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1 Introduction 

Thank you for choosing the QIAcube HT. We are confident it will become an integral part of your laboratory. 

Before using the QIAcube HT, it is essential that you read this user manual carefully and pay particular attention to the safety 
information. The instructions and safety information in this user manual must be followed to ensure safe operation of the instrument 
and to maintain the instrument in a safe condition. 

This user manual is also applicable to QIAxtractor instruments updated with QIAcube HT Software. 

 About this user manual 

This user manual provides information about the QIAcube HT in the following sections: 

 Introduction 
 Safety Information 
 General Description 
 Installation Procedures 
 QIAcube HT Software 
 Operating Procedures 
 Maintenance Procedures 
 Troubleshooting Guide 
 Technical Specifications 
 Appendices 
 Document Revision History 

The appendices contain the following information: 

 Appendix A 

 Advanced settings 
 Automatically skip to next if detect tip absence 
 Compensate for liquid loss (reagents) 
 Sample and reaction functions for non-wizard protocols 
 Description of the Generic XML Format 

 Appendix B 

 Declaration of Conformity 
 Waste Electrical and Electronic Equipment (WEEE) 
 FCC declaration 
 Liability clause 
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 Appendix C – Ordering Information 
 Appendix D – Informations de sécurité 
 Appendix E – Sicherheitshinweise 

 General information 

 Technical assistance  

At QIAGEN®, we pride ourselves on the quality and availability of our technical support. Our Technical Service Departments are 
staffed by experienced scientists with extensive practical and theoretical expertise in sample and assay technologies and the use 
of QIAGEN products. If you have any questions or experience any difficulties regarding the QIAcube HT or QIAGEN products 
in general, please do not hesitate to contact us. 

QIAGEN customers are a major source of information regarding advanced or specialized uses of our products. This information 
is helpful to other scientists as well as to the researchers at QIAGEN. We therefore encourage you to contact us if you have any 
suggestions about product performance or new applications and techniques. 

For technical assistance and more information, please see our Technical Support Center at www.qiagen.com/TechSupportCenter 
or call one of the QIAGEN Technical Service Departments or local distributors (see back cover or visit www.qiagen.com). 

QIAGEN customers are a major source of information regarding advanced or specialized uses of our products. This information 
is helpful to other scientists as well as to the researchers at QIAGEN. We therefore encourage you to contact us if you have any 
suggestions about product performance or new applications and techniques. 

For technical assistance, contact QIAGEN Technical Services. 

 Policy statement 

It is the policy of QIAGEN to improve products as new techniques and components become available. QIAGEN reserves the 
right to change specifications at any time. In an effort to produce useful and appropriate documentation, we appreciate your 
comments on this user manual. Please contact QIAGEN Technical Services. 

 Intended use of the QIAcube HT 

The QIAcube HT is intended to perform automated, medium-to high-throughput purification of nucleic acids such as aspirating, 
dispensing, filtering, and sequential transfer of liquids for molecular biology applications. 

The QIAcube HT is intended for use with QIAGEN kits indicated for use with the QIAcube HT for the applications described in 
the respective QIAGEN Kit handbooks. 

The QIAcube HT is intended for use by professional users, trained in molecular biological techniques and the operation of the 
QIAcube HT. 
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 Requirements for QIAcube HT users 

This table covers the general level of competence and training necessary for transportation, installation, use, maintenance, and 
servicing of the QIAcube HT. 

 Task Personnel Training and experience  

Delivery No special requirements No special requirements. 

Installation Laboratory technicians, or equivalent Appropriately trained and experienced personnel familiar 
with use of laptops and automation in general. 

Routine use (running protocols) Laboratory technicians, or equivalent Appropriately trained and experienced personnel familiar 
with use of laptops and automation in general. 

Servicing and annual preventive maintenance QIAGEN Field Service Specialists only Regularly trained, certified, and authorized by QIAGEN. 

 

 Requirements for using dedicated QIAcube HT kits on the QIAcube HT 

Software version 4.17.1 or higher is needed.  

For more information about available kits and protocols for the QIAcube HT, please visit www.qiagen.com/QIAcubeHT, or 
contact QIAGEN Technical Services. 

 Requirements for using dedicated QIAcube HT kits on the QIAxtractor 

To process dedicated QIAcube HT kits on the QIAxtractor instrument, QIAcube HT Software version 4.17 or higher is needed 
together with the Accessories Pack, QXT (see Appendix C – Ordering Information). 

 QIAcube HT Software 

The QIAcube HT is compatible with the Microsoft® Windows® XP Professional and Windows 7 Professional operating systems, 
and uses typical Windows features, such as tool buttons, command buttons, and dialog boxes. You should be familiar with the 
Windows operating environment and Windows conventions, especially the file management system. For more information, 
consult the Microsoft user guides. 
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2 Safety Information 

Before using the QIAcube HT, it is essential that you read this user manual carefully and pay particular attention to the safety 
information. The instructions and safety information in the user manual must be followed to ensure safe operation of the instrument 
and to maintain the instrument in a safe condition. 

Note: Translations of the Safety Information are available in French in Appendix D – Informations de sécurité and German in 
Appendix E – Sicherheitshinweise. 

The following types of safety information appear throughout this manual. 

WARNING 

 

The term WARNING is used to inform you about situations that could result in personal injury to you or 
others. 

Details about these circumstances are given in a box like this one. 

 
CAUTION 

 

The term CAUTION is used to inform you about situations that could result in damage to the instrument 
or other equipment. 

Details about these circumstances are given in a box like this one. 

 
The advice given in this manual is intended to supplement, not supersede, the normal safety requirements prevailing in the user’s 
country. 

 Proper use 

WARNING/ 
CAUTION 

 

Risk of personal injury and material damage 
Improper use of the QIAcube HT may cause personal injuries or damage to the instrument. 

The QIAcube HT must only be operated by qualified personnel who have been appropriately trained. 

Servicing of the QIAcube HT must only be performed by QIAGEN Field Service Specialists. 

 
WARNING/ 
CAUTION 

 

Risk of overheating 
To ensure proper ventilation, maintain a minimum clearance of 10 cm at the sides and rear of the 
QIAcube HT. Slits and openings that ensure the ventilation of the QIAcube HT must not be covered. 

 
WARNING/ 
CAUTION 

 

Risk of personal injury and material damage 
The QIAcube HT is too heavy to be lifted by one person. To avoid personal injury or damage to the 
instrument, do not lift the instrument alone. 
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WARNING/ 
CAUTION 

 

Risk of personal injury and material damage 
Do not attempt to move the QIAcube HT during operation. 

 
WARNING 

 

Explosive atmosphere 
The QIAcube HT is not designed for use in an explosive atmosphere. 

 
WARNING 

 

Risk of explosion 
The QIAcube HT is intended for use with reagents and substances supplied with QIAGEN kits. Use of 
other reagents and substances may lead to fire or explosion. 

 
CAUTION 

 

Damage to the instrument 
Direct sunlight may bleach parts of the instrument and cause damage to plastic parts. 

The QIAcube HT must be located out of direct sunlight. 

 
CAUTION 

 

Damage to the instrument 
Avoid spilling water or chemicals onto the QIAcube HT. Damage caused by water or chemical spillage 
will void your warranty. 

 
WARNING 

 

Risk of personal injury 
The robotic arm moves during position calibration while the instrument lid is raised. Never click any 
buttons while parts of your body are within the instrument workspace. 

 
In case of emergency, switch off the QIAcube HT at the power switch at the rear of the instrument and unplug the power cord 
from the power outlet. 

 Electrical safety 

Disconnect the line power cord from the power outlet before servicing. 

WARNING 

 

Electrical hazard 
Any interruption of the protective conductor (earth/ground lead) inside or outside the instrument or 
disconnection of the protective conductor terminal is likely to make the instrument dangerous. 

Intentional interruption is prohibited. 

Lethal voltages inside the instrument 
When the instrument is connected to line power, terminals may be live. Opening covers or removing 
parts is likely to expose live parts. 

 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 15 

WARNING 

 

UV irradiation hazard 
An electronic lid sensor ensures that the instrument lid must be closed for operation of the UV lamp. Under 
no circumstances should this lid sensor be disabled during the decontamination. 

 
To ensure satisfactory and safe operation of the QIAcube HT, follow the guidelines below: 

 The line power cord must be connected to a line power outlet that has a protective conductor (earth/ground). 
 Do not adjust or replace internal parts of the instrument. 
 Do not operate the instrument with any covers or parts removed. 
 If liquid has spilled inside the instrument, switch off the instrument, disconnect it from the power outlet, and contact 

QIAGEN Technical Services. 
 If the instrument becomes electrically unsafe, prevent other personnel from operating it, and contact QIAGEN Technical 

Services; the instrument may be electrically unsafe when: 

 The line power cord appears to be damaged. 
 It has been stored for a prolonged period of time in conditions outside of those outlined in Section 9. 
 It has been subjected to severe transport stresses. 

 Biological safety 

When handling biological material, use safe laboratory procedures as outlined in publications such as Biosafety in 
Microbiological and Biomedical Laboratories, HHS www.cdc.gov/od/ohs/biosfty/biosfty.htm. 

 Samples 

Samples may contain infectious agents. You should be aware of the health hazard presented by such agents and should use, 
store, and dispose of such samples according to the required safety regulations. 

WARNING 

 

Samples containing infectious agents 
Some samples used with the instrument may contain infectious agents. Handle such samples with the 
greatest of care and in accordance with the required safety regulations. 

Always wear safety glasses, 2 pairs of gloves, and a lab coat. 

The responsible body (e.g., laboratory manager) must take the necessary precautions to ensure that the 
surrounding workplace is safe, and that instrument operators are suitably trained and not exposed to 
hazardous levels of infectious agents as defined in the applicable Safety Data Sheets (SDSs) or OSHA,* 
ACGIH†, or COSHH‡ documents. 

Venting for fumes and disposal of wastes must be in accordance with all national, state, and local health 
and safety regulations and laws. 

*  OSHA: Occupational Safety and Health Administration (United States of America). 
†  ACGIH: American Conference of Government Industrial Hygienists (United States of America). 
‡  COSHH: Control of Substances Hazardous to Health (United Kingdom). 
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 Chemicals 

WARNING 

 

Hazardous chemical 
Some chemicals used with the instrument may be hazardous or may become hazardous after completion 
of the sample disruption process. 

Always wear safety glasses, gloves, and a lab coat. 

The responsible body (e.g., laboratory manager) must take the necessary precautions to ensure that the 
surrounding workplace is safe and that instrument operators are not exposed to hazardous levels of toxic 
substances (chemical or biological) as defined in the applicable Safety Data Sheets (SDSs) or OSHA,* 
ACGIH†, or COSHH‡ documents. 

Venting for fumes and disposal of wastes must be in accordance with all national, state, and local health 
and safety regulations and laws. 

*  OSHA: Occupational Safety and Health Administration (United States of America). 
†  ACGIH: American Conference of Government Industrial Hygienists (United States of America). 
‡  COSHH: Control of Substances Hazardous to Health (United Kingdom). 

 Toxic fumes 

If working with volatile solvents, toxic substances, etc., you must provide an efficient laboratory ventilation system to remove 
vapors that may be produced. 

 Waste disposal 

Used plasticware and containers may contain hazardous chemicals, or contagious/biohazardous materials. Such wastes must 
be collected and disposed of properly according to local safety regulations. 

For information on use and disposal of the tip disposal box, please see Section 3.2.6, page 30. 

For information about how to dispose of the QIAcube HT, see Section 9. 

 Mechanical hazards 

WARNING 

 

Moving parts 
Avoid contact with moving parts during operation of the QIAcube HT. Under no circumstances should 
you place your hands under the robotic arm when it is lowering. Do not attempt to move any plates or 
tubes while the robotic arm is operating. 

 
WARNING 

 

Damage to the instrument 
Do not apply any manual force to the Y-arm (i.e. the pipetting head). 

We strongly recommend restarting the system if the Y arm was accidentally manually moved. 
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To ensure satisfactory and safe operation of the QIAcube HT, follow the guidelines below: 

 Use only recommended tips and tip racks. 
 Keep the instrument lid closed whenever possible. 
 Do not override the lid sensor under any circumstances. 
 When calibrating plates with the lid open, always stand clear of the instrument when making adjustments. In calibration 

mode, the lid sensor is disabled. Therefore, do not click with the mouse or press any of the keys on the keyboard when 
looking closely at plate calibrations. Wait until the robotic arm has completed its movements before moving any plates or 
tubes. 

 Do not place any items on the robotic arm. 
 Select Pause, located in the toolbar of the QIAcube HT Software, to pause the instrument before removing plates or tubes 

from the worktable. Wait until the robotic arm has completed the current movement — this may take up to 10 seconds. 

 Maintenance safety 

Perform the maintenance as described in Section 7. QIAGEN charges for repairs that are required due to incorrect maintenance. 

WARNING/ 
CAUTION 

 

Risk of personal injury and material damage 
Only perform maintenance that is specifically described in this user manual. 

 
WARNING/ 
CAUTION 

 

Risk of electric shock 
Do not open any panels on the QIAcube HT. 

Risk of personal injury and material damage 
Only perform maintenance that is specifically described in this user manual. 

 
CAUTION 

 

Damage to the instrument 
Do not use solvents, or reagents containing acids, alkalis, or abrasives to clean the QIAcube HT. 

 
CAUTION 

 

Damage to the QIAcube HT lid 
Do not use alcohol, solvents, reagents containing acids, alkalis, or abrasives to clean the instrument lid. 
Alcohol will damage the lid. To clean the lid, use distilled water only. 

 
CAUTION 

 

Damage to the QIAcube HT side panels 
Never clean the instrument side panels with alcohol or alcohol-based solutions. 

 
CAUTION 

 

Damage to transfer carriage 
Under no circumstances should the transfer carriage for use with Capture Plate VX or Capture Plate DX 
be autoclaved. 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 18 

 Symbols on the QIAcube HT 

Symbol Location Description 

 

Worktable and near the type plate Warning symbol 

 

Worktable and near the tip chute 
outlet 

Biohazard symbol 

 

Worktable Squeezing warning symbol 

 

Type plate on the back of the 
instrument 

CE Mark for European Conformity 

 

Type plate on the back of the 
instrument 

UKCA mark for UK Conformity 

 

Type plate on the back of the 
instrument 

CSA listing mark for Canada and the USA 

 

Type plate attached to the cable of the 
instrument 

Legal Manufacturer 

 

Type plate on the back of the 
instrument 

WEEE mark for Europe 

 

Type plate on the back of the 
instrument 

FCC mark of the United States Federal Communications 
Commission 

 

Type plate on the back of the 
instrument 

C-Tick mark for Australia (supplier identification N17965) 

 

Type plate on the back of the 
instrument 

RoHS mark for China (the restriction of the use of certain 
hazardous substances in electrical and electronic equipment) 

 

Type plate on the back of the 
instrument    

Consult instructions for use 
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3 General Description 

The QIAcube HT delivers high performance and reliability, enabling purification of high-quality nucleic acids from 8–96 samples 
per run, in increments of 8 samples. Innovative instrument features ensure reliable purification and minimize the risk of 
contamination. The QIAcube HT is a fully integrated solution and provides reagents, plasticware, and optimized protocols for 
nucleic acid purification from virtually any type of sample.  

The QIAcube HT provides: 

 High performance through optimized protocols, even with difficult samples 
 Reliability with minimized risk of cross-contamination 
 Small footprint for space efficiency 
 More time for other important tasks 
 Convenient pre- and post-run documentation 

 The QIAcube HT 

 
The QIAcube HT. 

1 Lid  8 Lysis plate 

2 UV lamp 9 Filter plate and vacuum station 

3 Pipetting head(robotic arm) 10 Elution tubes 

4 Tip chute 11 HEPA filter 

5 Tip racks 12 Accessory panel 

6 SBS tube (base plate) 13 Feet 

7 Reagent troughs   

1 

2 

11 

4 

7 

9 

8 

6 5 

10 
3 

13 

12 
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 Instrument lid 

CAUTION 

 

Damage to the QIAcube HT lid 
Do not use alcohol, solvents, reagents containing acids, alkalis, or abrasives to clean the instrument lid. 

For more information, see Section 7.2.2, page 153. 

 
The lid of the instrument provides both an isolated enclosure for performing purification and a safety mechanism. 

The instrument lid incorporates a magnetic sensor to determine whether the lid is closed or not. Under no circumstances should 
this sensor be bypassed. 

The instrument lid must be closed for the software and hardware to initialize upon start-up and for a run to proceed.  

Opening the instrument lid while the robotic arm is performing a run will cause the robotic arm to pause. This pause is recorded 
in the post-run report (Section 6.5, page 149). Extreme care should always be taken when opening the instrument lid during a 
run as the pause in robotic operation may take several seconds to be completed. 

The instrument lid may remain open when calibrating the position and height of plates. Do not interfere with robotic arm movement 
during these calibrations and keep all body parts out of reach of the robotic arm while it is moving. 

 UV lamp 

A UV lamp in the instrument lid provides efficient worktable decontamination and helps to prevent contamination. 

Note: Before using the UV lamp the tip chute must be covered and placed into the instrument. 

To operate the UV lamp: 

1. Make sure that the UV lamp bulb is connected to the UV plug. 

2. Make sure that the QIAcube HT instrument lid is securely closed. 

For increased safety, an electronic lid sensor ensures that the UV lamp operates only when the instrument lid is closed. Under no 
circumstances should the lid be opened during the decontamination procedure. 

During UV irradiation, the robotic arm moves between 2 locations at 5 second intervals. All items must be removed from the 
instrument to ensure the worktable is fully exposed.  

The UV lamp does not irradiate certain areas, including the pipetting head, due to construction constraints. 

The UV lamp is enabled and time of exposure is set within the QIAcube HT Software. For more details, see Section 5.18.3, 
page 133. 
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 Pipetting head 

Liquid-handling tasks are performed by the multichannel pipetting head, which provides a motor-driven, backlash-compensated 
pipetting mechanism. Tips attach to the pipettor barrels of the pipetting head. 

The robotic arm controls the movement of the pipetting head in the X-, Y-, and Z-directions. 

The Y-axis arm of the robotic arm provides support for the pipetting head. Under no circumstances should the user apply any 
force to the Y-arm. This may misalign the arm and cause pipetting errors. 

Note: To prevent accidental damage, the wooden Y-arm support should always be fitted before the QIAcube HT is moved. 

 Tip chute 

 
Tip chute. 

Tips used on the worktable are discarded through the tip chute. Located at the rear-left of the QIAcube HT, the tip chute is held 
in place by a locating block, allowing easy placement and removal for cleaning. 

 HEPA filter 

The HEPA filter system provides positive clean air pressure on the worktable beneath the lid. The HEPA filter system consists of 
two HEPA filter cartridges. 

 
Hepa filter. 
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 Accessory panel 

All instrument electronics are housed in the rear of the instrument. The accessory panel, located at the rear of the QIAcube HT, 
provides ports for connection to the instrument. 

 
 

QIAcube HT accessory panel. 

1 Accessory 1 6 Accessory power outlet 

2 Accessory 2 7 Main power input socket 

3 Accessory 3 8 Power switch 

4 Serial RS-232 socket 9 Access to the pinch valve  

5 USB socket  Accessory panel (via an opening below the serial RS 232 socket) 

 Feet 

The feet of the instrument have a non-slip silicone base to ensure that the QIAcube HT remains securely positioned on a laboratory 
bench. Do not attempt to slide the instrument on a bench. Always lift the instrument to avoid damage to the silicone base of the 
feet. 

 Worktable 

The worktable is the instrument surface upon which items, such as plates, reagents, and tips are placed. 

Worktable layout is specified for a protocol with a run file and is represented in the QIAcube HT Software as the workspace. 
For more details, see Section 5.3, page 51. 

3 2 1 
4 

9 

5 6 7 8 
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 Principles of operation 

 Vacuum chamber and components for use with QIAcube HT kits on QIAcube HT or QIAxtractor 
instruments 

For more information about available kits and protocols for the QIAcube HT, please visit www.qiagen.com/QIAcubeHT, or 
contact QIAGEN Technical Services. 

 
Vacuum chamber, channeling adapter, and riser block EMTR (unassembled). 

The QIAcube HT vacuum chamber is composed of two separate compartments for waste (left) and elution (right). This 
configuration is one of many measures that minimize sample cross-contamination during purification.  

For more details about assembling the vacuum chamber for processing, see Section 6.2, page 135. 

The channeling adapter is located in the left (waste) side of the vacuum chamber and channels the waste from each well in the 
plate separately to prevent cross-contamination. The channeling adapter is pushed firmly downwards to engage the spigot into 
the drain of the waste chamber. The channeling adapter is held firmly in place by a rubber O-ring on the channeling block 
spigot. 

The riser block EMTR must be inserted into the elution (right) chamber to raise the elution plate to the optimal height to prevent 
cross-contamination during the elution process. 

Waste chamber Elution chamber 

Channeling adapter Riser block EMTR 
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Channeling adapter and riser block EMTR inserted into the vacuum chamber. 

The waste and elution compartments of the vacuum chamber are connected to the waste bottle via silicone hoses that pass from 
the blue connectors underneath the vacuum chamber through the pinch valve. The vacuum chamber hoses and the Y-hose 
connector are fitted to the instrument before delivery. For information about installation, see Section 4.4.3, page 34. 

Vacuum hoses must not be modified (e.g., shortened or lengthened). 

 
Vacuum waste hose.  

The transfer carriage provides a platform for transporting the capture plate between the waste and elution compartments of the 
vacuum chamber. 
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Transfer carriage for use with QIAGEN plates (e.g., QIAamp plate) other than Capture Plate VX or Capture Plate DX. 

 Vacuum chamber and components for use with Capture Plate VX or Capture Plate DX on the QIAxtractor 
instrument 

Note: This description is for QIAxtractor instruments only. All QIAcube HT instruments are delivered with the vacuum chamber 
components for dedicated QIAcube HT kits. 

 
Vacuum chamber, waste sink/mat support, and elution riser block (unassembled). 

The QIAxtractor vacuum chamber is composed of two separate compartments for waste (left) and elution (right). This configuration 
is one of many measures that minimize sample cross-contamination during purification.  

For more details about assembling the vacuum chamber for processing, see Section 6.2, page 135. 

Waste  
chamber 

Waste  
sink 

Elution chamber 

Riser block 
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The waste sink/mat support, located in the left (waste) side of the vacuum chamber, provides support for the silicone mat that 
seals the capture plate and channels the waste from each well in the plate separately to prevent cross-contamination. The waste 
sink/mat support is pushed firmly downwards to engage the spigot into the drain of the waste chamber. The waste sink/mat 
support is held firmly in place by a rubber O-ring on the waste sink/mat support spigot.  

The elution riser block must be inserted into the elution (right) chamber to raise the elution plate to the optimal height to prevent 
cross-contamination during the elution process.  

 
Waste sink/mat support and elution riser block inserted into the vacuum chamber. 

The waste and elution compartments of the vacuum chamber are connected to the waste bottle via silicone hoses that pass from 
the blue connectors underneath the vacuum chamber through the pinch valve. The vacuum chamber hoses and the Y-hose 
connector are fitted to the instrument before delivery. For information about installation, see Section 4.4.3, page 34. 

Vacuum hoses must not be modified (e.g., shortened or lengthened). 

 
Vacuum waste hose.  

The transfer carriage provides a platform for transporting the capture plate between the waste and elution vacuum chamber. 
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Transfer carriage for use with Capture Plate VX or Capture Plate DX. 

CAUTION 

 

Damage to transfer carriage 
Under no circumstances should the transfer carriage for use with Capture Plate VX or Capture Plate DX 
be autoclaved. 

 Vacuum control station and waste bottle 

 
Vacuum control station.  

The vacuum control station, an integral component of the QIAcube HT, provides vacuum to the vacuum chamber for processing. 
The vacuum is precisely controlled by the user using the QIAcube HT Software.  

A 4-liter waste bottle is housed in the vacuum control station. The waste bottle is connected to the vacuum chamber by a silicone 
hose that branches just before passing through the pinch valve.  
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The waste bottle volume indicator icon ( ) in the toolbar provides a calculation of the waste bottle volume based on volumes 
of liquids dispensed to the capture plate while in the waste position during processing. When the bottle indicator (blue line) 
reaches the “full” position (at approximately 2 liters), the user will be prompted to empty the waste bottle.  

To empty the bottle and acknowledge the alert, use the procedure described in Section 7.2, page 151. 

 
Vacuum bottle cap.  

 Pinch valve  

 
Pinch valve (base) and silicone hoses. 

1 Silicone hoses 2 Pinch bar 

1 1 

2 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 29 

 
Pinch valve (front). 

1 15-pin cable connector 3 Green LED 

2 Manual override button 4 Recessed pressure switch 

 
The pinch valve controls application of vacuum to separate vacuum chamber compartments for waste and elution during 
processing. 

The pinch valve can be set to the following positions:  

 Waste compartment open; elution chamber closed 
 Elution compartment open; waste chamber closed 
 Both compartments open  

By default, both compartments of the vacuum chamber are open (automatically selected when the pinch valve is switched on). 
This position protects the silicone hoses controlled by the pinch valve from potential damage caused by constant pressure when 
the instrument is inactive or turned off. The pinch valve defaults to the position of both compartments of the vacuum chamber 
open at the end of each run.  

The pinch valve is equipped with manual override buttons located below the 15-pin connector port on the front of the pinch 
valve. Pressing either button moves the pinch valve in the direction that the button is pushed, opening the vacuum to the opposite 
station. Pressing both buttons simultaneously moves the pinch valve to the center position, opening the vacuum to both stations.  

Important: In case of protocol failure, do not push override during processing. 

 Reagent trough adapters and reagent troughs 

The QIAcube HT is delivered with 2 reagent trough adapters for securely positioning reagent troughs on the instrument worktable: 

 The QIAcube HT specific reagent trough adapter is always located in the R1 position of the worktable. 
 The SBS-standard adapter can be located in the B1, B2, C1, and C2 positions of the worktable (default is C1).  

The SBS reagent trough adapter can be used on other QIAGEN instruments, such as the QIAgility®.  

1 
2 

3 
4 
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Reagent troughs are non-reusable, made from high-quality material, and are available for 70 mL and 170 mL volumes.  

Up to 8 troughs can be placed on the worktable using the reagent trough adapters: 2 x 170 mL and 6 x 70 mL. 

The trough arrangement for the QIAcube HT specific reagent trough adapter is shown below. 

        
Reagent trough layout for the QIAcube HT specific reagent trough adapter. 

 Tip disposal box 

Discarded tips are collected in a tip disposal box, located at the side of the QIAcube HT. 

To ensure correct positioning under the tip chute, the tip disposal box is held in place by the tip disposal box holder. Lock the tip 
disposal box holder with the instrument’s feet on the left side of the instrument, and then place the tip disposal box into the tip 
disposal box holder. 

 
Alignment of tip disposal box holder to the instrument and the tip disposal box. 

Tip disposal boxes are supplied with the QIAcube HT and can be reordered from QIAGEN. (See Appendix C – Ordering 
Information.) 
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 QIAcube HT laptop, QIAcube HT Software and user manual 

The QIAcube HT is operated via a computer. A laptop with the correct specification for operation of the QIAcube HT and 
QIAcube HT Software is supplied as part of the QIAcube HT System. However, if a different computer is used to operate the 
QIAcube HT or to run the QIAcube HT Software, then the following desktop or laptop hosting systems are recommended. 

Desktop computer: 

 Windows 7 Professional (32 bit) or Windows XP Professional SP3 
 Microsoft Internet Explorer (version 8 or higher) 
 At least 2.5 GHz CPU 
 At least 2 GB RAM 
 RS-232 serial port or USB 2.0 port 
 800 MB free hard drive capacity 
 At least 1024 x 768 screen resolution 

Laptop computer: 

 Windows 7 Professional (32 bit) or Windows XP Professional SP3 
 Microsoft Internet Explorer (version 8 or higher) 
 At least 2.5 GHz CPU 
 At least 2 GB RAM 
 RS-232 serial port, or USB 2.0 port, or PCMCIA slot 
 800 MB free hard drive capacity 
 At least 1024 x 768 screen resolution 

The computer connects to the QIAcube HT by one of the following interfacing options: 

 RS-232 (computer) — RS-232 (QIAcube HT)  
 USB (computer) — USB (QIAcube HT) (recommended) 

 
From time to time, QIAcube HT Software updates are released. To ensure that you are using the latest QIAcube HT Software, 
check for updates at www.qiagen.com/QIAcubeHT.  
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4 Installation Procedures 

Note: For your own safety and to prevent damage to the instrument, observe the safety instructions. 

 Instrument delivery and installation 

The following items are delivered: 

 QIAcube HT instrument 
 Vacuum control station and waste bottle 
 Laptop  
 QIAcube HT Software and User Manual on Removable Media 
 Unpacking instructions (printed version) 
 Accessories 

Note: We recommend checking the packing list before installation. 

 Requirements 

 Site 

QIAcube HT 

Choose the position for the QIAcube HT carefully. A change in position necessitates a recalibration. Place the QIAcube HT in its 
final position. 

The requirements for the QIAcube HT location and position are given below: 

 The location must have sufficient space to accommodate the QIAcube HT. Refer to Section 9 for instrument dimensions and 
operating conditions (temperature and humidity). 

 The QIAcube HT must be placed near to 3 properly grounded (earthed) AC power outlets. The power lines to the instrument 
should be voltage regulated and surge protected.  

 The QIAcube HT can be installed on any level and sturdy laboratory bench or table. There should be space below for the 
vacuum control station and space adjacent for the laptop. 

 Ensure that the switch at the rear of the instrument is easily reached. 
 Ensure that the instrument lid can fully open upwards without obstruction. 
 The QIAcube HT must not be installed near generators of static electricity (e.g., ionizers, large-screen televisions). 
 The QIAcube HT should be installed in a laboratory environment that is free of excessive airborne dust. 
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Vacuum control station 

The vacuum control station is best placed directly under the laboratory table upon which the instrument is placed. 

Note: We strongly recommend that the vacuum control station is placed at a position that is lower than the vacuum chamber so 
that liquids easily flow from the vacuum chamber to the vacuum control station.  

Laptop 

For operation of the QIAcube HT, the supplied laptop must be connected and placed near to the instrument.  

 Unpacking the instrument 

Important: For unpacking of the QIAcube HT, refer the unpacking instructions delivered with the instrument. 

 AC power connection 

Power requirements 

The QIAcube HT operates at: 

 100–240 V, 250 VA, 50–60 Hz, 5 A fuse 

Make sure the voltage rating of the QIAcube HT and laptop are compatible with the AC voltage available at the installation site. 
Main supply voltage fluctuations must not exceed 10% of nominal supply voltages. 

Grounding requirements 

To protect operating personnel, we recommend that the QIAcube HT be correctly grounded (earthed). The instrument is equipped 
with a 3-conductor AC power cord that, when connected to appropriate AC power outlets, ground (earth) the equipment. To 
preserve this protection feature, do not operate the equipment from AC power outlets that have no ground (earth) connection. 

Installation of AC power cord 

Connect one end of the AC power cord (standard 3-wire IEC mains cable) to the power connector on the accessory panel located 
at the rear of the QIAcube HT, and the other end to the AC power outlet.  

The AC line fuse (slow blow) compartment is located on the accessory panel at the rear of the instrument between the power 
switch and the mains power input socket. Fuses for the power supplies are specified on the label located above the main 
connector. If a fuse needs to be changed, contact a QIAGEN Field Service Specialist. 
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 Hardware installation 

 UV lamp 

The UV plug is integrated within the lid. To connect the UV lamp proceed as follows: 

1. Open the lid. 

2. Connect the delivered UV lamp bulb into the UV plug and turn it by 90°. 
 
Note: Hold the UV lamp bulb at both ends when fixing into the UV plug. Always wear safety gloves. 

WARNING 

 

UV irradiation 
An electronic lid sensor indicates that the instrument lid must be closed for operation of the UV lamp. 
Under no circumstances should the lid sensor be disabled during the decontamination. 

 

 HEPA filter system 

The HEPA filter system is installed and connected before shipping. 

 Vacuum control station 

The vacuum control station is connected to the instrument with the accessory power lead and an accessory cable. 

The male end of the accessory power lead is plugged into the accessory power port on the rear panel of the instrument 
(Section 3.1.6, page 22) and the female end into the power port on the vacuum control station.  

The male end of the 15-pin accessory cable is plugged into one of the unused accessory ports on the rear panel of the instrument 
(Section 3.1.6, page 22) and the female end into the accessory port on the vacuum control station. 
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Side view of vacuum control station. 

1 15-pin cable connector 4 Restart 

2 Green LED (running) 5 Accessory power port 

3 Red LED (standby) 6 Power switch 

 Pinch valve 

The pinch valve is mounted behind the instrument below the accessory panel. It must be connected to the instrument using an 
accessory cable. 

The male end of the accessory cable is plugged into an unused accessory port on the rear panel of the instrument (Section 3.1.6, 
page 22); the female end is inserted through the pinch valve opening in the rear panel and plugged into the accessory port on 
the pinch valve unit.  

 Vacuum waste hose 

The instrument is shipped fitted with the vacuum chamber, pinch valve, vacuum chamber hoses, and Y-hose connector. To protect 
the vacuum chamber hoses and Y-hose connector from damage, they are coiled up inside the rear cover of the instrument. 

 
Stored hoses visible in the rear cover of the instrument. 

To retrieve the Y-hose connector of the vacuum waste hoses, use one hand to reach under the cover to the left (when looking at 
the rear of the instrument) of the pinch valve and locate one of the hoses. While pulling the hose down, use the other hand to 
reach through the pinch valve opening and push the hoses down through the gap between the rear cover and the pinch valve. 

5 

6 

3 
1 

2 

4 
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Hoses visible in the gap between the rear cover and the pinch valve. 

Make sure that the hoses are not twisted and exit from under the rear cover without kinking. 

 
Hose exiting from the rear cover. 

 
Hose exiting from the pinch valve. 

Attach the vacuum waste hose by pushing the end that does not have an attachment onto the Y-hose connector. 

Note: If the instrument needs to be repacked for any reason, the Y-hose connector and vacuum chamber hoses should be stowed 
behind the rear cover to prevent damage. 
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 Software installation  

Note: QIAcube HT Software must be installed by a user with Windows administrator rights (see Section 4.5.1, page 37) before 
the instrument can be connected to the laptop for the first time.  

 Installing the QIAcube HT Software 

Note: The software will usually be installed on the laptop by a QIAGEN Field Service Specialist on the day of instrument 
installation, if the QIAcube HT was purchased with an installation pack. If the QIAcube HT was purchased without an installation 
pack, the user with Windows administration rights should install the software by following the steps below. 

Note: Default settings are recommended where appropriate for all installation steps. 

1. Turn on the laptop and close all open applications. 

2. Insert the removable media containing the QIAcube HT Software into the laptop. 

3. The start page appears automatically after a few seconds.  

 
If the start page is not displayed, you can start the installation process from the Windows Start menu by selecting Run and 
entering “D:\setup.exe” (where “D:” is the Removable Media drive). 

To exit the start page, click Exit. 

4. If Adobe® Acrobat® Reader is not yet installed on the laptop, select Install Adobe Reader.  

Adobe Acrobat Reader software is preinstalled on the laptop delivered with the instrument. Make sure that Acrobat Reader 
is installed when using a computer other than the laptop delivered with the instrument. 

Adobe Acrobat Reader is required to allow viewing of the user manual (this document). 

5. Click Show User Manual to view the user manual (this document) using Adobe Reader. 
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6. Click Install Operating Software to begin the installation process. 

The “Welcome to the QIAcube HT Setup Wizard” window appears, informing the user of the software version and 
recommending that the user close all other programs before installing the software.  

 
7. Select Next to continue. 

 
The “License Agreement” window displays the license agreement for the QIAcube HT Software.  

Return to the previous window by clicking Back in any window.  
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8. Read the license agreement, select I accept the agreement, and click Next to continue. Otherwise select Cancel to exit the 
software installation.  

 
9. In the “Select Destination Location” window, select the folder in which the software should be installed. Click Next to 

continue. 

Click Browse to browse to the installation folder.  

Note: If a previous version of the software is installed, the “Select Destination Location” screen does not appear and the 
following warning is displayed.  

 
Click Yes to uninstall the previous version of the software. By clicking No, the previous version of software remains installed 
and the installation of the new version cannot proceed. If you choose to uninstall the previous version of software, existing 
calibration settings and run files are retained for use with the new software version.  
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10. In the “Regional Settings” window, select the region of the world in which the installation is taking place. 

Choose the region from the drop-down list. Region selection ensures that the installed software displays local contact 
information for ordering and technical support. This window is shown only on initial installation, not during installation of 
upgrades.  

After the region is selected the Next button becomes active. 

11. Click Next to continue.  

 
12. In the “Select Additional Tasks” window, specify which additional tasks should be performed while the program is installing 

the software.  
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13. Click Next to continue. 

 
14. Review the installation parameters in the “Ready to Install” window, and click Install to continue.  

The release notes for the software version are displayed. 
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15. Review the displayed release notes, and click Next to continue. 

 
16. In the “Completing the QIAcube HT Setup Wizard” window, check Launch QIAcube HT to launch the software after the 

wizard closes. 

17. Click Finish to complete the installation process.  
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 Connecting the instrument to the laptop 

Before attempting to connect the instrument to the laptop, ensure the following conditions have been met: 

 The laptop has been properly set up and the QIAcube HT Software has been installed (Section 4.5, page 37). 
 The QIAcube HT has been properly set up and is in its final location (Section 4.2, page 32). 
 The laptop is in its final location near the instrument. 

Before the laptop can be connected to the instrument, all of the accessory cables connecting the instrument to other components 
should be connected to the QIAcube HT accessory panel (Section 3.1.6, page 22). The following photo shows the accessory 
panel. With the exception of the RS-232 cable, all of the required cables are connected. The RS-232 cable must be connected 
to the serial port for connection to the laptop. 

 
Cables attached to the accessory panel. 

 Connecting the computer to the QIAcube HT  

The QIAcube HT uses USB for connection to the computer. The laptop which is supplied with the QIAcube HT should be installed 
via USB.  

Note: Connect the computer to the QIAcube HT either via the USB or via the RS-232 interface. Do not make both connections at 
the same time. 

To connect via the RS-232 interface: 

 Connect the 9 pin serial cable between the RS-232 port on the instrument and the RS-232 port on computer. 

To connect via the USB interface: 

 Connect the USB cable between the USB port on the instrument and the USB port on the computer. 

Note: The laptop software recognizes connection to the QIAcube HT as a USB device even when the instrument is switched off. 

Switch on the instrument. 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 44 

 Hardware Wizard 

The first time the QIAcube HT is connected to the laptop, the Windows “Found New Hardware” wizard appears. 

 
 
1. Select No, not this time, and click Next. 

 
2. Select Install the software automatically (Recommended), and click Next. 
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3. Driver installation begins. Once installation is complete, the “Completing the Found New Hardware” window appears.  

 
4. Click “Finish” to complete connection of the laptop to the instrument.  

 Configuring the COM port 

The COM port used to connect the computer to the QIAcube HT must be correctly configured in the software to enable the 
software to communicate with the QIAcube HT instrument. By default, the software is configured to use COM1, and this 
corresponds to the first RS-232 port on the system.  

To use a computer with the USB interface, the COM port must be reconfigured to COM4.  

To do this: 

1. Start the software in “Virtual Mode”, as described in Section 5.1.2. 

2. Change the COM port to COM4, as described below. 

3. Shut down the software, as described in Section 7.7. 
 
The serial port can be configured manually by completing the following steps: 

1. Ensure the laptop is connected to the instrument. 

For more details, see Section 4.6, page 43. 

2. From the “Options” menu, select Robot Setup/Select COM port.  

The “Configure Serial Interface” window appears. 

 
3. Select the desired COM port from the drop-down list and click OK.  
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All COM ports configured in the system are listed. If the currently chosen COM port is not currently available, it is listed as 
“absent”. When the software identifies a USB COM port that is appropriate for connection to the instrument, it is listed with 
an asterisk (*). 

When the selection is changed, the following message appears.  

 
4. Click Yes to shut down the software. 

For more details, see Section 7.6, page 160. 

5. Restart the software and verify that it starts in “Normal” mode.  

The software starts in “Normal” mode only when the connection between the software and the laptop has been configured 
correctly and the instrument is switched on. 

After configuration, the COM port selection can be changed (see Section 5.18.1, page 130). 

 Important notes before first use 

The QIAcube HT has a variety of moving parts which present a number of significant pinch points. For your own safety and to 
prevent damage to the instrument, please observe the following: 

 Always use the packaging provided when moving the instrument. 
 The QIAcube HT should be lifted by two people. 
 Do not disable the instrument lid sensor. 
 Do not interfere with the robotic arm while it is operating. 
 Do not attempt to move any plates or tubes while the robotic arm is operating. 
 Do not, under any circumstance, place your hand under the pipetting head while it is lowering. 
 When calibrating plates with the instrument lid open, be sure to always stand clear of the robotic arm. Similarly, do not 

click with the mouse or press any of the keys on the keyboard while looking closely at plate calibrations. 
 Use only recommended tips and tip racks. 
 Keep the instrument lid closed whenever possible. 
 NEVER place any items on the Y-arm which supports the pipetting head. 
 NEVER apply any force (by hand or otherwise) to the Y-arm. 
 Use “Stop/Pause” located in the toolbar of the QIAcube HT Software to stop or pause the instrument before removing items 

from the worktable. 
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5 QIAcube HT Software 

The QIAcube HT Software provides a user-friendly, easy-to-use interface for configuring and running protocols on the QIAcube 
HT instrument.  

When started, the software automatically detects if the instrument is switched on and connected properly. The software displays 
a layout that corresponds to the setup of the instrument worktable. Software functions ensure that worktable items are calibrated 
for use on the instrument. 

Protocols are configured using the “Vacuum extraction” wizard. Once a protocol has been properly configured, the software 
automatically calculates the volumes of all required reagents and displays them in the workspace layout. 

Protocol configurations can be saved as run files for subsequent reuse. QIAGEN develops and publishes “template” run files 
called Qprotocols for use with the QIAcube HT. 

When a protocol is running, the software displays a checklist to assist the user in setting up the instrument worktable. The progress 
of a run can be followed in real time:  

 The software indicates the current position of the pipetting head.  
 A progress panel displays the run start time, current time, and estimated time to completion. 
 The reaction list displays the status of protocol tasks.  

Reports are generated before and after a run. Post-run reports are automatically saved for future reference. 

 Mode 

The QIAcube HT Software can be run in either the “Normal” mode or the “Virtual” mode. 

 “Normal” mode 

When communication between the laptop and instrument has been correctly specified, the QIAcube HT Software opens 
automatically in “Normal” mode. This mode is used to operate the instrument. 

 “Virtual” mode 

“Virtual” mode simulates instrument operation without communication with the instrument. This allows runs to be set up and files 
to be stored when the instrument is switched off or not connected. In addition, “Virtual” mode allows the processing behavior of 
newly configured protocols to be tested without using expensive reagents. 
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When running in “Virtual” mode, this is shown in the title of the window. 

 
 
All functions are enabled in the “Virtual” mode: Parameters can be changed, runs can be set up or modified, and virtual runs 
can be completed. However, in this mode, no communication is attempted with the instrument and all instrument responses are 
simulated. 

Protocols can be specified and saved in the “Virtual” mode to create templates for subsequent runs. This feature enables the user 
to create protocols on any laptop that has QIAcube HT Software installed. The template can be transferred to the laptop connected 
to the instrument, minimizing the time required for working on the laptop connected to the instrument.  

Any modification made to calibrations in the “Virtual” mode does not affect calibrations on the instrument.  

 Starting the QIAcube HT Software 

To run the “Normal” mode, ensure the instrument is connected to the laptop (see Section 4.6, page 43) before starting the 
QIAcube HT Software.  

1. Close the instrument lid, switch on the instrument (see Section 6.1, page 135), and allow the instrument to initialize.  

2. Switch on the laptop and wait for the Windows operating system to start up. 

3. To start the software, double-click the QIAcube HT Software icon on the desktop.  

 
QIAcube HT Software icon. 

 
Alternatively, open the Windows Start menu and select Programs/QIAcube HT/QIAcubeHT. 

During startup, the software attempts to communicate with the connected instrument using the configured COM port (see 
Section 4.8, page 45). Details about the attempted connection as well as details about the software version are displayed 
in the QIAcube HT window that appears. 

QIAcube HT 
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If the software successfully communicates with the instrument, the “Normal” mode is launched. Otherwise, the software is 
launched in the “Virtual” mode. For more details about modes, see Section 5.1, page 47. 

Since the communication process takes several seconds, it is possible to start in “Virtual” mode by clicking Virtual Mode in 
the QIAcube HT window. 

After beginning operation in either mode, the software displays options for creating a new run or opening an existing run. 
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4. Select an option, and double-click the option or click Open to continue.  

The following options are available. 

 To start a new project, select the New tab and choose Empty Project (last used layout) or Empty Project (default layout). 
 To create a new run file using the “Vacuum extraction” wizard, select the New tab and choose Vacuum Extraction 

Protocol. 
 To open a previously saved run file, open the Recent tab, and select a file. 
 When template protocols are installed, the form offers a Protocols tab. To open a template run file, open the Protocols 

tab and select a file from the list of template run files (see Section 5.15.1, page 104). 

 
5. Alternatively, click Cancel to exit the form.  

This creates an empty project based on the last layout used. 

 

For more information about available options, see Section 5.15.3, page 105. 
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 The software workspace 

The software workspace is the main user interface providing control of QIAcube HT Software functions.  

The workspace is displayed: 

 When a new project is initiated. 
 When an existing run file is opened.  
 When a new protocol is created using the “Vacuum extraction” wizard. 

The software workspace displays positions that correspond to slots on the QIAcube HT worktable. Items specified in positions in 
the software workspace, referred to as “plates”, correspond to actual items placed on the worktable, and include the following: 

 Multiwell plates (e.g., 96-well plates) 
 Tip racks containing tips 
 Reagent plates containing reagents in reagent troughs 
 Accessories (such as a cooling block) 

A plate can be configured with a function that defines the actual contents of the container in the plate position: 

 Reagent 
 Sample 
 Reaction 
 Tip 

A layout specifies plate positions and functions for a specific protocol. 

Important sections of the typical workspace are indicated in the following figure. 

 
QIAcube HT Software workspace default configuration. 

A1 

B1 B2 

C1 C2 

R1 
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In this default configuration, items are indicated in the following locations: 

 A1 — capture plate 
 B1 — 96-well lysis block 
 B2 — tip rack 
 C1 — reagent troughs 
 C2 — tip rack 
 R1 — reagent troughs 

This configuration can be modified according to protocol requirements. 

The following table lists the typical or intended use for each position. Actual settings depend on the protocol used. 

 Position Use  

A1 Capture plate 

B1 Lysis block, usually preloaded with samples 

B2 Tip rack 

C1 Reagents used during processing or preloaded samples (depending on the protocol) 

C2 Tip rack 

R1 Reagents used during processing 

 

 “Virtual” mode indicator  

The “Virtual” mode indicator at the top of the window (not shown) appears when the software is operating in “Virtual” mode. 
For more information, see Section 5.1.2, page 47. 

 Menu bar 

The menu bar provides access to the menus from which most software functions can be controlled.  

For more information about the options available from the menu bar, see Section 5.4, page 54. 

 Toolbar 

The toolbar, which is always visible, provides shortcuts to commonly used operations, such as opening and saving run files and 
starting and pausing runs. Warnings are displayed in this bar when there is a problem with a run. 

For more information about the options available from the toolbar, see Section 5.5, page 58. 
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 Workspace items 

Options for pipet tips, plate types, and accessories are displayed by selecting an item in the workspace and right-clicking. A 
typical menu is shown in the following figure. 

 
 
There is some overlap between the functions that can be controlled from these context-sensitive menus and the items available in 
the menu bar. 

The plate positions displayed in the workspace are labeled in accordance with the corresponding worktable item. Letters indicate 
the rows and numbers indicate the columns. Thus the locations are numbered A1, B1, B2, C1, and C2 from the top left across 
and down towards the lower right.  

Plate buttons, located at the top, right corner of the plates, allow direct access to simple plate functions and information.  

These buttons appear when the mouse pointer is hovering over a plate. The warning button is always visible for plates that have 
not yet been calibrated. For more information about calibration, see Section 5.12.5, page 88. 

 Plate button Name Description  

 
Warning Appears when calibration data for the plate are not complete. Clicking opens the appropriate calibration function. 

 
Zoom Toggle for the enlarged and normal views of the plate.  

 
Info Clicking displays details about the plate. 

 
Switch Toggle for a photographic and schematic view for the plate. 

  
For more information about working with workspace items, see Section 5.6, page 60. 

 Right-hand pane 

This area provides access to all functions for setting up reagents, samples, and reactions. The contents of the right-hand pane 
change, depending on the item selected. 

For more information about working with the right-hand pane, see Section 5.6, page 60. 
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 Status bar 

The following indicators may be displayed in the status bar at the bottom of the window: 

 Tip-use mode; double-click to modify options 
 Liquid-level tracking mode; double-click to toggle 
 Instrument model and COM port (when instrument is connected) 
 QIAcube HT Software version number; double-click to review software and instrument details 
 Individual operations being performed and error conditions; double-click to review the diagnostic log 
 Active user; double-click to modify user management settings  

 Menus 

The menu bar located at the top of the window provides access to the main functions of the software.  

 “File” menu  

The “File” menu provides access to functions related to run files (Section 5.14, page 104). Some of these functions can also be 
accessed from the toolbar. The following table describes the “File” menu options. 

 Toolbar icon Menu item Description  

 

New (Ctrl+N) Create a new run file or open a recently used run file. 

 

Open… (Ctrl+O) Browse and open an existing run file to run or modify. 

 

Save As… 
(Ctrl+S) 

Save the current setup to the current run file or to a new run file. All instrument-independent parameters required to 
subsequently run the protocol on the connected instrument or on a different instrument are saved. 

 

Lab notebook… Enter comments that are saved with the run file. The comments are displayed when the run file is subsequently 
opened. This feature can be used as a type of laboratory notebook to document the purpose of the run. 

– 1–8  List the last 8 run files that have been used. A run file can be selected from the list to open. 

– Exit (Ctrl+Q)  Exit the QIAcube HT Software. 
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 “Control” menu  

The “Control” menu provides access to functions controlling the instrument. 

The following table describes the “Control” menu options. 

 Toolbar icon Menu item Description  

 

Send Robot 
Home 

Initiates the instrument homing function to reset the position reference for the arm and pipetting head including tip 
ejection. On completion, the arm and pipetting head return to the “rest” position at the rear right of the worktable. 
Used, for example, when the user accidentally moves the pipetting head of the robotic arm while adding or 
removing consumables.  

 

Start Starts the selected run. For more information, see Section 6.3.1, page 140. 

 

Pause/Cancel Pauses a run and records the pause in the post-run report. The run can be continued by clicking Continue Run or 
canceled by clicking Cancel Run in the window that appears. 
Extreme care should always be taken when pausing and opening the instrument lid during a run.  

 

 “Wizards” menu 

The “Wizards” menu allows the user to access wizards for purification, sample name import, reaction list export, and report 
functions. 

The following table describes the “Wizards” menu options. 

 Toolbar icon Menu item Description  

 

Vacuum 
Extraction 
Wizard… 

Starts the “Vacuum extraction” wizard. For more details, see Section 6.3.1, page 140. 

– Import well 
data… (Ctrl+I) 

Opens the “Import Well Data” form, allowing sample identifiers to be imported from text-based spreadsheets. For 
more details, see Section 5.11.6, page 78. 

– Export reaction 
list… (Ctrl+E) 

Opens the “Export Reaction Info” window, allowing details about the contents of reaction wells to be exported to a 
file for external use. For more details, see Section 5.11.7, page 81. 

 

Generate report 
(Ctrl+R) 

Generates a pre-run report describing the required instrument setup and actions to be performed during a protocol 
run. The report can be exported, printed, or saved (see Section 6.3.2, page 142).  
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 “Options” menu  

The “Options” menu controls most instrument setup options, including configuration of run settings, calibration settings, and 
pipetting behavior. 

The following table describes the “Options” menu options. 

 Menu item Description  

User management Control access of software functions for different classes of users. For more details, see Section 5.12.5, page 88. 

Calibration management Transfer calibration and other settings from one laptop to another. For more details, see Section 5.13.4, page 100. 

Robot setup Configure robot-specific hardware parameters and access to wizards for performing various robotic calibrations. See 
Sections 5.12.5 and 5.17 (pages 88 and 121, respectively). 

Run settings Specify global options relating to runs. 

Advanced settings Access additional options for instrument control and specialized applications. Only change these settings as directed by 
your QIAGEN Field Service Specialist. See Appendix A – Advanced settings for more information.  

Change plate type Change the type of the selected plate. For more details, see Section 5.8.2, page 62. 

Change accessory Change the accessory assigned to the selected plate. For more details, see Appendix A – Sample and reaction functions for 
non-wizard protocols. 

Change plate function Change the function of the selected plate. For more details, see Section 5.8.4, page 64. 

 

 “Help” menu  

The “Help” menu provides access to different documentation and diagnostic facilities which are listed in the following table. This 
item can help you to solve problems, sometimes under the guidance of a QIAGEN Technical Service Specialist.  

 Menu item Description  

Contents Display the QIAcube HT User Manual in PDF format. Adobe Acrobat Reader is necessary to view this document. 

Save support package… Create a zipped support package, containing run settings, calibration data, and log information describing the recent 
context of the system for troubleshooting. 

Choose support package… Browse a list of support packages from recent runs. 

Self-diagnostic tools Open a window for self-diagnostics.  

Enable serial communications 
logging 

This option should only be enabled under instruction from your QIAGEN Field Service Specialist. 

View axis usage options View the number of movements each axis has performed since the instrument was last serviced. 

Explore save directory Open the default file directory where run files are saved. 

Display log file Open the current diagnostic log file. 

About QIAcube HT… Display information about the QIAcube HT, including QIAGEN contact information and QIAcube HT Software release 
notes.  

 

Identifying the instrument serial number 

Each QIAcube HT is identified by a unique serial number, which is displayed on the serial number badge at the rear of the 
instrument. The serial number is also stored electronically in the instrument, allowing the instrument to be identified by the software. 
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To view the QIAcube HT electronic serial number, open the Help menu from the menu bar and select About QIAcube HT…. 

 
 
Open the General Information tab in the window that appears. If the electronic serial number and the number on the serial 
number badge do not match or the serial number field is blank, your QIAcube HT Software is running in “Virtual” mode. 

Identifying the software version number 

All QIAcube HT Software versions are identified with a version number consisting of at least 2 groups of numbers and letters 
separated by dots.  

To view the software version number, open the Help menu from the menu bar and select About QIAcube HT…. The version 
number is displayed above the tabs.  

This software version number is also displayed in the lower left region of the status bar in the QIAcube HT Software window 
(Section 5.3.6, page 54). 

Identifying the firmware version number  

All QIAcube HT instruments are identified with a firmware version number. The firmware is software that is running on the 
microprocessor system inside the instrument.  

To view the firmware version number, open the Help menu from the menu bar and select About QIAcube HT…. The version 
number is displayed in the General Information tab. If no firmware number is displayed, the software has not been able to 
communicate with the instrument and is most likely running in “Virtual” mode. 
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 Toolbar 

The toolbar located at the top of the QIAcube HT Software window provides easy access to the main functions in the software. 
Some of these functions can also be accessed from the menu bar. 

 
The toolbar. 

File functions 

 Icon Function Description  

 

New file… Create a new run file or open a recently used run file. 

 

Open file… Browse and open an existing run file to run or modify. 

 

Save file…  Save the current setup to the current run file or to a new run file. All instrument-independent parameters required to 
subsequently run the protocol on the connected instrument or on a different instrument are saved. 

 

Documentation functions 

 Icon Function Description  

 

Generates  
the report for  
this run 

Generates a pre-run report describing the required instrument setup and actions to be performed during a protocol 
run. The report can be exported, printed, or saved (see Section 6.3.2, page 142). 

 

Show help Display the QIAcube HT User Manual in PDF format. Adobe Acrobat Reader is necessary to view this document. 

 

Instrument control functions 

 Icon Function Description  

 

Start run… Starts the selected run. For more information, see Section 6.3.1, page 140. 

 

Pause the run Pauses a run and records the pause in the post-run report. The run can be continued by clicking Continue Run or 
canceled by clicking Cancel Run in the window that appears. 
Extreme care should always be taken when pausing and opening the instrument lid during a run. 

 

Home pipettor 
position and rest 

Initiates the instrument homing function to reset the position reference for the arm and pipetting head including tip 
ejection. On completion, the arm and pipetting head return to the “rest” position at the rear right of the worktable. 
Used, for example, when the user accidentally moves the pipetting head of the robotic arm while adding or 
removing consumables. 

 

Show lab 
notebook… 

Enter comments that are saved with the run file. The comments are displayed when the run file is subsequently 
opened. This feature can be used as a type of laboratory notebook to document the purpose of the run. 
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Processing functions 

 Icon Function Description  

 

Indicate wells… Toggle an option to show or hide the source and destination well indicators, displayed on the workspace for the 
selected reaction list task. 

 

UV lamp Display the UV lamp window. For more details, see Section 5.18, page 130. 

 

Air filter power 
toggle 

Toggle the HEPA Filter on (green) and off (red). Available only when the HEPA Filter is installed. For more details, 
see Section 5.18.4, page 134. 

 

Clean vacuum 
station… 

Display the “Instrument Cleaning Procedure” window. For more details, see Section 7.2, page 151. 

 

Open wizard… Starts the “Vacuum extraction” wizard. For more details, see Section 6.3.1, page 140. 

 

Additional functions 

 Icon Function Description  

 

Service register Open the “Service Register” Window. For more details, see Section 5.18.2, page 131. 

 

Click to  
reset 

Indicates the approximate amount of liquid in the liquid waste bottle. For more details, see Section 3.2.3, 
page 27. 

 

Warning Indicates a warning has occurred. For more details, see Section 8.1, page 162. 

 

Unlocks a 
template 

Allows a template run file to be freely edited as a conventional run file. For more details, see Section 5.15.1, 
page 104. 

 

Indicates a 
QProtocol 
template 

Indicates that the loaded run file is a QProtocol template run. For more details, see Section 5.15.1, page 104. 

 
Indicates a User 
Developed 
template 

Indicates that the loaded run file is a User Developed template run. For more details, see Section 5.15.1, 
page 104. 

 

Displays protocol 
information 

Opens a browser window to display optional read-only protocol details (when the loaded run is a template). 
For more details, see see Section 5.15.1, page 104. 
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 Right-hand pane 

The right-hand pane is at the right side of the software workspace.  

When the software is launched, the right-hand pane is typically gray and empty.  

 
 
Selecting a position in the software workspace displays information about the selected plate in the right-hand pane.  

 
 
The right-hand pane can be closed by clicking the cross at the top, right corner. 

The contents of the right-hand pane are described for the various workspace items. For more details, see Section 5.7, page 61. 
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 Workspace items 

Software workspace items are software definitions that correspond to actual items placed on the QIAcube HT worktable (for 
more information about the workspace, see Section 5.3, page 51). Actual worktable items must be calibrated for use in protocols. 
To ensure proper functioning of the QIAcube HT, the correct workspace items matching the actual worktable items must be 
selected for each layout. For more information about calibration, see Section 5.12.5, page 88. 

The following workspace items are described in subsequent sections: 

 Plates 
 Tips 
 Reagent troughs 
 Samples 

Clicking a workspace item displays information about the item in the right-hand pane. 

 Plates 

A “plate” is a workspace item (Section 5.7, page 61) that corresponds to an object placed on the QIAcube HT worktable in a 
slot or in the vacuum chamber.  

The following types of plates are used on the QIAcube HT: 

 96-well containers (e.g., sample, lysis, capture, and elution plates) 
 Tip racks containing tips 
 Reagent adapters holding reagent troughs containing reagents 
 Accessories such as a cooling block (not normally used on the QIAcube HT) 

Every plate has two basic properties, type and function, that define their use on the instrument. A layout defines the plates (type 
and function) and their positions in the workspace for a protocol.  

 Plate properties 

Information about a selected plate is displayed in the right-hand pane (see Section 5.6, page 60). 

All plates have the properties listed in the following table. 
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 Property Description  

Name Name of the item as it appears in the software workspace. 

Description Description of the item that lists specifications and segments. 

Plate ID User-specified plate identifier or bar code. 

Segment Set ID Internal reference to a software model of the plate in the software plate library. 

Manufacturer Name of the item manufacturer. 

Consumable Part Number Manufacturer’s catalog number. 

Required Adapter Name of adapter, if required. 

Adapter Part Number Catalog number of required adapter. 

Calibration Calibration data, including the position and height information used for accurate pipetting. For more 
details, see Section 5.12.5, page 88. 

Plate use Types of liquids that can be used in the plate (e.g., sample, reagent). 

Pipet Order Description of the sequence in which the instrument uses wells when pipetting. 

Segmentation Arrangement of distinct well groupings defined for the plate. 

Labeling and Well Display Order Description of labels used on plate wells and the sequence in which labels are listed in the grid view 
shown in the right-hand pane. This selection affects the way in which plate data are imported and 
exported. 

Position restrictions Depending on the function defined for the plate, it may be restricted to certain positions in the workspace. 

 Plates with special functions, such as tip racks and reagent troughs, have additional properties, which are described in the 
following section and in Appendix A – Sample and reaction functions for non-wizard protocols. 

 Choosing the plate type  

To accommodate the wide variety of consumables and different types of runs, the type of plates and their locations can be 
changed within a layout.  

The correct type of plate must be chosen for each specific workspace location to ensure proper pipetting. 

Calibration data are information about a type of plate that the software uses to control tip placement during pipetting operations. 
Calibration data are valid only when the type of plate selected in the software workspace matches the actual item on the 
worktable. A plate must be calibrated before it can be used in a protocol. For more information about calibration, see 
Section 5.12.5, page 88. 

Choose the plate type as follows: 

1. Open the software workspace (see Section 5.3, page 51). 

2. Right-click the position of the plate to be chosen. 

3. From the menu that appears, select Change plate type. 

The “Plate Configuration” window appears. 
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4. To display plates that are not tip racks, select QIAGEN and Other in the “Filter to” panel.  

For more information about tip racks, see Section 5.9, page 65. 

5. From the “Select Plate Type” drop-down list, select type of plates to be displayed in the “Plate” list.  

Only the options that are appropriate for the selected position are displayed. 

6. Select a plate from the “Plate” list.  

If you cannot find the plate you want to use, contact QIAGEN Technical Services. 

When a plate type is chosen, manufacturer and part number details (if available) are displayed in the center right window 
to enable plate identification.  

When selecting capture plates in the A1 vacuum position, catalog numbers are displayed with graphics for the matching 
adapters. These catalog numbers are embossed on the actual items for easy identification.  

7. When the correct plate has been chosen, click OK to apply the changes and close the window.  

 Defining favorite plate types 

Plates that you commonly use can be added to the “favorites” list for quick searching.  

Add a plate to the favorites list, as follows: 

1. Open the software workspace (see Section 5.3, page 51). 

2. Right-click the plate that is to be specified as a favorite. 

3. From the menu that appears, select Change plate type. 

The “Plate Configuration” window appears. 
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4. Display previously defined favorites by selecting Favorites in the “Filter to” panel.  

5. To remove a plate from the favorites list, select a plate from the filtered favorites list and click Remove Favorite. 

6. To add a new plate to the favorites list, click another “Filter to” option (such as QIAGEN or Other), choose the desired 
plate, and click Add Favorite.  

7. After setting the “Filter to” options as desired and selecting a plate for the current position, click OK to apply the change 
and close the window.  

 Changing plate function 

Once a plate type has been chosen, the plate function can be changed. This allows the user to define what liquid the plate will 
contain (e.g., samples, reactions, reagents, or other).  

Change a plate function as follows: 

1. Open the software workspace (see Section 5.3, page 51). 

2. Right-click the plate for which the function is to be changed. 

Note: A plate may have multiple segments that are specified with different functions. In this case, select the segment for 
which the function is to be changed. 

3. From the menu that appears, select Change plate function. 

The available functions appear as a new menu. 

4. Select the appropriate function.  

Note: Sample plates are source plates only. If a plate containing samples is used for ejection and distribution, it has to be 
defined as reaction plate. 

5. Click OK to apply the change and close the window.  
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 Tips 

Tips are placed on the instrument worktable in 96-well racks in manner similar to the way conventional 96-well plates are placed. 
Accordingly, the software treats tips as special tubes that are placed in 96-well tip-rack plates. Tip workspace items are configured 
in the software using the same mechanisms that apply to conventional plates. 

 
A typical workspace representation of a tip-rack plate. 

 Tip properties 

Information about a selected tip-rack plate is displayed in the right-hand pane (Section 5.6, page 60). 

 
Right-hand pane information for a tip-rack plate. 

In addition to the properties that all plates have (see Section 5.8.1, page 61), tips have the properties listed in the following 
table. 
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 Property Description  

Tip Type For all tip types in the workspace setup, a description of the nominal volume capacity for a tip.  

Available For all tip types in the workspace setup, the number of tips available. 

Required For all tip types in the workspace setup, the number of tips required for the protocol. 

Enough Tips? For all tip types in the workspace setup, a flag indicating whether the number of tips available is sufficient 
for the protocol. 

Location For each tip rack, the position on the worktable. 

Capacity For each tip rack, the volume capacity for a tip. 

Tips remaining For each tip rack, the number of available tips. 

Position restriction Tips can be placed in positions B1, B2, C1, and C2 in the workspace. Conventionally, they are used only 
in positions B2 and C2. 

 

 Tip availability 

Tip availability describes the presence or absence of tips at positions in tip racks on the worktable. If tips are physically removed 
from or added to the worktable, the tip availability information must be manually updated in the software to match the tips on 
the worktable. 

During the run, the software uses tip availability information to collect and use tips present on the worktable. If the information is 
incorrect, the instrument may attempt to pick up a tip from a location where no tip is available and the run will not proceed 
correctly.  

The software tracks tip use and internally updates the tip availability as the run proceeds. This information is recorded at software 
shutdown and reinstated at software startup.  

If the tip supply is exhausted during a run, the system pauses with a notification to the operator that empty tip racks must be 
replaced with full racks.  

In the software workspace, tip availability status in tip rack positions is indicated as follows: 

 Available (present) — dark blue 
 Unavailable (absent) — white 
 Used (dirty) tips — red (considered unavailable for software calculations) 

Tip availability options are set with the tip operations menu, which is accessed by right-clicking a tip rack on the software 
workspace.  
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Tip operations menu. 

Setting tip availability for a single column of tips 

Liquid-handling tasks are performed with an 8-channel pipettor. Thus, operations performed on a single tip are applied to all 8 
tips in the column of the rack.  

A convenient shortcut allows the availability of a column of tips to be changed. While pressing the “Alt” key, click a tip location. 
The tip status toggles between available and unavailable. The color of the tip column position changes to indicate the change in 
status. 

Setting tip availability for a selection of tips 

Set tip availability for a selection of tips as follows: 

1. Select tips in the tip-rack plate in the software workspace (see Section 5.3, page 51). 

Selected tips are indicated with red outline. Availability can be set for only one selection at a time. 

2. Right-click to open the tip operations menu. 

3. Select Set selected tips to ‘Available’ or Set selected tips to ‘Unavailable’. 

The color of the tip positions changes color to indicate the status. 

4. Repeat the process until the availability is set for all tips.  

The color of the tip positions changes to indicate the change in status. 
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Setting tip availability for plates 

Set tip availability for all tips in a plate as follows: 

1. Select a tip-rack plate in the software workspace (see Section 5.3, page 51). 

2. Right-click to open the tip operations menu. 

3. Select one of the following options:  

 “Set all tips on current plate to ‘Available’”  
 “Set all tips on current plate to ‘Unavailable’”  
 “Set all tips on all plates to ‘Available’”  
 “Set all tips on all plates to ‘Unavailable’”  

The color of the tip positions changes to indicate the change in status. 

 Reagents 

A reagent is a liquid type located in a “source” container (typically a reagent trough on the worktable) that is combined with a 
sample in “destination” reaction wells during protocol processing. Each reagent normally performs a specific function in the 
process of sample purification, such as digestion, binding, or washing.  

In typical QIAcube HT protocols, reagents are defined in the following plate types (Section 5.8, page 61): 

 Adapter, Reagent Trough SBS Plate 
 Adapter, Reagent Trough R1 Position Plate 

 Reagent properties 

Information about a selected reagent trough is displayed in the right-hand pane (Section 5.6, page 60). 

 
Right-hand pane information for a reagent plate. 

In addition to the properties that all plates have (see Section 5.8.1, page 61), reagents have the properties listed in the following 
table. 
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 Reagent property Description  

Name Reagent identifier. Each reagent identifier used in a run must be unique. 

Def. Vol. (µL) Default volume of reagent to be dispensed by one channel to each reaction well. In typical protocols, this 
value is set to 0 and reagent volumes required at each processing step are defined using the “Vacuum 
extraction” wizard. For more details, see Section 5.10.3, page 70. 

Viscous Indicates that the liquid is viscous. Selecting Yes instructs the software to use the “Reagent speed (viscous)” 
pipetting speed. Otherwise, software uses the “Reagent speed (normal)” pipetting speed.  

Mix Count Number of times a reagent is aspirated and dispensed to mix for improving homogeneity before first use. 

Drip Pause (sec) Duration of a pause which allows reagent adhering to the external surface of the pipet tip to drain when 
pipet tip is withdraw to liquid level and pauses, defined in increments of 0.25 seconds. 

Extra Vol. (mL) Volume at the bottom of the tube or trough that cannot be aspirated by tips and must be supplied in 
addition to the nominal volume required for the run. The value depends on the plate type chosen: 
Typically 5 µL for 20 µL PCR tubes and 0.35–7 mL for reagent troughs. As volume loss due to pipetting 
and evaporation can be substantial, this value should be reduced with care. 

  
Note that a reagent plate may have multiple sections that contain different reagents. For more details about segments, see 
Appendix A – Sample and reaction functions for non-wizard protocols. 

To open a tooltip displaying additional information about a reagent trough and its contents, place the mouse pointer over the 
position in the software workspace.  

 

 Configuring reagents 

Reagents can be configured by completing the following steps: 

1. Open the software workspace (see Section 5.3, page 51). 

2. Right-click the position of the reagent to be specified. 

Initially, the reagent position in the software workspace appears gray.  
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3. In the “Reagent Options” panel of the right-hand pane, check the Use Reagent box. 

4. Enter the corresponding details in the “Reagent Configuration” panel to specify the reagent name, viscosity, and related 
pipetting parameters.  

For more information about reagent properties, see Section 5.10.1, page 68. 

When the reagent has been specified with a non-blank name, the background color of the reagent position changes in the 
workspace to pale orange (by default). When a non-zero default volume is also provided, this color becomes more intense. 

 Required reagent volume  

When the addition of reagents is specified in run setup, the software calculates the total volume of the reagent required for the 
run. The required reagent volume includes the volume of reagent dispensed, as well as any additional volume necessary for 
accurate liquid transfer (specified as “Extra Vol.”; also see Section 5.10.1, page 68). 

The required reagent volume is displayed in the reagent position. 
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Required reagent volume. 

 Samples and reactions  

A “sample” is a liquid type located in a source container which is combined with reagents in destination reaction wells during 
protocol processing. 

A “reaction” is a liquid type located in a destination container (e.g., a lysis plate) to which other liquids such as sample and 
reagent are added during protocol processing and from which liquid may be removed during processing. 

In purification protocols, raw sample materials may be initially placed in either sample or reaction containers, typically multiwell 
plates or blocks (Section 5.8, page 61). When treated as a sample, raw materials are always aspirated and moved to another 
plate before further processing. When treated as a reaction, raw materials are configured as “preloaded” (e.g., in a lysis plate) 
and other reagents may be added before further processing. 

Sample and reaction containers, such as lysis plates and reagent troughs, have identifiers to allow a unique description of the 
raw sample material to be tracked to other reaction wells (e.g., the capture plate) during liquid transfer. 
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 Sample properties 

Information about a selected sample segment on a plate (Appendix A – Sample and reaction functions for non-wizard protocols) 
is displayed in the right-hand pane. 

 
 
Properties of sample segments are described in the following table. 
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 Property Description  

Sample bank  

Sample Bank Name A sample bank is a selection of wells in a plate segment that is grouped and treated as a single unit for 
liquid-handling operations. In the QIAcube HT Software, sample banks are always aligned to the 8-
channel pipettor. 

Sample data  

Well Position in the sample plate. 

Sample Name Name of the sample. When not specified by the user, the software assigns a name based on the sample 
position. 

Sample ID Sample identifier. This can be any textual identifier (e.g., an alphanumeric bar code) which may 
represent a label on the tube or its contents. Software tracks the sample identifier to target reaction wells. 

Conc. Sample concentration. This may be specified in a unit specific to the application and usually represents a 
quantity (e.g., number of copies, mass, etc.) per unit volume. The software assumes the same unit is used 
for all concentration values in the run. 

Bar code See the “Sample ID” entry above. 

 To use samples in reactions, they must be organized into sample banks (see Appendix A – Sample and reaction functions for 
non-wizard protocols). The following sample bank operations are accessible from the samples right-hand pane. 

Delete Bank Deletes the selected sample bank. Deleting a sample bank will not affect sample names, sample 
identifiers, or concentrations. 

Rename Bank Opens a window in which the sample bank name can be changed. Click OK to continue. 

New Bank Displays the “Update Sample Bank” window, which enables a new sample bank to be created. See 
Appendix A – Sample and reaction functions for non-wizard protocols. 

Edit Bank Displays the “Update Sample Bank” window, which enables an existing sample bank to be modified. 
See Appendix A – Sample and reaction functions for non-wizard protocols. 

Select sample bank Select a sample bank from the drop-down menu. Members of the selected bank are indicated in the grid 
view. 

 Reaction properties 

Information about a selected reaction segment on a plate (Appendix A – Sample and reaction functions for non-wizard protocols) 
is displayed in the right-hand pane. 
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Properties of reaction segments are described in the following table. 

 Property Description  

Reaction list  

Operation A list of all processing operations defined in the protocol. 

Reaction data  

Well Position in the reaction plate. 

Final Contents Description of final contents of the well, indicating the net effect of all liquid additions and removals 
during run processing. The information shown in the tooltip displayed for the well may be different as only 
added liquids are listed. 

ID Reaction identifier. This can be any textual identifier (e.g., an alphanumeric bar code) which may 
represent a label on the tube or its contents. The software tracks the identifier of a reaction container to 
target reaction wells when contents are transferred. The displayed identifier includes the assigned 
identifier as well as the identifiers of any sample and reaction contents transferred from other containers. 

Conc. Reaction concentration. This may be specified with a unit specific to the application and usually 
represents a quantity (e.g., number of copies, mass, etc.) per unit volume. The software assumes the same 
unit is used for all concentration values in the run. The concentration shown is either the value explicitly 
assigned for the well, or a value calculated based on the concentration of sample or reaction contents 
transferred from other plates or reagent troughs. 

Bar code See “ID” entry above. 
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The “reaction list” panel shows the sequence of instrument instructions to be performed during the protocol run. Functions to 
manipulate instrument instructions are as follows. 

Add… Opens the “Reaction Configuration” window. See Appendix A – Sample and reaction functions for 
non-wizard protocols. 

Edit Opens the “Reaction Configuration” window. When possible, enables a reaction to be edited. 
Alternatively, double-click a reaction to open the “Reaction Configuration” window. 

Copy Copies selected reaction. Click on a reaction in the “Reaction List”, and click Copy. If there is more 
than one reaction in the list, a submenu appears. Select Copy in-place?, Copy to end of list?, or 
Cancel. 

Delete Deletes selected reactions. To delete more than one reaction, hold down the “Shift” or “Ctrl” key, 
click reactions in the “Reaction List” to select them, and click Delete. 

Retarget Enables a reaction to be retargeted to a different reaction plate. Click on the new reaction plate to 
select it, click a reaction in the “Reaction List”, and click Retarget. Click Yes in the message that 
appears to continue. 

? Displays a summary of the selected instruction. 

Up / Dn Modifies the reaction list order. Click reaction to be changed in the “Reaction List”. Hold down the 
“Shift” key to select multiple reactions. Click Up or Down to move the selected reaction(s) up or down 
in the list.  

Special Enables a “Special” reaction to be set up and added to the “Reaction List”. See Appendix A – Sample 
and reaction functions for non-wizard protocols. 

Select All Selects all of the reactions in the “Reaction List”. 

 Highlights reagents that are involved in a selected reaction in green. Click the icon again to remove 
the highlight. 

 Highlights sample banks that are involved in a selected reaction in orange. Click the icon again to 
remove the highlight. 

 Highlights destination reaction wells that are involved in a selected reaction in blue. Click the icon 
again to remove the highlight. 
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 Common properties and operations 

In addition to identifiers for individual wells and concentration properties, the following properties and operations are common 
to sample and reaction segments: 

 Property Description  

Plate ID Any textual identifier (e.g., an alphanumeric bar code) that may represent a label on the plate can be 
associated with the selected segment. 

Bar code Entry ( ) 
Interactive entry of individual well identifiers, as described in Section 5.11.4, page 76. 

Well Data Import (“Import” button) Import of identifier and concentration details from a file, as described in Section 5.11.4, page 76. 

Well Data Export (“Export” button) Export of well content details to a file, as described in Section 5.11.6, page 78. 

Sample Bank Operations Configuration and modification of sample banks for use in liquid-handling operations, as described in 
Appendix A – Sample and reaction functions for non-wizard protocols. 

Clear (“Clear” button) Deletion of user-assigned names, identifiers, and concentration values from all rows of the grid view. 

Well Display Order (Options ‘Pipetting 
Sequence’ and ‘Label Sequence’) 

Sequence in which wells are displayed in the sample or reaction data grid (i.e., “Label Sequence” or 
“Pipetting Sequence”). Each plate type has a specific pipetting order and specific label order. Where 
these are different (e.g., vertical pipetting order and horizontal label order), the sequence in which wells 
are listed in the grid changes according to the well display order selection. This function is useful, for 
example, when it is convenient to distribute liquids by column (vertical pipet order), but to export the data 
by row (horizontal label order). 

Plate ID Any textual identifier (e.g., an alphanumeric bar code) that may represent a label on the plate can be 
associated with the selected segment. 

  
The following options are accessed by right-clicking the cells of the sample or reaction right-hand pane grid view. 

Copy all Copy all the grid data to the system clipboard. The data can be pasted into a Microsoft Excel® or text 
file. 

Paste to current cell Paste a list of values from the system clipboard (e.g., previously copied from an Excel sheet or text file) 
into the selected column. 

Row height Adjust row height. Select Grow to increase the row height or select Shrink to decrease the row height.  

Export Export the grid data directly to another file. Select either Export to CSV or Export to Excel (only available 
when Excel is installed). 

 Entering sample bar codes 

Sample bar code identifiers can be imported using bar code readers that are connected to a laptop via a USB or keyboard 
wedge. A keyboard wedge is an input device that is inserted between the keyboard plug and the laptop keyboard socket. For 
the best results, the bar code reader system should be able to simulate user tabs or carriage returns appended to the bar code. 
These simulated tabs or carriage returns automatically move the data input point (cursor) on the data table to the next input cell 
each time a bar code is read.  
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1. Click a “Sample” or “Reaction” plate to view the sample or reaction right-hand pane. 

2. Click the  icon.  

The “Bar code Entry” window opens. 

 
3. Scan the sample or reaction identifiers. 

Identifiers are automatically added to the “Bar code Entry” table.  

4. To add samples or reactions directly to a sample bank, select Add to sample bank, named, in the “Sample Bank Name” 
panel. Alternatively, select either New Bank or Existing Bank. If “New Bank” is selected, enter a sample bank name. If 
“Existing Bank” is selected, click a sample bank to select it. 

Note: Sample bank operations are disabled if the run has been set up using the “Vacuum extraction” wizard 
(Section 6.3.1, page 140). 

5. Click OK to return to the main software window. 

 Data transfer formats 

Some sample and reaction data can be exported and imported (see Sections 5.11.6 and 5.11.7, pages 78 and 81, 
respectively).  

In the export mode where the data can be defined by the user, the user must specify the data content by writing an export string. 

The following table lists the data designators for export strings. 
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 String Sample export Reaction export  

%0 Separator (comma, tab) Separator (comma, tab) 

%1 Well number in selected display order 
(label or pipetting sequence; e.g., “10”) 

Destination well number in selected display order (label or pipetting sequence; e.g., “10”) 

%2 Well location (address label; e.g., “G3”) Destination well location (address label; e.g., “G3”) 

%3 Sample type (none, unknown, standard) Sample type (none, unknown, standard) 

%4 Sample concentration (if known) Source concentration (if known) 

%5 Sample name Final contents, including full names and volumes 

%7 – Target volume 

%8 – Sample name, including volume 

%9 – Reagent name, including volume 

%A – Final contents, including full names and excluding volumes 

%S – Sample name, excluding volume 

%R – Reagent name, excluding volume 

%V – Sample volume 

%F – Final concentration (if known) 

%P Plate identifier Destination plate identifier 

%p – Source plate identifier 

%I Sample identifier Total identifier, including tube or reaction identifier and constituent identifiers of contained 
samples. 

%C  Constituent identifiers of contained samples. 

%T  Tube or reaction identifier. 

  
For example, to generate a *.csv file from a sample plate that contains the sample number, the sample location, and the sample 
identifier, the valid format string is: 

%1 %0 %2 %0 %I 

 Importing sample and reaction data 

In addition to a quick, manual function for importing sample names, files containing sample and reaction data can be imported. 

Manual import of sample names 

Sample names can be easily copied from a spreadsheet by copying the column that contains the sample name information. The 
copied entries are pasted to the QIAcube HT Software by right-clicking a cell and selecting the “Paste to current cell” item from 
the menu that appears. Sample names are copied to the target cells. 

File import of sample and reaction data 

1. Click the  button.  

2. Select the file type to import (i.e., *.csv, *.txt, or *.*), select the file, and click Open. 

3. Select a column separator.  
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“Comma” is the default when selecting a *.csv file. Other separators (e.g., tab) can be used. If needed, the ASCII code for 
any character can be specified, making the import function universal. 

Tab Tab character. 

Comma Comma character. 

ASCII Char Character specified by an ASCII value (e.g., “9” (tab), “44” (comma), “32” (space), “58” 
(colon). 

4. Some text-based spreadsheets contain strings of special characters (e.g., $, “, or #). If these are not required as part of the 
sample names, select Remove from fields, separate with. Enter the symbol to be removed. Multiple character sequences can 
be removed by separating them with “;”. 

5. In the “Import Options” panel, select the starting import row and well in the Start importing FROM row and Start importing 
TO well fields. 

Start importing FROM 
row 

Defines the first row in the file from which the data will be imported. 

Start importing TO well Defines the first well in the “Sample” or “Reaction” plate to which the data will be 
imported. 

6. Select the remaining options in the “Import Options” panel as desired, and select the column from which this information 
will be imported. 

Note: The software will automatically limit the number of rows imported to prevent overrunning the end of the import file 
and to prevent exceeding the available wells on the plate. 

Limit sample count to Defines the maximum number of rows of data that can be imported from the file. 

Sample name from 
column 

Instructs the software to import the sample name from a specific column in the file. 

Load ID from column Instructs the software to import an identifier from a specific column in the file. 

Load Conc. from column Instructs the software to import a concentration value from a specific column in the file. 
 
7. The “Sample Bank Options” panel of the form describes how data are to be imported to one or more sample banks in the 

run. To activate these options, select Add filtered rows to sample bank(s). Only one option may be activated at a time. 
The options are: 

New Bank Defines the name of a new sample bank. 

During import, the new sample bank is created and the wells to which data are imported 
are used to populate the new sample bank. 

Existing Bank Displays a drop-down list of existing sample banks already configured in the target plate 
or segment of the run. 

During the import, the wells to which data are imported are added to the selected sample 
bank. Existing members of the sample bank prior to import are retained unchanged. 
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Bank from column Defines a column that indicates for each row the name of a sample bank containing the 
well. At most one sample name per well (row) is permitted (and a blank name indicates 
the well is not a member of any bank). 

During import, the software ensures that for the data set imported each sample bank 
name in the column is created or updated to include the corresponding member well. 

Banks named from 
membership columns 

Defines a list of column indices where each referenced column represents the name and 
contents of a sample bank. For each such column, the name of the sample bank is in the 
first (header) row of the file and any non-blank value in subsequent rows of the column 
represents membership of the well in the sample bank. 

During the import, the software ensures that for each column in the list the corresponding 
sample bank is created or updated to include the member wells of that column in the data 
set imported. 

Note: Sample bank operations are disabled if the run has been set up using the “Vacuum extraction” wizard (See 
Appendix A – Sample and reaction functions for non-wizard protocols). 

8. The “Row Filter” function allows the user to filter the imported data, limiting the selection of rows prior to import. During 
import, only filtered rows displayed in the “Import Preview” pane are included in the imported data set. Two filters may be 
used. When used together, only rows matching both filtering criteria are included in the selected data set. 

The first filter is based on a concentration range. If desired, select the Specify concentration range [Min, Max] function and 
then define the options as required. Filtering is based on the concentration values present in the column selected in the Load 
Conc. from column configuration option. When active, the “Import Preview” pane shows only those rows where the 
concentration filter criteria are met. 

Min Concentration Defines the minimum concentration of the concentration range. 

Max Concentration Defines the maximum concentration of the concentration range. 

Use selected wells INSIDE 
range 

Instructs the software to select rows where the concentration value is within the defined 
concentration range. 

Use selected 
wells OUTSIDE range 

Instructs the software to select rows where the concentration value is outside the defined 
concentration range. 

The second filter is based on membership in at least one sample bank selected from the file. This function, Members of 
selected bank columns only, is available when Bank from column or Banks named from membership columns is selected. 
When the filter is activated, the “Import Preview” pane shows only rows with a non-blank value in the selected Bank from 
column or with a non-blank value in any one of the columns listed at Banks named from membership columns. 

Note: Sample bank operations are disabled if the run has been set up using the “Vacuum extraction” wizard (see Appendix 
A – Sample and reaction functions for non-wizard protocols). 

9. The “Import Preview” panel displays the samples to be imported. Click Import to import the data. The imported data will be 
displayed in the right-hand pane.  

Note: No data are imported from a row in which all fields are empty. 

Note: Existing data will be overwritten by any imported data that are located in the same well. 

Note: Multiple sample banks are simultaneously imported using the Banks named from membership columns function. 
Alternate strategies allow multiple sample banks to be successively populated from the same import file. For example, the 
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Bank from column function can be used, where several columns, one per sample bank, are present in the file and each row 
includes the bank name in the corresponding column to indicate its membership in that bank. Set the Bank from column 
and activate the Members of selected bank columns only filter. Click Import. Repeat for each sample bank column in the 
file. This can also be accomplished using the concentration filter function. Arrange the import file so that it has a column 
representing each sample bank. Populate the rows in each column with a concentration value (e.g., 0) to indicate 
membership of that sample in that bank. Set the Row Filter to include rows with concentrations in the range (0, 0). Set the 
Load Conc. from column and choose the sample bank name as a New Bank or Existing Bank. Click Import. Repeat for each 
sample bank column in the file. 

 Exporting sample and reaction data 

Sample and reaction data, which is listed in the sample and reaction right-hand pane, can be exported in a number of formats. 
This can be used to transfer data to the QIAGEN QIAgility or Rotor-Gene® Q instruments, or other data storage systems (e.g., 
laboratory information management system [LIMS] environments). 

To export sample or reaction data: 

1. Click a sample or reaction plate to view the right-hand pane. 

2. Click Export. 

The “Export Samples” or “Export Reaction Info” window appears.  
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3. Select an export mode from the drop-down list. 

CSV File (Excel 
compatible) 

A *.csv text file with comma separators between columns. The data are fixed and 
contains the number, location, sample name, reagent name, sample type, 
concentration, and target volume. 

RotorGene v4.4 A *.sam sample file which is compatible with the Rotor-Gene 2000/3000 software 
version 4.6–5.x. The data are fixed and contains location, sample name, and sample 
type. 

RotorGene v4.6 or later A *.smp sample file which is compatible with the Rotor-Gene software version 4.6 or 
later. The data contains the sample concentration and a user selectable sample identifier 
which can be either sample name or sample identifier. 

Custom, comma 
separated 

A *.csv text file with comma separators between columns. The data can be user-
defined. 

Custom, tab separated A *.txt file with tab separation between columns. The data can be user-defined. 

Export directly into Excel 
97 or later 

Creates an *.xls spreadsheet file, and if Excel is installed on the laptop, automatically 
launches Excel with the imported data. The data can be user-defined. 

Tube Map CSV file A *.csv file with format fixed as “well-location, plate identifier, sample identifier” (using 
the substitution pattern %2%0%P%0%I, as described in Section 5.11.5, page 77). This 
describes the mapping of a tube or well location (plate and well label) to its contents 
(sample identification). 
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Roche® MagNA Pure® 
LC copy/paste import 
file 

A *.csv file with format fixed as the single column “sample identifier” (using the 
substitution pattern %I as described in Section 5.11.5, page 77). This describes the 
contents of each well to facilitate export to the Roche MagNA Pure LC instrument. 

Rotor-Gene Q v1.x, 
6000 v1.x & 3000 v6.x 

A *.smp sample file which is compatible with the Rotor-Gene Q, Rotor-Gene 6000, and 
late revisions of the Rotor-Gene 3000 software. The data for each reaction contains a 
user selectable sample identifier and a user selectable concentration. Data can be 
grouped into “pages” according to the reaction identification. 

QIAxcel® Sample Info 
Text File (8x12 well 
grid) 

A *.csv “Sample Info Text” file which can be imported into the QIAxcel software. The 
data are organized in an 8 x 12 grid that contains a user-selectable identifier for each 
well of the 96-well plate. 

QIAxcel ScreenGel® 
(XML) 

A *.xml file in rack file format which can be imported into the QIAxcel ScreenGel 
software. This export format is only available for 96-well plates. 

Generic XML Export A *.xml file in generic format described in Appendix. A XSL file can be selected that is 
used as transformation. 

4. Choose an output format.  

The output formats available depend on the export mode that was selected. 

Sample Label Determines how the sample is to be named when the data are imported into the Rotor-
Gene Q or QIAxcel software. 

Concentration Option Determines the concentration value to be associated with the reaction for import into the 
Rotor-Gene Q software. 

Page Option Determines how the reaction data are to be grouped for analysis purposes after import 
into the Rotor-Gene Q software. 

Empty Label Determines how unpopulated reaction wells are named during export to the QIAxcel 
Sample Import Text file format. 

Sample Label 

Full ID Comprises the identifier of the reaction well (“Reaction ID”) and all identifiers of 
contained samples (“Sample ID”). 

Sample ID A list of sample identifiers present in the reaction well. 

Reaction ID The user-assigned label associated with the reaction well. 

Sample Name A list of sample names present in the reaction well. 

Concentration Option 

Sample/Source Uses the initial concentration value. This is associated with the source sample or 
standard well. 

Final Reaction Uses the final concentration value of the sample or standard after dilution with other 
liquids. This is associated with the reaction well. 

Page Option 
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Reaction ID Reactions are segregated according to the reaction identifier (user-assigned label) 
associated with the well. For each reaction identifier, a page is created and named 
according to the identifier. 

None All reactions are placed into a single page named “Page 1”. 

Empty Label 

None No identification is used (blank). 

Label The well label is used as the identifier. 

Label Number The index of the well in the pipetting sequence is used as the identifier. 

Well Number The index of the well in the (horizontal) sequenced grid export is used as the identifier. 

5. Click Export. 

6. Enter a file name and select the location to which the data will be exported.  

7. Click Save to continue.  
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 User management 

User management allows the definition of different access rights to various data and functions within the QIAcube HT Software. 

User management functions are accessed from the menu bar (Options > User Management). 

 User identification 

Unlike software that requires separate login authentication, the QIAcube HT Software user is defined as the current Windows 
user logged on the laptop on which the software is installed.  

The user identification function is always active and the user's identification is reported in all pre and post run reports as well as 
diagnostic logs produced by the software during normal operation. 

Note that access privileges are included only to support a particular use policy for the software and are not intended to prevent 
accidental or intentional circumvention of the policy or misuse of the software. 

All users are able to edit and save modified run files (Section 5.14, page 104). If the run file is not saved with a new name, the 
previous run file data will be lost. If required, standard Windows file system write-protection mechanisms may be used to protect 
run-file data. 

 User classes 

The QIAcube HT Software supports the following user groups:  

 QIAcube HT Operator 
 QIAcube HT Designer 
 QIAcube HT Manager 
 Windows Administrator 

In the following we will speak of Operator, Designer, Manager, and Administrator. 

Operator 

An “Operator” user can navigate and view table layouts, run settings, and reaction list data with “view/read only” access. 

Operators have “edit” access to perform the following: 

 Update “lab notebook” text information for a run file 
 Set tip availability 
 Assign identifiers and bar codes to plates, identifiers to wells, and bar codes to samples or reaction wells for a protocol run 
 Modify the set of wells associated with sample banks used in the protocol run 
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An Operator cannot modify reaction properties. 

Designer 

A “Designer” user has all access rights as an Operator and, in addition, has “read/write” access to all functions of the software 
including the ability to: 

 Design table layouts 
 Calibrate the instrument  
 Define run settings  
 Setup the reaction list  
 Import and export data  

Designers are expected to define template run files (Section 5.14, page 104) and specify calibration data (Section 5.13, 
page 89) to be used by Operators. 

Manager 

A “Manager” has all access rights as a Designer. In addition, Managers can: 

 Enable and disable the access control function in the software (Enable User Access option, see Section 5.12.3, page 87)  
 Update group membership for each of the QIAcube HT groups if they are able to elevate to an Administrator 

Administrator 

An Administrator has all access rights as a Manager. 

An Administrator user is a member of the standard local Windows administrator group and has full administrative access on the 
computer. This is necessary to update the QIAcube HT group membership. 

A Manager enables the user access control, a Manager/Administrator assigns users to groups (see the following sections). 

Upon restarting the software, only Administrators and users assigned to the “Manager”, “Designer” and “Operator” groups can 
operate the software. When attempting to start the QIAcube HT Software, users that are not assigned to a user groups are denied 
access to the software.  

When user access control is disabled, all users are given “Manager” access.  

Upgrading the software does not affect user access control. 
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 Enabling access control 

Upon installation, the QIAcube HT Software user access control features are disabled and all users have “Manager” access (see 
the previous section for user group descriptions).  

A Manager enables the user access control with Options > User management > Enable access control. 

You can toggle between enabled and disabled states. A tick appears next to “Enable access control” when this option is enabled.  

If the access control is enabled it is directly active. Be careful to enable the access control only if you are a Manager. 

 Managing user groups 

The user groups will always be managed on the local laptop where the software is installed even if you are connected to a 
domain. 

If you are a Manager you can use the management functions on the menu bar Options > User Management > Users & Groups 
to change the group’s membership. You need the right to elevate to an Administrator to really save your changes. 

To set the group’s membership of users on the laptop computer: 

1. Open the Options menu, and select User management > Users & Groups. 

2. The “Users & Groups” window appears. 

3. Select the user from the “Users” panel. 

 
4. Select the group to which the selected user should be assigned (i.e., Administrators, QIAcube HT Manager, QIAcube HT 

Designer, or QIAcube HT Operator) in the “Possible Groups” panel. 
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5. Click the  button to move the selected group into the “Guest’s Groups:” panel. 

 
6. To assign the user to more than one group, repeat steps 4 and 5. 

7. Click Save to really save your changes. This needs elevation to an Administrator. If you are not elevated at this moment, a 
pop-up of the operating system will appear to ask for elevation. 

 Change current user 

To change users, the current user must shut down the software and log out of Windows. The new user must subsequently log in 
to Windows and restart the software. 

Alternatively, select Options > User management > Change Current User. The “Change User” window appears. The new user 
must enter their username and password, and click OK to log on. 

 
 
If the login was successful the new rights will take effect immediately. 
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 Revert to first user 

If you want to become again the user who started the software, select Options > User Management > Revert to First User. 

 Calibration 

Before an item can be used on the instrument for a protocol run, the locations of the items on the worktable and the heights of 
the items in the position must be configured with a process that is referred to as “calibration”. Volumes can also be calibrated to 
ensure the QIAcube HT distributes liquids accurately. 

The following calibrations are available: 

 Plate position  
 Plate height  
 Volume  

The QIAcube HT employs several locating mechanisms to ensure that items placed on the worktable are positioned correctly. For 
example, the reagent trough adapter is located by pins which serve to orientate the adapter correctly and ensure that the 
supported troughs are positioned correctly. Similarly, plates are secured by a positioning mechanism and clamps on the table 
rails. Care must be taken with some plates to ensure that correct orientation is maintained.  

Once the QIAcube HT has been correctly installed and calibrated, there is generally no need for recalibration. However, if the 
instrument is moved or serviced, we recommend that calibrations be checked and re-calibration performed if needed. 

All calibration data are unique to a particular instrument and are stored locally as part of the software installation. The calibration 
data are not saved with the run files. This allows run files to be transferred between instruments at different sites without 
modification. During a run, the software always uses the local calibration data specific to the instrument on which it is run. 

When an instrument is connected to a new laptop, calibration data obtained on the previous laptop can be moved to the new 
laptop. Because calibration data are associated with the instrument's unique electronic serial number, calibration data from 
several instruments can be used correctly on a single laptop. 

Joy pad 

The use of a joy pad (a game controller that has only buttons and no stick) can make position calibration significantly easier. A 
USB joy pad can be connected to the laptop that controls the QIAcube HT. During calibration, the user controls the robotic arm 
movement with the joy pad. This can significantly speed up the process, especially for position calibration. 

Note: The joy pad must be connected before the calibration wizard is opened. 

Note: Plate height and position calibration data are used to position tips within the wells or tubes of the plate. Accurate plate 
calibration is essential for proper functioning of the QIAcube HT. 
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 Calibrating plate positions 

Plate position calibration defines the positions of wells or tubes in a plate to be used on the QIAcube HT worktable. Calibration 
ensures that the robotic arm moves to the correct location for every well on the plate.  

For each QIAcube HT worktable location, position calibration is required for each plate type used in that location: Each plate 
must be independently position calibrated in all worktable locations in which it is used.  

Plate positions are calibrated with the Options > Robot setup > Calibrate plate positions… option. 

WARNING 

 

Risk of personal injury 
The robotic arm moves during position calibration while the instrument lid is raised. Never click any 
buttons while parts of your body are within the instrument workspace. 

 
As tips are used during position calibration, ensure that the workspace configuration correctly describes the worktable setup of 
tip types and tip rack positions before calibrating. 

The position calibration function requires tip racks to be calibrated before any other plate type. The procedure for calibrating tip 
rack positions is the same as for other plate types. 

Plate position warning 

Clicking the warning icon ( ) at the top, right corner of a plate that requires position calibration opens the “Set Alignment” 
wizard and the following warning.  
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Performing plate position calibration 

To perform a position calibration, follow these steps: 

1. Open the instrument lid. 

2. Place the plates to be calibrated on the instrument worktable.  

If possible, do not place consumables in the plates. Position calibration should be performed on the “true” position of a 
well, not a position of a consumable that may not fit well. 

3. If calibrating a tip rack position, use an empty tip rack. Otherwise, ensure that 200 µL tips in an appropriate, calibrated tip 
rack are placed properly on the worktable and that the tips availability is set properly. 

For more details, see Section 5.9.2, page 66. 

4. Select Options > Robot Setup > Calibrate plate positions. 

5. Read the warning about modifying calibration data (shown in previous section), and select Yes. 

The “Position Calibration” window appears. 

 
6. If not calibrating a tip rack position, click Get New Tip to load tips onto the pipettor. If calibrating a tip rack position, use 

the pipettor hubs only without tips attached. 

7. From the “Plate Selection” list, select the type of plate to be calibrated.  

If any tip rack position is not calibrated, the software will prevent calibration of other plate types. 

Multiple plates can be calibrated in a single run.  

Plates that have not been previously calibrated are listed as “(not calibrated)”. After calibration, this status changes to 
“(updated)” to indicate that the changes have been made (but not saved). 

8. Use the X-position and Y-position arrow button controls to position the pipetting head over the column to be calibrated. 

The column to be calibrated is indicated in red in the software workspace. 

Note: When calibrating the capture plate position A1 by using Capture Plate VX or Capture Plate DX, ensure the mat 
support with correctly fitted silicone mat is correctly inserted in the vacuum chamber (waste side) and calibrate directly into 
the holes of the mat (i.e., without the capture plate in place). 

9. Lower the pipetting head by clicking Lower Tip several times until the tip (or pipettor hub if no tips are attached) is just 
above (approximately 2–5 mm), but not touching, the plate. Make sure the tip (or hub) is not touching the plate or 
consumable loaded in the plate before proceeding. 
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This step ensures greater accuracy. 

10. Using the X-position and Y-position arrow buttons, move the robotic arm to a location directly above the center of the well 
(or contained consumable) indicated by the red well.  

Look at the robotic arm directly from both the front and the side to ensure correct alignment. The pipetting head may be 
lowered further to facilitate easier alignment. 

 
11. When the tip is positioned correctly in the center of the well, click Save. 

The status adjacent to the plate description changes to “updated”.  

The position is not stored until Save has been clicked. 

12. If desired, click Check Position to validate that the correct position has been specified. 

13. If calibrating additional plates, click the next plate in the list and repeat the position calibration process. 

14. Once all plates have been calibrated, click Close to exit the wizard. 

 Calibrating plate heights 

Plate height calibration defines the base position of the wells of a plate to be used on the QIAcube HT worktable. Calibration 
allows software to correctly calculate the height at which tips must be placed for optimal aspirate and eject pipetting operations.  

Plate heights are calibrated with Options > Robot setup > Calibrate plate heights…. 

WARNING 

 

Risk of personal injury 
The robotic arm moves during position calibration while the instrument lid is raised. Never click any 
buttons while parts of your body are within the instrument workspace. 

 
If the plate height is calibrated incorrectly and the tip is positioned too high during liquid transfer, a droplet may form at the end 
of the tip. If the surface tension of the droplet is sufficient, it will not fall into the tube, resulting in incorrect pipetting. 

If the tip is positioned too low, the tip may form a seal at the base of the plate, preventing the liquid from being dispensed, 
resulting in incorrect pipetting. In extreme cases, consumables may be damaged.  
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When positioned correctly, the tip is approximately 1 mm from the internal base of the plate, ensuring that the surface of 
distributed liquid is higher than the end of the tip. 

 
 
As tips are used during height calibration, ensure that the workspace configuration correctly describes the worktable setup of tip 
types and tip rack positions before calibrating. 

Plate height warning 

Clicking the warning icon ( ) at the top, right corner of a plate that requires height calibration opens the “Configure Plate 
Heights” wizard, and the following warning.  

 

Performing plate height calibration 

Manual and automatic procedures are available for calibrating plate height.  

During automatic plate height calibration, the robotic arm advances the pipetting head very slowly until the base of the plate is 
sensed. The calibrated height is calculated as the sensed height of the plate base less a small predetermined offset. The sensing 
of the tube base can be automatically repeated to take an average of several values.  

During manual height calibration, the user sets the distance between the tip and the base of the plate.  

We generally recommend using automatic height calibration for reagent trough and sample or lysis plate positions. Where 
“supernatant” sample or lysis plates are used, manual height calibration is necessary and the height must be set such that tips 
touch the surface of a 200 µL liquid volume preloaded into the plate (i.e., approximately 5 mm above the true base of the plate). 
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Note: Height calibration data for QIAGEN capture plates are available within the QIAcube HT Software and normally do not 
require adjustment by the user. However, if height calibration is required, only the manual calibration method can be used as 
the silica membrane located at the base of each well cannot tolerate contact (which would occur using automatic height 
calibration). Accordingly, automatic plate height calibration is not available for capture plates. 

Automatic height calibration 

1. Ensure that the plate to be calibrated for height has already been calibrated for position (see Section 5.13.1, page 90). 

2. Open the instrument lid. 

3. Place the plates to be calibrated on the instrument worktable.  

4. Ensure that 200 µL tips in an appropriate, calibrated tip rack are placed properly on the worktable and that the tip 
availability is set correctly. 

For more details, see Section 5.9.2, page 66. 

5. Select Options > Robot Setup > Calibrate plate height. 

6. Read the warning about using the height calibration function (shown in the previous section), and click Yes. 

The “Height Calibration” window appears. 

 
7. From the “Plate Selection” list, select the type of plate to be calibrated by checking the corresponding boxes. Alternatively, 

you can select all plates by clicking Select All. 

Plates that have multiple segments (see Appendix A – Sample and reaction functions for non-wizard protocols) appear in 
the list several times (once for every defined segment). 

8. Enter the number of columns (8 wells per column) to be measured for calculating the average in the “Take average of how 
many columns?” field.  

We recommend a minimum of 2columns. 

9. Click Autodetect (checked items) at the bottom of the window. 
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10. Read the warning about the number of empty wells or tubes required to take the required number of measurements for 
averaging, and click Yes. 

 
A final notification appears regarding the plate type and position that is to be automatically height calibrated. 
Acknowledge by clicking OK to proceed. 

 
The instrument collects required tips and proceeds with automatic detection of heights in the wells or tubes to be measured. 
On completion, a notification about the height values determined is displayed. 

 
11. Accept or reject the reported average.  

If the averages for a plate are within 135 units of one another, the numbers can be accepted. 

If the numbers are not within 135 units of one another, check that the plate is sitting correctly and that the tip is not bent. If 
a calibration is rejected, it must be repeated. 

12. Steps 8 to 12 are repeated for each plate selected at step 7. When calibration is completed, click Close to exit the wizard.  

Manual plate height calibration 

1. Ensure that the plate to be calibrated for height has already been calibrated for position (see Section 5.12.5, page 88). 

2. Open the instrument lid. 

3. Place the plates to be calibrated on the instrument worktable.  

4. Ensure that 200 µL tips in an appropriate, calibrated tip rack are placed properly on the worktable and that the tip 
availability is properly set. 

For more details, see Section 5.9.2, page 66.  

5. Select Options > Robot Setup > Calibrate plate height. 

6. Read the warning about using the height calibration function, and select Yes. 

The “Height Calibration” window appears (see figure in the previous section). 
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7. From the “Plate Selection” list, select the type of plate to be calibrated manually by highlighting the corresponding text. 

 
Plates that have multiple segments (see Appendix A – Sample and reaction functions for non-wizard protocols) appear in 
the list several times (once for every defined segment). 

8. Click Manual Setup. 

A notification appears indicating which plate is to be manually calibrated. Click Yes to confirm. The instrument 
automatically collects tips and places the pipetting head above the plate to be calibrated. 

 
9. Read the warning about plate position calibration, and click Yes. 

 
If the current setting is retained and the plate in the position is too high, the tip may jam into the plate and bend.  

10. Lower the pipetting head by clicking Lower tip to current setpoint and use the Adjust Height and Level at bottom of well 
up/down control several times until the tip is just above (approximately 1 mm), but not touching, the plate. Make sure the 
tip is not touching the plate or consumable loaded in the plate before proceeding. 

This step ensures greater accuracy.  
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As it is not possible to see the distance between the tip and the base in most cases, the distance must be “felt” by manually 
lifting the well from its support. 

 
11. If the (the pipetting head) is accidentally moved too far downwards in the Z direction (i.e., touches the base), ensure that 

the pipetting head is returned to the proper position by clicking Home Z-axis. 

12. When the selected “Level at bottom of well” position is suitable, click OK to set the correct height calibration. 

13. Once all plates have been height calibrated, click Close to exit the wizard.  

 Calibrating volumes 

A direct relationship exists between the rotation of the motor shaft (P-axis) and the vertical movement of the pipet piston (i.e., 
volume aspirated or dispensed). Volume calibration defines the number of units that the P-axis motor must move to accurately 
deliver a given volume of liquid. 

Volume calibration is performed using the “Volume calibration” wizard. During installation, the preinstalled settings can be set 
up using “Option 1” from the “Volume calibration” wizard. 

Before starting the first run on a newly installed QIAcube HT volume calibration has to be done. If no volume calibration has 
been done an error is shown at start of a run. 

Opening the “Volume calibration” wizard 

1. Start the QIAcube HT Software.  

For more details, see Section 5.2, page 48. 

2. From the options that appear, select Empty Project (last used layout) or Empty Project (default layout). 

3. From the Options menu in the menu bar, select Robot Setup/Calibrate Volumes. 

The “Volume Calibration Wizard” dialog box appears.  
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Option 1 

Option 1 allows manual adjustment of the P-axis unit value for specific volumes. This method is used to enter the values supplied 
in the volume calibration report provided by QIAGEN.  

1. Select Option 1 from the “Volume calibration” wizard. 

The “Volume Calibration Wizard — Manual Calibration” window appears. 

 
2. Click in the appropriate cells in the “Value (P axis units)” column and enter new values for the P-axis units. 

3. Click Next.  

4. In the window that appears, click Yes to confirm the changes.  

5. In the window that appears, click OK to continue.  

The “Volume Calibration Wizard — History of Calibration Data” dialog box appears.  
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6. Select calibration data to display in the table from the “History of calibration data” drop-down list.  

Current Settings is displayed by default.  

Up to 9 sets of saved calibration settings can be viewed.  

7. To update the default volume calibration with the displayed calibration settings, click Use displayed settings as new 
calibration. 

8. If desired, click Generate Report to display the current calibration settings in table format.  

 
9. Click Close to close the report and return to the wizard. 

For more information about the report options, see Section 6.3.2, page 142. 

10. Click Finish to close the wizard and return to the main software window.  
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Option 2 

Option 2 allows current calibration settings to be viewed and the current default calibration settings to be replaced with previously 
saved calibration settings. 

1. Select “Option 2” from the “Volume calibration” wizard. 

The “Volume Calibration Wizard — History of Calibration Data” window appears. 

2. Proceed with step 6 of “Option 1” (page 98).  

Option 3 

Option 3 allows the volume calibration to be reset to the preinstalled default calibration settings. Current calibrations are 
automatically saved in the volume calibration history. 

1. Select Option 3 from the “Volume calibration” wizard. 

2. In the window that appears, click Yes to reset the volume calibration, close the window, and return to the wizard. 

3. Click Cancel in the wizard to update volume calibration with preinstalled default settings.  

 Calibration management 

Calibration management provides access to functions for saving, reinstating, and deleting calibration data and other instrument 
and software settings. In particular, calibration management functions allow data to be exchanged between laptops connected 
to the same instrument. 

Calibration management functions are accessed from the menu bar (Options > Calibration Management). 

 Saving calibration data 

Calibration and a variety of other data can be saved to a removable drive, network share location, or other media. The data 
file is referred to as the “setup disk” and is specific for the instrument for which the data were obtained.  

Note: A setup disk should be used only for the instrument for which the data were created.  

The setup disk is used to transfer instrument-specific data when the instrument is connected to a new laptop. It is not necessary to 
use a setup disk when the software is updated to a new version. 

Note: QIAcube HT run files (e.g., “runfile.QSP”) are not instrument specific and can be transferred between laptops connected 
to different instruments. 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 101 

Create a setup disk as follows: 

1. From the Options menu in the menu bar, select Calibration Management/Save calibration on setup disk.... 

 
The “Calibration Settings” dialog box appears. Ensure that the displayed serial number matches the serial number of the 
connected instrument.  

2. Click Save to continue. 

 
3. Specify the file name and location for the setup disk. 

A default file name and location is supplied.  

It is possible to browse to the folder where the setup disk should be stored. 

4. Click Save to create the setup disk as specified. 
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 Reinstating calibration data 

After a setup disk has been created (see the previous section), it can be used to reinstate the data. 

Reinstate calibration data from the setup disk as follows: 

1. From the Options menu in the menu bar, select Calibration Management > Load calibrations from setup disk.... 

 
2. Specify the file name and location for the setup disk to be reinstated. 

3. Click OK to reinstate the specified setup disk. 

4. If calibration settings are found, the following window appears. Click Yes to overwrite the existing calibration settings. 

 
5. If the identifier in the setup disk matches the connected instrument, a dialog box appears prompting to restart the software. 

Click Yes (recommended). 

 
6. If necessary, indicate whether the current run file should be saved. 

The calibration data will be reinstated when the QIAcube HT Software is restarted. 
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 Deleting calibration data 

Calibration data associated with the connected instrument can be deleted. This is required, for example, to simplify recalibration 
of plate heights after servicing the manifold (8-channel pipetting head). 

Delete calibration data as follows: 

1. From the Options menu in the menu bar, select Calibration Management > Delete multiple calibrations …. 

The “Delete Multiple Calibrations” dialog box appears. 

 
2. Select the type of data to be deleted. 

3. Delete the data by clicking Delete. 
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 Run files 

QIAcube HT run files (file extension *.QSP) contain all the information required to perform a protocol on the QIAcube HT 
instrument. The run file specifies protocol settings and instrument-control parameters, including: 

 Liquid transfer 

 Air volumes 
 Pipetting speeds 
 Amount of liquid initially present in target plates 
 Sample groupings (banks) 

 Vacuum processing 
 Plates (corresponding to items on the worktable) 

 Sample and reagent names 
 Required number of tips 
 Required reagent volumes 

 Layout (positions and types of plates in the workspace) 

Run files do not contain instrument-specific information (e.g., they do not contain instrument calibration data). This enables run 
files to be transferred between different instrument installations so that a specific protocol configuration can be reproduced at 
different sites. 

All users are able to edit and save modified run files. If the run file is not saved with a new name, the previous run file data will 
be overwritten. If required, standard Windows file system write-protection mechanisms may be used to protect run-file data. 

 Working with run files 

 Template protocol run files 

Template protocols are standardized run files that have been developed to directly support common extraction protocol 
applications. 

Template protocol run files are “locked”. Edit access is only permitted to update the lab notebook, set tip availability and modify 
sample selections and well IDs/barcodes. The fundamental processing structure of a template protocol run cannot be changed. 

Two types of template protocol run files are supported: 

 “QProtocol” template run files ( ) 
 “User Developed” template run files ( ). 
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QProtocol run files are validated by QIAGEN, and optionally include read-only protocol information which is displayed when 
the run is loaded. The protocol information typically describes the processing of the run, kit details, and references to other 
material relevant for the protocol. It can be displayed at any time by clicking  in the toolbar. 

User Developed run files are derived from QProtocols, and differ from their original QProtocol only in the details of selected 
samples and identifications used in the run. 

In practice, a QProtocol run is treated as a User Developed template as soon as it is loaded into the software. It is not possible 
to save a QProtocol run file as a QProtocol template. Instead, a loaded template run (either a QProtocol or a User Developed 
template) may be saved as a locked User Developed template, or the operator may explicitly unlock the template by clicking  
in the toolbar and save it as a conventional non-template run file. 

When a template run is explicitly unlocked, any optional read-only protocol information initially provided by QIAGEN in the original 
template is removed from the run, because the structure of the protocol can be changed and may diverge from the original. 

 Obtaining run files 

Run files (Section 5.14, page 104, for commonly used purification protocols are available from www.qiagen.com/QIAcubeHT. 
These may be distributed as conventional run files or as template run files. 

Template run files are installed by default into the “QProtocols” folder of the software installation (typically C:\Program 
Files\QIAcubeHT\QProtocols). The presence of any valid template run files in this folder activates the appearance of the Protocols 
tab in the “New File…” dialog box. 

Conventional run files can be stored in any convenient location, such as on the computer desktop or in the folder defined by the 
default path (usually C:\Program Files\QIAcubeHT\Data). 

 Opening new or existing run files 

Create a new run file or open an existing run file as follows: 

Select the File > New menu item or click the New File… toolbar icon to open a window for choosing options. 

 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 106 

The following options are available. 

 To start a new project, select the New tab and choose Empty Project (last used layout) to create a run based on the most 
recently used workspace layout. Alternatively, choose Empty Project (default layout) to create a run based on the default 
layout as displayed after initial software installation.  

 To create a new run file using the “Vacuum extraction” wizard, select the New tab and choose Vacuum Extraction Protocol 
(see Section 5.16, page 107).  

 To open a previously saved run file, open the Recent tab, and select a file from the list of most recently used files, or click Browse 
to browse to the desired file. Double-click or choose Open to open the chosen run file. 

 When template protocols are installed, the form offers a QProtocols tab. To open a template run file, open the QProtocols 
tab and select a file from the list of template run files. 

 
 Alternatively, click Cancel to exit the form. This creates an empty project with the last layout used. 
 Use the File/Open… menu item or Open file… toolbar item to open an existing run file. Browse to the desired file. Double-

click or choose Open to open the chosen run file. 
 Use the File/<number> menu item for to select one of the eight most recently used run file; <number> is the indicated 

number of the used run file. 

 Saving run files 

When a run file has been modified, it should be saved to preserve the changes.  

Open the File > Save As… menu item or click the Save file… toolbar icon to save the run file. Both options allow the location 
and name of the file to be specified. The file can be saved in the same location with the same name (overwriting the existing file) 
or with a new name. 

When attempting to create a new run file or open an existing run file while working on a modified run, a notification appears 
requesting the user to save the current modifications. This notification also appears when an attempt is made to exit the software 
(e.g., using the File > Exit menu item or clicking the cross in the title bar) while working with a modified run file.  
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Click Yes to save the changes and proceed with the requested operation. This action is the same as using the File > Save As… 
menu item or clicking the Save file… toolbar icon.  

Click No to discard the changes and proceed with the requested operation.  

Click Cancel to cancel the requested operation and return to working with the current modified run file. 

 Creating a run file with the “Vacuum extraction” wizard  

Users with “Designer” rights can modify existing run files or create new run files using the “Vacuum extraction” wizard. For more 
information about user rights, see Section 5.12.5, page 88. 

Before starting the wizard, we recommend that all worktable items to be used in the protocol (including reagent troughs, sample, 
lysis and capture plates, and tip racks) are specified in the workspace (Section 5.7, page 61) and calibrated (Section 5.12.5, 
page 88). 

The wizard progresses through a sequence of steps to guide the protocol configuration process. Several of the steps appearing 
in the sequence are determined by parameters set in the first few steps within the wizard. The description in the following sections 
illustrates the typical sequence of steps displayed when using the wizard. 

Once one or more steps have been completed, it is possible to navigate backward to modify earlier steps if necessary by clicking 
Back. 

The wizard can be exited at any time by clicking Close in the wizard title bar. Exiting discards all changes made in the wizard 
and restores the configuration of the run file to the state prior to opening the wizard. A warning is presented. 

 
 
On successful completion of the wizard using the Finish button of the wizard summary page, the software compiles the protocol 
configuration and updates the list of operations displayed in the reaction list in the right-hand pane. All reaction steps existing 
prior to opening the wizard are discarded. 
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 Starting the “Vacuum extraction” wizard 

The following options are available to open the “Vacuum extraction” wizard: 

 Using the File > New menu item. This displays the option to create a new run. In the New tab, select Vacuum Extraction 
Protocol. 

 Using the Wizards > Vacuum extraction wizard… menu item. 
 Using the Open wizard… toolbar item. 

The first step of the “Vacuum extraction” wizard appears. 

 “Vacuum extractor configuration wizard” step 

The “Vacuum extractor configuration wizard” window allows configuration of parameters used in subsequent wizard steps and 
selections. 

 
 
1. Specify how the samples will be loaded. 

The following options are available: 

 My samples are preloaded into an empty lysis block 

Samples are transferred to a lysis block that is manually loaded onto the worktable. Lysis buffer will be automatically 
added to the samples. 

 I'd like the samples to be automatically pipetted into the lysis plate from a sample plate 

This option is used to aspirate the supernatant from digested and pelleted tissue samples into the lysis plate or, 
alternatively, to transfer an aliquot from a library plate to the lysis block for extraction. The sample plate is manually 
placed on the worktable and the supernatants or samples are subsequently transferred automatically to the lysis plate. 
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To mix the samples before transfer to the lysis plate, select Premix autoloaded samples before loading into lysis plate? 
and specify the number of times the samples should be mixed. 

 Prompt me to manually load samples directly into the lysis plate loaded with lysis buffer during the run 

Lysis buffer is automatically transferred to the lysis plate and samples are subsequently loaded manually into the lysis 
plate during a pause in the protocol. For example, infectious material can be loaded directly into the lysis buffer in a 
safety cabinet, allowing the infectious material to be inactivated by the lysis buffer before transferring the lysis block to 
the instrument. 

2. Enter a value for the How many reagents are you lysing with (pre-capture)? option. 

This option specifies the number of lysis reagents to be dispensed onto the sample by the instrument, prior to the loading 
the lysate onto the capture plate.  

The entered value determines the number of “Load Pre-Capture Reagent Steps” windows (Section 5.16.6, page 113) 
displayed subsequently by the “Vacuum extraction” wizard.  

For example, when lysis involves processing with an enzymatic reagent followed by the addition of a binding reagent, the 
“Vacuum extraction” wizard displays 2 windows: One for specifying the addition of each reagent.  

3. Enter a value for the How many reagents are you washing with (post capture)? option. 

This option specifies the number of wash reagents to be distributed to the capture plate after lysis and binding.  

The entered value determines the number of “Wash Step1 to Wash Step n” windows (Section 5.16.8, page 115) displayed 
subsequently by the “Vacuum extraction” wizard.  

The number of sequential washes for each reagent is specified in the corresponding “Wash Step1 to Wash Step n” 
window. 

4. Enter a value for the How many reagents are you eluting with? option. 

This option specifies the number of elution reagents to be distributed to the capture plate after lysis, binding, washing, and 
drying.  

The entered value determines the number of “Elution Step1 to Elution Step n” windows (see Section 5.16.10, page 117) 
displayed subsequently by the “Vacuum extraction” wizard.  

The number of sequential elutions for each reagent is specified in the corresponding “Elution Step1 to Elution Step n” 
window. There are up to 6 elution steps possible. 

5. Select Wet capture plate before loading sample? to include a step that wets the capture plate before the lysed samples are 
loaded. 

This step is not usually required for standard nucleic acid purification. 

6. Click Next to continue. 
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 “Table setup” step: Configuring the layout 

The “Table setup” window specifies the workspace layout (Section 5.3, page 51), including the items (reagent troughs, sample 
and lysis plates, capture plate, and tips) and their position on the instrument worktable. 

1. After completing the “Vacuum extractor configuration wizard” step (previous section), the “Table setup” window appears. 

 
2. For each position to be used, select the position and click Set Plate. Alternatively, right-click the position and select Change 

plate type from the menu that appears. 

For more details about restrictions for each position, see Section 5.3, page 51. 

Note: Before configuring the size and position of reagent troughs for a new run file, calculate the volume of each reagent 
required to process 96 samples, and select an appropriate reagent trough configuration for the calculated volume. When 
reagent troughs are configured for processing fewer samples, the run file may need to be reconfigured for larger reagent 
troughs if more samples are processed in subsequent runs.  

3. Specify the plate type by completing the information in the window that appears as described in Section 5.8.2, page 62. 

4. For each specified plate, select the plate and click Set Function. Alternatively, right-click the position and select Change 
plate function from the menu that appears. 

Note: Plate type must be correctly specified before its function can be determined. 

5. Specify the plate function by completing the window that appears as described in Section 5.8.4, page 64. 

6. Click Next to continue.  
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 “Configuration [1]” step 

“Configuration [1]” specifies the primary run parameters that differ from run to run when using the same protocol processing 
configuration. In particular, this step permits configuration of the specific samples to be processed and the lot numbers of the 
plasticware and reagents to be entered (where necessary). 

1. After completing the “Table Setup” step (previous section), the “Configuration [1]” step appears. 

 
2. Select Turn HEPA filter on automatically to automatically switch the HEPA filter on when the run starts and switch it off when 

the run is completed.  

3. To track the plasticware pack, enter a value in the Consumable lot number field. 

Note: This is only necessary when Tracking required for consumables and reagent pack lot numbers? is activated (e.g., 
from an existing protocol template). 

4. To track the reagent pack, enter a value in the Consumable lot number field. 

Note: This is only necessary when Tracking required for consumables and reagent pack lot numbers? is activated (e.g., 
from an existing protocol template). 

5. Select columns to be used for processing by clicking. Alternatively, click the Select All to select all columns.  

Selection can be cleared by clicking Clear All. 

6. Click Next to continue. 
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 “Configuration [2]” step 

“Configuration [2]”specifies reagent trough parameters. 

1. After completing the “Configuration [1]” step (previous section), the “Configuration [2]” step appears. 

 
2. For each specified reagent trough, select a size that is appropriate for processing 96 samples, and click the position to 

open a window for specifying reagent details. 

Note: Before configuring the size and position of reagent troughs for a new run file, calculate the volume of each reagent 
required to process 96 samples, and select an appropriate reagent trough configuration for the calculated volume. When 
reagent troughs are configured for processing fewer samples, the run file may need to be reconfigured for larger reagent 
troughs if more samples are processed in subsequent runs.  

 
3. Enter reagent details. 

For more details, see Section 5.10.1, page 68. 
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Important: The extra volume prevents pipetting error due to volume loss from pipetting and evaporation and is affected by 
a number of variables, including the number of samples processed, the alcohol content of the reagent, the amount of time 
between starting the run and the use of the reagent, ambient temperature, airflow, reagent viscosity, and reagent trough 
size. The default value is 0.75 mL. Actual extra volumes must be empirically determined, and are commonly up to 7 mL. 

The extra volume can be reduced to 0.35 mL when using expensive reagents that are not volatile, are used early in a run, 
and are placed on the worktable in a 70 mL reagent trough (cat. no. 990554) with the improved design. (The improved 
design has individual wells on the bottom of the trough to reduce the dead-volume).  

We recommend the following extra volumes for most other reagents, particularly those containing alcohol. 

 3 mL for the 70 mL reagent trough 
 5 mL for the 170 mL reagent trough 

4. Click OK to apply the changes and close the window.  

5. Click Next to continue. 

 “Load Pre-Capture Reagent 1” step 

The “Load Pre-Capture Reagent 1” step specifies how the first lysis reagent and samples will be combined. Similar windows 
appear for each reagent to be used before capture. 

1. After completing the “Configuration [2]” step (previous section), the “Load Pre-Capture Reagent 1” window appears. 

 
Information in the “Load lysis” panel reflects the selections made in the “Vacuum Extractor Configuration Wizard” window 
(Section 5.16.2, page 108). 

2. Select the first lysis reagent and volume to be processed. 

3. Select the sample volume to be transferred. 
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Depending on previous selections, this sample volume is automatically aspirated from the sample plate into the empty lysis 
block or the sample volume (e.g., sample including any previously or manually added reagents) that is in the lysis block 
when placed on the instrument. 

4. Specify the number of times the lysis reagent–sample mixture should be aspirated and distributed to ensure mixing. 

5. If the lysis reagent–sample mixture requires incubation before continuing, select the type of incubation. 

Timed pause 

 Allows a time to be specified for incubation at room temperature (15–25°C). 

Pause until user confirmation 

 Pauses the protocol to allow incubation until a user action continues the protocol, allowing, for example, the lysis block 
to be removed from the instrument for incubation at elevated temperatures. This option provides a text field in which 
instructions can be entered. 

6. If incubation time can include the time required for mixing, check the Mix samples during incubation checkbox. Specify the 
number of iterations (number of times the mixing routine is performed) and the number of times to mix during each iteration. 

7. Click Next to continue.  

Note: The total volume (i.e., lysis reagent and sample) must not exceed the working volume for the wells of the lysis plate. The 
working volume of a given plate is determined dynamically and not known until the wizard is completed. If the working volume 
is exceeded, a notification appears requiring the volumes to be adjusted accordingly before the protocol configuration can be 
finalized. 
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 “Load capture plate” step 

The “Load capture plate” step specifies the amount of sample lysate that is transferred from the lysis plate to the capture plate. 
This step also allows vacuum processing to be specified. 

1. After completing the “Load Pre-Capture Reagent” steps (previous section), the “Load capture plate” window appears. 

 
2. Specify the amount of lysate to be transferred from the lysis plate to the capture plate. 

If the entered volume exceeds the working maximum capacity of the capture plate, the total volume to be transferred will be 
divided into multiple aliquots of equal volume. Each transfer cycle requires application of vacuum. The number of cycles 
required is displayed. 

3. Specify vacuum processing. 

For details, see Section 5.16.12, page 120. 

4. Select the Premix lysed samples [in lysis plate] before loading into capture plate? to mix the sample and reagent before 
transferring the lysate to the capture plate. Enter the number of times the mixing routine should be performed in the Premix 
iterations field. 

5. Click Next to continue.  

 “Wash step 1 to wash step n” step  

The “Wash Step 1 to Wash Step n” step specifies washing steps. A window is provided for each wash step defined in the “How 
many reagents are you washing with (post capture)?” field of the “Vacuum extractor configuration wizard” step (Section 5.16.2, 
page 108). A similar window is shown for each wash reagent. Consecutive applications of the same wash reagent (iterations) 
are configured in the step for the wash. 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 116 

1. After completing the “Load capture plate” step (previous section), the “Wash Step 1 to Wash Step n” window appears. 

 
2. Select the wash reagent and volume to be transferred at this step. 

3. If the wash should be incubated at room temperature (15–25°C) on the capture plate before continuing, enter the 
incubation time. 

4. Specify vacuum processing. 

For details, see Section 5.16.12, page 120. 

5. Select the number of times the wash reagent should be applied (iterations). 

6. Click Next to continue.  
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 “Dry sample” step 

The “Dry Sample” step specifies conditions for drying samples on the membrane prior to elution.  

1. After completing a “Wash Step 1 to Wash Step n” step for each wash reagent (previous section), the “Dry Sample” 
window appears. 

 
2. Specify vacuum processing. 

For details, see Section 5.16.12, page 120. 

The default is set at approximately 25 kPa for 5 minutes. The settings shown are for the DNA and virus protocols and are 
adequate for the DNA and virus capture plates. 

3. Click Next to continue.  

 “Elution steps” step 

Before the elution steps are processed, the QIAcube HT moves the transfer carriage with the capture plate from the waste side 
of the vacuum chamber to the elution side of the vacuum chamber.  

The “Elution Steps” step specifies the conditions for eluting samples from the capture plate into the elution plate. A window is 
provided for each elution step defined in the How many reagents are you eluting with? field of the “Vacuum extractor 
configuration wizard” step (Section 5.16.2, page 108). A similar window is shown for each elution reagent. Consecutive 
applications of the same elution reagent (iterations) are configured in the step for the elution. 
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1. After completing the “Dry Sample” step (previous section), the “Elution Step 1 to Elution Step n” window appears. 

 
2. Select the elution reagent and volume to be transferred. 

3. If a user interaction is required before transfer of the elution reagent, check the User Pause before loading Reagent? 
checkbox. 

This pause allows the user to load a heated elution reagent and to check that the capture plate membrane has been 
properly dried before the elution reagent is applied. 

4. If the elution reagent should be incubated at room temperature (15–25°C) on the capture plate before continuing, enter the 
incubation time. 

Incubation allows the elution reagent to dissolve nucleic acids from the capture plate membrane.  

5. Specify vacuum processing. 

For details, see Section 5.16.12, page 120. 

6. Select the number of times the elution reagent should be applied (iterations) in the Perform this step n times. field. 

7. Use of TopElute fluid is made possible by specifying two elution steps. In the first elution step, an elution buffer is added but 
no vacuum is applied. In the second elution step, TopElute fluid is added to the elution buffer then vacuum is applied. 
TopElute fluid only partially passes the membrane thereby preventing the flow of air through empty wells. 

8. Click Next to continue. 
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 Wizard summary 

At the completion of the “Vacuum extraction” wizard, the user is presented with a summary describing the specified run file.  

 
 
The report should be carefully checked. To return to completed steps and modify settings, click Back. 

If the run file is correctly specified, click Finish. 

Note: It is essential to complete the wizard using the Finish button to save all wizard configuration details for protocol processing. 

The following options are available for the report. 

 Print: Print the report 
 Save: Save the report in HTML format 
 Email: Save the report as an e-mail attachment 
 MSWord: Save the report as a Microsoft Word® document 
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 Specifying vacuum processing 

The “Vacuum” panel appears in steps in which vacuum can be applied. Generally, vacuum is applied to draw liquids through 
the capture plate after each aliquot transfer. In addition, vacuum can be applied to dry the membrane. 

 

Applying a vacuum 

To apply vacuum, check the Use vacuum at the end of this step? box.  

Up to 3 separate and successive vacuum operations can be specified with the options that appear (e.g., “2-step Vacuum” for 2 
separate vacuum operations).  

For example, these steps can be configured to use a long duration of low-pressure vacuum followed by a short duration of high-pressure 
vacuum. Such a strategy allows liquids in all wells to be drawn through the membrane simultaneously.  

Vacuum duration 

Vacuum duration is specified in seconds in the Vacuum run-time field. 

Vacuum pressure 

Target vacuum pressure is specified in kilopascal (kPa) in the Vacuum pressure field. 

The optimal vacuum pressure depends on a number of factors. The viscosity and nucleic acid concentration of the sample as well 
as the amount of protein and other non-particulate clogging material in the sample affects the optimal vacuum duration.  

Set the duration for the slowest clearing sample.  

Excessive vacuum may cause aerosol from the capture plate membrane, collapse of the capture plate membrane, drying of salts 
and detergents onto the membrane, and foaming. 

Insufficient vacuum may cause reduced performance and, when drying membranes, require longer drying times. 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 121 

Not applying vacuum 

When not using the Use vacuum at the end of this step? option, the vacuum will not be applied. The reagent from the previous 
step is not drawn through the membrane, and remains in the well so that the reagent of the specified step is added to it. 

An additional incubation can be specified by setting the vacuum to 0 kPa. In this case, the vacuum run-time is the incubation 
time. 

Optional pause after vacuum application 

The Wait for user confirmation before turning vacuum off? checkbox pauses the protocol after the specified vacuum run-time has 
elapsed by releasing the vacuum. The user can now decide either to switch on the vacuum again or to continue. This option 
allows the user to experiment with vacuum times for each sample type. 

Optional vacuum setpoint ignoring feedback 

The Ignore feedback? option requests the software to set the target vacuum pressure and ignore the actual pressure achieved, 
enabling the vacuum to be applied for the specified duration without actually achieving the intended target. This is useful only 
during drying operations, and is only displayed for contexts where drying is appropriate. 

 Setting run parameters 

Run Settings functions specify run parameters that define specific characteristics of pipetting operations, including pipetting 
speeds, air volumes, and tip use. Run settings are stored with the run file and allow the protocol to be reproduced on another 
instrument. 

New program settings can be set as default or original defaults can be restored. 

Run Settings functions are accessed from the menu bar (Options > Run Settings). 

 Configuring tip air intake 

The Configure tip air intake… option allows the user to set the volume of air the pipetting head takes up before aspirating liquid. 
The air is subsequently blown out after liquid ejection to clear the tip. Higher air volumes may assist when pipetting viscous 
liquids.  

Air volumes are set separately for different classes of liquids (e.g., samples and reagents).  

We recommend 0 µL as the air intake volume for QIAcube HT applications.  
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Configure air intake volumes as follows: 

1. From the Options menu in the menu bar, select Run Settings > Configure tip air intake…. 

The “Configure tip air intake” dialog box appears. 

 
2. Specify air intake volumes. 

Values can be reset to defaults by clicking Restore Defaults. 

3. Click OK to apply the settings and close the dialog box.  

 Configuring pipet speed 

The Configure pipet speed… option allows the pipetting speed of liquid aspiration and dispensing to be controlled. 

Pipetting speeds are set separately for different classes of liquids (e.g., samples and reagents). In addition, the pipetting speed 
for mixing operations can also be set. 

We recommend using the default speed (450 µL/s) for liquid pipetting and the fastest speed for mixing to ensure efficient mixing.  

Slower speeds can be chosen for pipetting viscous liquids. When specifying reagent troughs for a layout, the reagent can be 
defined as “normal” or “viscous” (see Section 5.9, page 65).  

Settings can be returned to default values with the Options > Run Settings > Reset settings to factory defaults option. 
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Configure pipetting speeds as follows: 

1. From the Options menu in the menu bar, select Run Settings > Configure pipet speed…. 

The “Configure Pipetting Options” window appears. 

 
2. Specify pipetting speeds. 

3. Click OK to apply the settings and close the window.  

 Using liquid-level tracking 

The Use liquid level when pipetting? option sets the liquid-level tracking mode, which determines how tips are placed in liquids 
for pipetting operations. 

Configure liquid-level tracking as follows: 

1. From the Options menu in the menu bar, select Run Settings > Use liquid level when pipetting?. 

2. Select an option from the menu that appears:  

 Do not use liquid level.  

Tip is placed at the bottom of the plate or reagent trough for aspirating and dispensing tasks. 

 Detect liquid level using sensor. 

Function is not available on the QIAcube HT and selection is inactive. 

 Use liquid level estimate. 

Default. Software tracks liquid transfer and calculates volumes present in plates or reagent troughs, allowing tips to be 
placed near the estimated liquid surface to minimize contact during aspirating and dispensing tasks. 

Note: Use default “Use liquid level estimate” setting unless advised by QIAGEN Technical Services. 
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 Configuring error reporting 

The Ignore errors during run? option allows the error reporting during a run to be configured. 

All errors are reported in the post-run report, regardless of the setting chosen for this parameter. This feature cannot be disabled. 

Configure error reporting as follows: 

1. From the Options menu in the menu bar, select Run Settings > Ignore errors during run?. 

2. In the window that appears, select an option: 

 Interrupt run on all errors. 

Default. All warnings and errors that occur during the run are reported. User intervention is required every time an error 
occurs. 

 Interrupt run on serious errors. 

Only serious or fatal errors that occur during the run are reported and require user intervention. 

 Ignore all errors. 

All errors occurring during the run are ignored. No user intervention is required. 

3. Click OK to apply the settings and close the window. 

 Setting tip use options 

The Set tip usage options… option allows the user to manage tip use. The number of tips required to complete a protocol can be 
reduced drastically by using this option.  

Configure tip use as follows: 

1. From the Options menu in the menu bar, select Run Settings > Set tip usage options…. 

2. In the dialog box that appears, select an option from the drop-down list. 

For runs compiled using the “Vacuum extraction” wizard: 

 Programmed tip usage (for NA Extraction) 

This option ensures no cross-contamination can occur during reagent addition and sample transfer, but reduces costs 
by re-using tips during intra-sample mixing operations. 
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For runs not compiled using the “Vacuum extraction” wizard: 

 Use Each Tip for one Operation Only. 

One tip is used for each aspirate–eject cycle. This option uses a large number of tips. 

 Re-use tips where possible. 

This option uses a simple optimization strategy to reuse tips where possible.  

Important: When using this option, ensure that plates containing liquid are assigned a non-zero preload volume (right-
click the plate to select and set this value, see Section 5.10.2, page 69), otherwise contamination may result. 

 
3. Click OK to apply the settings and close the dialog box.  
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 Setting the default file location 

The Set default file location… option sets the location for all saved files to the default path, C:\Program Files\QIAcubeHT\Data. 
This directory contains run files as well as sub-directories for log files, reports, and support packages. When the default file 
location is changed, the location of the subdirectories is also changed correspondingly. 

Set file location to the default as follows: 

1. From the Options menu in the menu bar, select Run Settings > Set default file location…?. 

A dialog box for browsing to the folder appears. 

 
2. Select the new folder to be used as the default for file location. 

3. Click OK to apply the settings and close the dialog box. If required, subdirectories will be generated automatically in the 
new file location. No changes are made to the original default file location and all files are retained. 
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 Resetting to default values 

The Reset settings to factory defaults option allows all options in the Options menu to reset to the original preinstalled default. 

Reset to original defaults as follows: 

1. From the Options menu in the menu bar, select Run Settings/Reset settings to factory defaults?. 

The following table lists the original default settings. 

 Option Original default  

Error Mode Do not ignore errors. 

Pipetting Speeds 450 µL/s for all liquid classes except viscous reagent, which is set to 210 µL/s. 

Air Volumes 0 µL for all liquid classes. 

Tip Re-use For runs compiled using the “Vacuum extraction” wizard: Programmed tip usage (for NA purification) 
For runs not compiled using the “Vacuum extraction” wizard: Use each tip for one operation only. 

Use liquid level when pipetting? Estimate. 

 2. Click Yes to apply the settings and close the dialog box.  

 Saving current settings as new defaults 

The Save current settings as new defaults? option allows the current settings available from the Options menu to be set as the 
default. These settings are subsequently used as default options for new runs created from the Empty project (last used layout) or 
Empty project (default layout) selections made from the New runs or Recent runs window (see Section 5.2, page 48). 

Note: Calibration settings are saved separately and cannot be reset with this option. 

To save current settings as new defaults, ensure that run settings in the “Options” menu are set as desired, and select the “Run 
Settings > Save current settings as new defaults?” option. 

To restore original preinstalled defaults for all settings, see Section 5.17.7, page 127. 

 Setting system color configuration 

The “System color configuration” option allows system color configuration to be modified according to preference. 

From the Options menu in the menu bar, select Run Settings > System color configuration. 

The “Sample Color Configuration” dialog box appears. 
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In each tab, select the color to be modified. Use the following tools to configure new colors: 

 
Select a color. 

 
Add selected color. 

 
Delete selected colors. 

 
Reset all sample colors; click Yes to continue. 

 
Refresh the colors displayed on the software worktable according to the current settings. 

 
Open color theme. 

 
Save color theme. 

 
Apply changes and close. 
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Open the Sample Colors tab, and select colors used for samples. 

 
 
Open the Liquid Colors tab, and select colors used for reagents and other liquids. 

 
 
Open the Selection Colors tab and select colors used for liquid functions and for representation of members of a sample bank, 
as well as for selection and highlighting.  
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 Setting shutdown beep 

By default, the software issues a beep when shutdown is completed after exiting the software. The beep may sound up to 
3 seconds after the workspace displayed by the software closes.  

From the Options menu in the menu bar, select Run Settings > Shutdown beep? to enable and disable this feature. 

 Setting the screen saver operation 

By default, the software inhibits the operation of screensavers to ensure that the user interface is always available while the 
QIAcube HT Software is running.  

From the Options menu in the menu bar, select Run Settings > Allow screensaver? to enable and disable the screen saver. 

Note: The screensaver is configured separately using Windows display or power management functions. 

 Generating filenames for reaction data export 

By default, when using the reaction data export function, the user must provide a file name for exported data. From the Options 
menu in the menu bar, select Run Settings > Generate filenames for reaction exports? option to enable or disable the software 
to automatically generate a unique file name for reaction exports.  

The generated file name is based on the run file name, time, and date for export. 

 Controlling communication and accessories 

The software provides functions to configure the communications interface with the instrument, to operate UV lamp and HEPA 
filter accessory functions, and to monitor the status of the service schedule for the instrument. 

 Selecting a COM port  

The COM port is configured at installation (see Section 4.8, page 45) and will normally be determined automatically. If 
necessary, the selection can be changed manually using the “Virtual” mode (see Section 5.1.2, page 47). 

Change the COM port manually as follows: 

1. Run the QIAcube HT Software in the “Virtual” mode.  

2. From the Options menu in the menu bar, select “Robot Setup/COM port”.  

3. Select the appropriate port from the dialog box that appears.  

4. Exit and restart the software.  

If the port is set properly, the software can communicate with the instrument and opens in the “Normal” mode by default. 
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 Using the service register 

The service register describes the current status of maintenance alert notification records that are associated with the instrument. 
The software maintains a schedule of required service activities in this service register. 

When a scheduled maintenance activity is due, a service alert notification is generated. 

If the system has any unacknowledged service alert notifications,  in the toolbar is marked with a red exclamation mark. 

Acknowledge service alert notifications as follows: 

1. From the “Options” menu in the menu bar, select “Robot Setup > Service register”. 

The “Service Register” dialog box appears. 

 
The component that requires service most urgently is selected (i.e., “HEPA Filter” in the figure above). 

Maintenance activities that are scheduled for future dates are displayed as green records. When a scheduled maintenance 
activity is due, the record is displayed in red. 

The table provides information about previous acknowledgments:  

Item Component to be serviced. 

Due Date Date service is required. 

Acknowledged By Name of the user completing the last service acknowledgement. 

Acknowledge Date Date and time the user completing the last service acknowledgement. 
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The following fields are available for acknowledging service: 

Component Component to be serviced. 

Due Date Date service is required. 

Reason Information about servicing frequency and requirements. 

Acknowledgment Date Current date and time. 

Acknowledged By Name of the current user. 

Comment Service comments entered by the user. 

Clicking Acknowledge Service confirms that the selected service has been completed and applies the information in the 
fields. 

Clicking Exit closes the dialog box. 

2. To acknowledge a service, select the component that has been serviced. 

3. Enter your user name in the Acknowledged By field. 

4. If desired, enter additional details about the service in the Comment field. 

5. Click Acknowledge Service. 

A message appears, summarizing the service acknowledgment. 

 
6. Click Save to save the service acknowledgment.  

The acknowledged service is listed black in the “Service Register” dialog box. In addition, the component is indicated in 
green, as a reminder of a future service. 

Note: Once a service has been acknowledged and saved, it cannot be edited. 

Note: A component can be serviced at any time — regardless of whether it is indicated in red in the “Service Register” dialog 
box. 

Note: Volume calibration must be done before starting the first run after acknowledging a pipettor service. If no volume calibration 
has been done, an error is shown at the start of a run. 
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 Using the UV lamp 

UV lamp options are set with options in the menu bar and toolbar. For more information about the UV lamp, including 
prerequisites for use, see Section 4.4.1, page 34. 

Enable the UV lamp as follows: 

1. Ensure the UV lamp is enabled. 

The UV lamp hardware is automatically detected by the software. When the UV lamp is operational, “Options/Robot 
setup/Enable UV light (robot has lamp)” is automatically checked and the UV lamp icon is active in the toolbar – as shown 
in step 3. 

2. Ensure that the instrument lid is tightly closed. 

3. Click  in the toolbar. The “UV Lamp Control” dialog box appears.  

 
4. Specify the irradiation.  

 For manual control: Click Enable Lamp to start irradiation. To end irradiation, click Disable Lamp. 
Note: Under manual control, the robotic arm does not move and shadowing results. 

 For timed operation: Set the exposure time (1 second to 30 minutes) in the Activate UV lamp for: field, and click Start. 
After the elapsed time, the robotic arm returns to the rear, right resting position and the UV lamp turns off automatically. 
The software can be set to shut down after the duration has elapsed and the UV lamp is switched off by selecting Close 
software when UV finishes?. 

Note: If the UV lamp icon is grayed out in the toolbar, the UV lamp is not available. In this case check whether the UV tubular 
lamp is installed and if it is working correctly. 
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 Using the HEPA filter 

The HEPA filter is turned on and off with options in toolbar. For more information about the HEPA filter see Section 4.4.2, 
page 34. 

Turn the HEPA filter on or off as follows: 

1. Ensure the HEPA filter is connected to the QIAcube HT with the accessory cable before switching on the instrument and 
initializing the software. 

2. Click  in the toolbar to toggle the HEPA fan on and off.  

The color of the symbol indicates whether the fan is on (green) or off (red). 
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6 Operating Procedures 

 Switching on the QIAcube HT 

Before attempting to use the QIAcube HT, ensure that the instrument has been properly installed and all tubing and cable 
connections are in order. In addition, the QIAcube HT Software must be installed properly and the connection to the laptop must 
be configured correctly. For more details, see Section 4, page 32. 

Switch on the QIAcube HT follows: 

1. Switch on the QIAcube HT using the power switch located at the rear of the instrument on the lower left panel. Wait until 
the instrument is initialized before proceeding. 

The instrument is initialized and ready to communicate when the pipetting head is raised to the top position. 

2. Ensure that the vacuum station unit is attached to mains power (either directly or through an IEC connection to the QIAcube 
HT) and is switched on. 

3. Switch on the connected laptop and wait for the operating system to complete startup. 

4. Start the QIAcube HT Software (see Section 5.2, page 48). 

5. If the software opens in the “Normal” mode (see Section 5.1, page 47), the QIAcube HT can be used.  

For information about running protocols, see Section 6.2, page 135. 

If the software opens in the “Virtual” mode (see Section 5.1.2, page 47), it may be necessary to properly configure the 
COM port before the instrument can be used. For more details, see Section 5.18.1, page 130. 

 Assembling the vacuum chamber 

 For plates from QIAcube HT kits 

All QIAcube HT instruments are delivered with the vacuum chamber components for dedicated QIAcube HT kits. To upgrade 
your QIAxtractor instrument to process the dedicated QIAcube HT kits, QIAcube HT Software version 4.17.1 or higher and the 
Accessories Pack, QXT are required (see Appendix C – Ordering Information). 

The following figure illustrates the assembly of the vacuum chamber. 
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For more information about available kits and protocols for the QIAcube HT, please visit www.qiagen.com/QIAcubeHT, or 
contact QIAGEN Technical Services.  

1. Insert the channeling block holder into the left (waste) chamber of the vacuum chamber. 

2. Press firmly on the sides of the channeling block holder to seat it in the chamber, sealing the O-ring on the spigot into the 
drain.  

3. Afterwards place the channeling block into the channeling block holder. 

 
4. Place the capture plate in the transfer carriage.  

5. Load the carriage with capture plate into the left (waste) compartment of the vacuum chamber. 

96-well plate 
(e.g., QIAamp plate) 

Transfer carriage  
(cat. no. 9022654) 

Channeling adapter  
(cat. no. 9022656) 

Contains: 
Channeling block  

(cat. no. 9022665) 

Channeling block holder  
(cat. no. 9022664) 

Elution microtubes (EMTR) 

Riser block EMTR  
(cat. no. 9022655 

Vacuum chamber 
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6. Ensure that the carriage is positioned to the left inside the vacuum chamber. 

 
7. Place the riser block EMTR in the right (elution) side of the vacuum chamber with the pin of the riser block EMTR in the right 

top position. 

8. Load an elution microtubes rack (EMTR) into the elution chamber. 

 For Capture Plate VX or Capture Plate DX 

Note: This description is for QIAxtractor instruments only. All QIAcube HT instruments are delivered with the vacuum chamber 
components for dedicated QIAcube HT kits. 

The following figure illustrates the assembly of the vacuum chamber. 

Note: For proper functioning, it is essential to load the silicone mat properly. 
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1. Remove the silicone mat in its protective sleeve from the plastic bag.  

Ensure that the silicone mat is facing up as indicated on the protective sleeve. 

2. Place the silicone mat in the protective sleeve on a firm, flat surface. 

3. Release the sleeve and allow it to spring open. 

4. Place a clean dry waste sink/mat support on the silicone mat so that the exit nozzle faces up. 

 
5. Align the waste sink/mat support with the silicone mat. 

The top and side edges of the silicone mat and waste sink/mat support should align and the knobs of the silicone mat 
should align with the holes in the waste sink/mat support. 

6. Check the alignment by looking through the hole in the waste sink/mat support to the silicone mat.  

When properly aligned, 4 mat holes should be visible. 

 
7. When the silicone mat and waste sink/mat support are aligned, press down firmly on the waste sink/mat support. 

Small adjustments may be required to properly seat the waste sink/mat support on the silicone mat. When seated properly, 
the silicone mat sits flatly on the waste sink/mat support. 

8. Invert the assembly.  

9. Insert the assembly into the left (waste) compartment of the vacuum chamber, aligning the spigot of the mat support 
assembly to the drain of the chamber. 
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10. Press firmly on the sides of the waste sink/mat support to seat it in the chamber, sealing the O-ring on the spigot into the 
drain. Avoid touching the clean surface of the silicone mat. 

 
11. Check of the sealing lip of the capture plate to be sure there are no chips or cracks.  

Chips, cracks, and anything else that interferes with a good seal will reduce the vacuum efficiency. 

12. Place the capture plate in the transfer carriage.  

13. Load the carriage with capture plate into the left (waste) chamber of the vacuum chamber. 

Ensure that the carriage is positioned to the left inside the vacuum chamber. 

Ensure that the nozzles of the capture plate are aligned with the holes in the silicone mat.  

 
14. Gently twist the capture plate to secure it in the correct position.  

Important: Do not force the capture plate nozzles downward into the holes of the silicone mat. 

15. Ensure the elution riser block is in the right (elution) side of the vacuum chamber. 

16. Load a covered elution plate into the elution chamber. Squeeze the locking tabs on the elution plate lid and remove the lid. 
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 QIAcube HT protocols 

Protocols are a complete set of processing instructions defined in a run file. For more information about run files, see Section 5.14, 
page 104. 

To process dedicated QIAcube HT kits on the QIAxtractor instrument, QIAcube HT Software version 4.17.1 or higher is needed 
together with the Accessories Pack, QXT (see Appendix C – Ordering Information). 

For more information about available kits and protocols for the QIAcube HT, please visit www.qiagen.com/QIAcubeHT, or 
contact QIAGEN Technical Services.  

Standard protocols require standard sample volumes (e.g., 200 µL), see kit handbook accompanying the product for details and 
ordering information. Processing larger sample volumes requires that reagent volumes are increased accordingly.  

The “Vacuum extraction” wizard allows users to modify standard run files for their individual requirements. Advanced users can 
use the “Vacuum extraction” wizard to create new run files. For more details about the “Vacuum extraction” wizard, see 
Section 5.16, page 107. 

Before attempting to run a protocol, ensure: 

 The appropriate run file is available and you are familiar with it. 
 You are familiar with all documentation provided with the run file or product. 
 All required reagents and plasticware are available. 
 Samples are prepared correctly. 
 You are familiar with the assembly of the vacuum chamber (Section 6.2, page 135). 

Before attempting to run a standard protocol, be sure to read the handbook and any documents accompanying the run file. 
These documents contain important information about samples and sample preparation as well as protocol-specific instructions. 

 Performing a protocol 

Perform a protocol as follows: 

1. Place the tip chute on the worktable and ensure that it is over the tip disposal box.  

Ensure that the tip discard chute is open and clear.  

Ensure that the tip disposal box is empty and aligned to the tip disposal box holder fitting with the tip discard chute 
unobstructed (e.g., ensure that the UV cover has been removed). 

2. Switch on the QIAcube HT instrument and the connected laptop.  

We recommend leaving the vacuum station switched on at all times.  

For more information, see Section 5.1, page 47. 
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3. Ensure the UV lamp is switched off. 

For more information, see Section 5.18, page 130. 

4. Launch the QIAcube HT Software. Ensure that the QIAcube HT software launches in “Normal” mode. 

For more information, see Section 6.1, page 135. 

5. Open the appropriate QIAcube HT run file corresponding to the desired protocol. 

For more information about run files, see Section 5.14, page 104. 

6. Ensure all plates to be used in the protocol are correctly calibrated (position and height). 

For more information calibration, see Section 5.12.5, page 88. 

7. Click  in the toolbar and configure the sample columns to be processed on the “Configuration [1]” screen of the 
“Vacuum extraction” wizard. For more information, see Section 5.16.4, page 111. Complete the wizard and allow the 
software to update the workspace display. 

8. As instructed by the protocol, prepare the following and place in the specified positions on the worktable: 

 Reagent troughs containing reagents 
 Tip racks and tips 
 Sample plate containing samples 
 Additional processing plates (e.g., lysis, capture) 
 Accessories 

Note: If fewer than 12 columns (96 wells) are to be processed, cover the unused columns of the capture plate with adhesive 
tape (supplied). Unused columns must be covered to ensure proper vacuum operation.  

Trim any excess tape to avoid protocol errors. 

Note: Do not reuse the capture, lysis, or elution plates, even if some wells were not used, as handling plasticware between 
runs is a potential source of cross-contamination.  

Note: Discard used silicone mats. 

Note: In the sample plate or preloaded lysis plate, unused wells in any column containing samples to process must contain 
water or buffer. To avoid foaming, the volume added to unused wells should be the same as the sample volume. 

9. Ensure that lids have been removed from all plates. 

10. Check the tip availability and correct if necessary. 

For more information, see Section 5.9.2, page 66. 

11. If vacuum processing is required, prepare the vacuum chamber. 

For more information, see Section 6.2, page 135. 

12. If required, turn on the HEPA filter. 

For more information, see Section 5.18.4, page 134. 

13. Ensure that reagents are correctly prepared and loaded in correct volumes into the corresponding troughs on the worktable 
as displayed on the workspace display. 

14. Ensure that the vacuum station liquid waste bottle is no more than half full to prevent the risk of filter blockage during the 
run. For more information, see Section 7.2.1, page 151. 

15. To start a run, click  in the toolbar. The pre-run checklist appears. 
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16. Perform the pre-run check. 

After ensuring that each item in the checklist has been implemented correctly, check the box to the left of the item. 

Note: Because the instrument does not sense the state of all items on the worktable, it is necessary that the user confirm that 
the worktable is set up correctly. 

For more information about pre-run check warnings, see Section 6.3.3, page 144. 

17. If desired, generate a pre-run report by clicking Pre-Run Report. 

For more details, see Section 6.3.2, page 142. 

18. After completing the pre-run checklist, click OK to start the run. 

The OK button is disabled until all pre-run check conditions have been met. 

The protocol starts. 

Progress of the run is displayed in the right-hand pane. The status of tasks is listed as “ACTIVE” or “COMPLETE”. 

19. When the protocol has been completed, cover the elution plate with the lid and remove from the elution chamber. 

20. Discard any silicone mats, other used plasticware, and liquid waste. 

21. Clean the instrument and accessories.  

For more details, see Section 7.2, page 151. 

 Pre-run report 

When performing a protocol, a pre-run report can be prepared from the pre-run check (see Section 6.3.1, page 140) from the 
Wizards/Generate Report... menu item, or by using the Generate pre-run report… toolbar item.  
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The pre-run report contains the following information: 

 Name of the run file  
 Name of the user performing the protocol 
 Version of QIAcube HT Software  
 Mode (“Normal” or “Virtual”) in which the instrument is running 
 The instrument type and serial number, when operating in “Normal” mode 
 Workspace layout and volumes of reagents 
 Estimated run duration 
 Selected run settings, including air volumes and pipetting speeds 

The following options are available for the report. 

 Print: Print  
 Save: Save in HTML format 
 Email: Save as an e-mail attachment 
 MSWord: Save as a Microsoft Word document 

Close the pre-run report by clicking Close. 
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 Pre-run check errors and warnings  

When errors or warnings are detected in the run configuration,  is displayed in the toolbar. 

Clicking  displays the pre-run checklist, which enables details of the configuration issues to be displayed. 

Items indicated in blue in the pre-run checklist are warnings. These can be acknowledged. Items indicated in red are errors and 
cannot be acknowledged. All items must be acknowledged to activate the OK button in order to start the run.  

Click  to display a description of the error in the lower panel.  

Pre-run error messages are logged and saved in diagnostic support packages. 

Examples of errors are listed below.  

 “Insufficient tips” — tip availability calculations indicate that the number of available tips is not sufficient for the run 
 “Well Too Full” — reagent volume calculations indicate that the reagent parameters are set to add a volume that is greater 

than the well capacity 
 “Well Too Small” — reagent volume calculations indicate that the reagent parameters are set to pipet a volume that is 

smaller than the minimum required for accurate pipetting 
 “Volume Too Small” — reagent volume calculations indicate that the reagent parameters are set to pipet a larger volume 

than is available in a well 
 “Not Enough Output Wells” — specified processing instructions require more wells in a plate than are available  
 “Operation Impossible” — a task (or combination of tasks) in the reaction list cannot be performed 
 “Bad Plate Config” — plate configuration cannot be used 

For system error messages and codes, see Section 8.2, page 163. 

 In-run open system/open circuit test 

For every protocol run which uses the vacuum pump, an “Open System” or “Open Circuit” test is performed as the first step of 
the run. This step is implicit in the run and cannot be removed or skipped. The intention of this step is to verify correct setup of 
the vacuum subsystem, ensuring that the bottle and tubing are correctly connected. 

During this test, the software applies a specific vacuum pressure and monitors the achieved value. If the achieved pressure is too 
high, this implies a blockage in the filter, a kinked hose, an incorrect connection with the bottle, or some other constriction of the 
air flow. If the achieved pressure is too low, this implies a leak, perhaps due to poor connections or incorrect fitting of the bottle 
cap. 

When the Open Circuit test fails, a warning dialog box appears. This provides more hints about how to fix the problem. 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 145 

 

 In-run plate detection test 

For every protocol run that uses the vacuum pump, a “Plate Detection” test is performed as the second step of the run. It follows 
immediately after the “Open Circuit” test. This step is implicit in the run and cannot be removed or skipped. The intention of this 
step is to verify correct setup of adapters and the vacuum chamber. 

During this test, the software applies a specific vacuum pressure and monitors the achieved value. If the achieved pressure is too 
low, this implies incorrect alignment of the capture plate and carriage assembly (and incorrect alignment to the holes of the 
silicone mat with DX or VX reagents and plasticware). 

 
 
Note: The lid sensor is disabled during the Plate Detection test, allowing the lid to be raised and the capture plate alignment to 
be manually adjusted while the vacuum pump is operating during this phase of processing. 

Note: If using DX or VX reagents and plasticware, avoid pressing the capture plate nozzles down into the silicone mat holes as 
this may bind the capture plate and mat together and interfere with later transfer of the capture plate to the elution side of the 
chamber. 
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 In-run interactive vacuum steps 

During performance of the vacuum steps, a dialog box appears showing the remaining time for the operation and an indication 
of achieved vacuum pressure and pump effort (where possible). Buttons in the dialog box allow the run to be canceled (Cancel 
run) or the operation to be prematurely completed and the run advanced directly to the next step (Advance). 

 
 
When the time remaining falls below 3 seconds, the dialog provides a visible alert. 

 
 
If no user confirmation is required to complete the step, the dialog box closes when the remaining time falls to 00:00:00. The 
vacuum operation terminates automatically, and the run proceeds without user intervention. 

Where user confirmation is required for the step to complete, the dialog box changes its presentation. 

A Continue button is shown instead of an Advance button, and a different visual alert appears. An audible alert is also generated, 
although this may be disabled using the Mute button. The total elapsed time is shown next to the text “Vacuum turned off since”.  

If Continue is selected, a new window appears with the choice either to resume the vacuum or advance to proceed with the 
protocol.  
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If Resume is selected, the vacuum turns on until the Continue button is clicked.  

 
 
If Continue is selected, the following dialog box opens. 

 
 
Click Proceed to proceed with the vacuum, or click Advance to finish the vacuum step and continue with the protocol. 
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 Modifying a protocol reaction list  

Advanced users can modify a protocol using the edit functions of the reaction list that appears in the right-hand pane when a 
reaction plate (e.g., capture plate) is selected. 

This can be useful to assist in recovering an interrupted run that has not fully completed because of an error. 

Changing the reaction list directly to modify a protocol previously set up using the “Vacuum extraction” wizard is not 
recommended or supported in other cases because of the following: 

 Several instructions entered into the reaction list using the “Vacuum extraction” wizard cannot be edited and cannot be 
otherwise set up or configured. 

 All changes made to the reaction list are lost when the “Vacuum extraction” wizard is subsequently opened and run 
successfully to completion. 

Where it is both necessary and feasible to modify the reaction list of a protocol run generated by the “Vacuum extraction” wizard 
to achieve a specific protocol behavior, it is possible to immediately save the run file to preserve the change. When the run is 
later opened, the restored reaction list can be run as intended, unless the “Vacuum extraction” wizard is first invoked. 

Note: In a run previously set up using the “Vacuum extraction” wizard, the wizard is started explicitly using either the 
Wizards/Vacuum extraction wizard… menu item or Open wizard… toolbar item, and is started implicitly when a plate is changed 
using the Plate Configuration function (see Section 5.8.2, page 62). 

The implicit execution of the “Vacuum extraction” wizard usually makes post-edit of the protocol reaction list impractical to support 
for general use. It is recommended to use post-edit of the protocol only for run recovery after run interruption. 

 Canceling a protocol  

A protocol run can be paused and canceled at any time. Pauses are logged in the post-run report. 

To pause a run, click  in the toolbar. The instrument will complete its current operation (e.g., it will never pause when the 
pipetting head is at a position below the resting position and pause.  

The user is presented with options to continue or cancel the run. Selecting Cancel run causes the robot to stop all movements and 
terminate the run. Selecting Continue allows the run to proceed. 

Note: Once canceled, a run cannot be restarted from the canceled step. 
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 Post-run report 

At the completion of a run, a post-run report is generated by the software. 

 
 
The report is similar in presentation to the pre-run report (Section 6.3.2, page 142). 

The post-run report contains the following information: 

 Name of the completed run file  
 Name of the user who performed the protocol 
 Name of the report generated 
 Version of QIAcube HT Software  
 Mode (“Normal” or “Virtual”) in which the instrument was running 
 The instrument type and serial number, when operating in “Normal” mode 
 Exceptions generated in the course of the run (e.g., “User paused the run”) 
 Actual run duration (start and finish times) 
 Details of sample identifiers eluted into the elution plate (if available) 
 Summary of processing steps in the protocol 
 Selected run settings, including air volumes and pipetting speeds 
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The following options are available for the report. 

 Print: Print  
 Save: Save in HTML format 
 Email: Save as an e-mail attachment 
 MSWord: Save as a Microsoft Word document 

Close the pre-run report by clicking Close.  

The post-run report is automatically saved in the Reports subdirectory of the Data directory (default location is C:\Program 
Files\QIAcubeHT\Data).  
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7 Maintenance Procedures 

The following procedures must be carried out to ensure reliable operation of the QIAcube HT: 

 Regular maintenance 
 Cleaning of the instrument 

Following these procedures ensures that the QIAcube HT is free of dust and liquid spills. 

Before undertaking maintenance procedures, it is recommended that you familiarize yourself with the safety information by 
referring to Section 2. 

Important: Disconnect the QIAcube HT and vacuum station from mains power before cleaning. 

 Servicing 

QIAGEN offers comprehensive Service Support Agreements, including Warranty Extensions, Full Cover Support Agreements, 
and system/application training, including on-site installation and annual preventive maintenance. Service Support Agreements 
maximize productivity and ensure high performance from your system. In addition, service histories are fully documented and all 
parts are certified and guaranteed. 

Contact your local QIAGEN Field Service Specialist or your local distributor for more information about flexible Service Support 
Agreements from QIAGEN. 

 Annual preventive maintenance 

QIAGEN recommends that an annual preventive maintenance service is carried out on the QIAcube HT. The service should be 
performed by a trained QIAGEN Field Service Specialist. Contact your local QIAGEN Field Service Specialist or your local 
distributor for more information. 

 Regular maintenance procedures 

 Emptying the waste bottle of the vacuum station 

The vacuum chamber is connected to a waste bottle. The waste bottle volume indicator icon ( ) in the toolbar provides a 
calculation of the waste bottle volume.  

Probes on the waste bottle and cap assembly detect when the bottle becomes too full. If this occurs, the user is notified and the 
run will be interrupted. The run cannot proceed until the alert is acknowledged. 
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The prompt includes an audible alarm. If required, use the Mute button to silence this alarm. 

To ignore the warning and proceed without emptying the bottle, use the Ignore button. This is not recommended, and, in general, 
the system will soon generate another “bottle full” alert. 

It is possible to empty the waste bottle at other times without waiting for a warning. To reset the indicator, click  in the 
toolbar, and click Yes in the window that appears. 

 
 
When the bottle fills with 3 liters of waste, the liquid comes into contact simultaneously with 2 Teflon® coated sensor electrodes 
within the waste bottle. When this occurs, the software pauses the run until the waste bottle is emptied and the waste indicator 
is reset.  

Empty the waste bottle as follows: 

1. Disconnect the waste bottle and discard the waste according to local safety regulations. 

2. Replace and reconnect the waste bottle.  

3. Click Bottle Emptied in the window that appears. This allows the run to proceed. Alternatively, use the Cancel button to 
terminate the run.  
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 Cleaning the QIAcube HT 

CAUTION 

 

Damage to the instrument 
Do not use solvents, or reagents containing acids, alkalis, or abrasives to clean the QIAcube HT. 

 
CAUTION 

 

Damage to the QIAcube HT lid 
Do not use alcohol, solvents, reagents containing acids, alkalis, or abrasives to clean the instrument 
lid. Alcohol will damage the lid. To clean the lid, use distilled water only. 

 
CAUTION 

 

Damage to the QIAcube HT side panels 
Never clean the instrument side panels with alcohol or alcohol-based solutions. 

 
CAUTION 

 

Damage to transfer carriage 
Under no circumstances should the transfer carriage for use with Capture Plate VX or Capture Plate DX 
be autoclaved. 

 
WARNING/ 
CAUTION 

 

Risk of personal injury and material damage 
Only perform maintenance that is specifically described in this user manual. 

 
WARNING 

 

Risk of electric shock 
Do not open any panels on the QIAcube HT. 

Risk of personal injury and material damage 
Only perform maintenance that is specifically described in this user manual. 

Cleaning agents 

The following disinfectants and detergents are recommended for cleaning the QIAcube HT. 

Note: If using disinfectants different from those recommended, ensure that their compositions are similar to those described below. 

General cleaning of the QIAcube HT: 

 Mild detergents  
 70% ethanol (except for the QIAcube HT lid) 
 Mikrozid® Liquid (Schülke & Mayr GmbH, cat. no. 109160) 
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Disinfection 
 Ethanol-based disinfectants can be used for disinfection of surfaces, such as the worktable: e.g., 25 g ethanol and 35 g 1-

propanol per 100 g liquid, Mikrozid Liquid, Mikrozid Wipes, or 70g ethanol per 100g liquid. Do not use ethanol-based 
disinfectants to clean the lid. 

 Disinfectants based on glyoxal and quaternary ammonium salt can be used for submerging worktable items, such as the 
plate adapter and tip ejector: e.g., 10 g glyoxal, 12 g lauryldimethylbenzylammonium chloride, 12 g 
myristyldimethylbenzylammonium chloride, and 5–15% nonionic detergent per 100 g liquid, Lysetol® AF (Gigasept® Instru 
AF in Europe, Schülke & Mayr GmbH, cat. no. 107410; or DECON-QUAT® 100, Veltek Associates, Inc., in the USA, cat. 
no. DQ100-06-167-01) 

Removal of RNase contamination 
 5 PRIME RNaseKiller (5 PRIME, cat. no 2500080) — for cleaning surfaces and submerging worktable items 

Removal of nucleic acid contamination 
 DNA-ExitusPlus™ (AppliChem, cat. no. A7089,0100) can be used for cleaning surfaces and to submerge worktable items. 

General instructions 
 Do not use spray bottles to spray cleaning or disinfectant liquids onto surfaces of the QIAcube HT workstation. Spray bottles 

should be used only for items that have been removed from the instrument. 
 If solvents or saline, acidic, or alkaline solutions are spilt on the QIAcube HT or if QIAGEN buffers splash the instrument lid, 

wipe the spilt liquid away immediately. 
 Follow manufacturer's safety instruction for handling cleaning agents. 
 Follow manufacturer's instruction for soaking time and concentration of the cleaning agents. Immersing for longer than the 

recommended soak time can harm the instrument. 
 Do not use alcohol or alcohol-based disinfectants to clean the QIAcube HT lid. Exposing the QIAcube HT lid to alcohol or 

alcohol-based disinfectants will cause surface cracking. Clean the QIAcube HT lid with distilled water only. 

Wipe the instrument with a damp cloth only. 

The worktable inside the instrument should be cleaned using a moist, soft cloth.  

Note: Do not wipe the linear guides for the mobile axes (X, Y, Z). These guides support movement of the pipetting head and 
allow it to slide backwards and forwards easily. Wiping the guides will remove the grease and make them more susceptible to 
rust. See the “Cleaning the guide rails” section, page 158, for information about when and how to clean the linear guides.  

 Cleaning the instrument after completing a run 

1. When the protocol has been completed, cover the elution plate with the lid and remove from the elution chamber. 

2. Discard racks containing only used tips. Cover used fractions of partly used tip racks with an adhesive tape. 

3. Discard unused reagent. 

Fresh reagent should be prepared for each run. 

4. Discard the lysis block. 

5. Remove the tip chute. Clean the tip chute according to instructions in Section 7.2.5, page 156. 
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6. Remove the carriage and discard the capture plate. Rinse the carriage with clean, deionized water and dry. 

7. If using plates from dedicated QIAcube HT kits, remove the channeling adapter, rinse it with clean, deionized water, and 
dry. 

If using Capture Plate VX or Capture Plate DX, remove the waste sink/mat support and discard the silicone mat. Rinse the 
waste sink/mat support with clean, deionized water and dry. 

8. Clean any reagent spilt on the instrument worktable or vacuum chamber with a damp cloth.  

 Cleaning the instrument after shutting down 

Upon instrument shut down, the instrument cleaning procedure is automatically opened to guide the user through the instrument 
cleaning process.  

Additionally, the instrument cleaning procedure can be manually initiated without shutting down the instrument by clicking  in 
the toolbar. 

Perform the cleaning procedure as follows: 

1. If desired, select “Run UV cleaning operation before closing?”. 

2. Replace lids on any tip racks containing unused tips. Discard racks containing only used tips. 

3. Discard unused reagent and reagent troughs. Clean the reagent trough adapters and reagent trough lids. 

4. Discard the lysis block. 

5. Remove the tip chute. Clean the tip chute according to instructions in Section 7.2.5, page 156. 

6. Remove the carriage and discard the capture plate. Clean carriage according to instructions in Section 7.2.5, page 156. 

7. If using plates from dedicated QIAcube HT kits, leave the channeling adapter in position until the waste chamber has been flushed. 

If using Capture Plate VX or Capture Plate DX, remove the silicone mat from the waste sink/mat support and discard. Leave 
the waste sink/mat support in position until the waste chamber has been flushed. 

8. Flush the vacuum chamber by pouring 20 mL water in the left (waste) side and clicking Next in the instrument cleaning 
procedure to cycle the pump and flush the lines. 

Note: The “Instrument cleaning procedure” window must be open before the water is poured into the sink.  

Opening of the window automatically instructs the instrument to close the vacuum line to the elution chamber to prevent 
wash water from flowing into the elution chamber and draining out through the air bleed hole onto the laboratory bench. 

9. Remove and clean the waste sink/mat support or channeling adapter assembly according to instructions in Section 7.2.5, 
page 156. 

For information about cleaning air bleed holes, see page 156. 

10. Spray the vacuum chamber and worktable with Tri-Gene from MEDI-CHEM (www.medi-chem.com) and leave for 15–
30 minutes. Wipe excess liquid with clean paper towels. 

11. Discard liquid waste according to local safety regulations.  

For more details, see Section 7.2, page 151. 

12. Switch on the UV lamp for 30 minutes.  
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 Cleaning instrument worktable accessories 

Transfer carriage and vacuum chamber adapters 

After first rinsing with room temperature (15–25°C) tap water, soak for 15–30 minutes in a quaternary ammonium based solution. 
Rinse with room temperature, deionized water and allow to drain and dry. 

Reagent trough adapters  

Rinse reagent trough adapters with clean tap water. If more rigorous cleaning is required, reagent trough adapters can be 
washed in a laboratory dishwasher and, if necessary, autoclaved.  

Instrument lid 

The instrument lid is manufactured acrylic, which is 100% UV absorbent.  

Do not use alcohol solvents, reagents containing acids, alkalis, or abrasives to clean the instrument lid. 

The instrument lid should be cleaned only with water and a clean, soft cloth. Alternatively, a cleaning product specifically 
designed to clean acrylics can be used. Any cleaning product should be tested on a small inconspicuous section of the instrument 
lid first.  

Greasing the O-ring  

If using plates from dedicated QIAcube HT kits, apply a thin film of vacuum grease to the O-ring, as required, on the channeling 
block holder indicated with a red arrow in the following figure). 

 
Channeling block holder O-ring. 

A tube containing silicone grease is provided with the instrument for this purpose. Greasing facilitates the placement and removal 
of the adapters from the vacuum chamber. 
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If using Capture Plate VX or Capture Plate DX, apply a thin film of vacuum grease to the O-ring, as required, on the underside 
of the waste sink/mat support (indicated with a red arrow in the following figure).  

 
Waste sink/mat support O-ring. 

Cleaning air bleed holes 

The QIAcube HT and QIAxtractor instruments have air bleed holes positioned at strategic points on the vacuum chamber and 
the waste sink/mat support, as shown in the following figures. 

      
 
Each of these air bleeds has a small stainless steel aperture inserted in the hole to specifically control the rate of air flow.  

The air bleed holes serve two purposes: 

 Provide a positive air flow towards the waste chamber 
 Allow chamber to equilibrate to atmospheric pressure after the application of a vacuum  

Important: Air bleed holes should be kept clean and clear of blockages. 

To clean air bleed holes, flush with a squirt bottle containing deionized water. 
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Greasing the pipettor  

The pipetting head occasionally requires servicing. The software has a built-in maintenance counter that reminds the user after 
300,000 pipetting operations that the pipetting head requires service. Contact your QIAGEN Field Service Specialist for servicing 
requirements. 

Cleaning the guide rails 

The X, Y, and Z guide rails are the coated hardened steel rails that support the linear bearings that allow the robotic arm to slide 
back and forth easily. Do not wipe these guide rails with a cloth as doing so removes the grease.  

Check for spilt reagents daily. Wipe only the areas which have spilt reagent on them and then move the robotic arm back and 
forth over the axis to redistribute the grease. 

The linear bearings incorporate seals to keep the bearings free of dust or grit. The rails and bearings have been tested on the 
QIAcube HT in excess of 2,000,000 operations without any sign of degradation. 

 Weekly maintenance procedure 

It is fundamental to most applications that the instrument remains free of contaminants, especially DNA, RNA, DNases, and 
RNases. The instrument must be routinely decontaminated to ensure validity of results and to eliminate the possibility of cross-
contamination.  

Before starting, be sure the following are readily available: 

 Quaternary ammonium based solution 
 Sterile water free from nucleic acids and nucleases 
 Detergent 
 Deionized water free from nucleic acids and nucleases  
 100% ethanol 
 Soft, clean paper towels 
 Sterile spray bottle containing deionized water free from nucleic acids and nucleases 
 Sterile spray bottle containing 70% ethanol free from nucleic acids and nucleases 

Note: Do not allow alcohol, solvents, reagents containing acids, alkalis, or abrasives to come into contact with the instrument lid. 

Note: Do not allow household bleach to come in contact with anodized parts, such as the tip chute and components of the 
Accessories pack, QXT. 

1. Remove reagent plates and blocks, waste sink/mat support or channeling adapter, riser block, and tip chute from the 
instrument worktable.  

2. Wash the removed items with detergent and rinse with clean water.  
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3. Place the clean items into the quaternary ammonium based solution and soak for 15–30 minutes.  

4. Rinse the items completely with deionized water.  

5. Briefly rinse items with 100% ethanol, and dry with soft paper towels.  

Make sure all components are free from detergent and quaternary ammonium-based solution.  

6. Spray the worktable with one of the recommended cleaning agents and leave for 15–30 minutes to ensure DNA 
decontamination.  

7. Wipe surfaces with clean paper towels.  

8. Spray the work space with sterile water and dry with clean paper towels. Repeat this process three times. 

9. Rinse the workspace with 70% ethanol, and allow to air dry. 

10. Replace all components on the worktable. 

11. Close instrument lid.  

12. Switch on the UV lamp for 15 min.  

For more details, see Section 5.18, page 130. 

 Pipetting head service kit 

All pipetting instruments require regular servicing to maintain precision and accuracy. The frequency at which the QIAcube HT 
pipetting head requires regular servicing depends on the use (approximately once every 300,000 operations). This is typically 
once per year when processing one plate per day; every 6 months when processing 2–3 plates per day; and every 3 months 
for 3 or more plates per day. 

 Replacing HEPA filters 

HEPA filters should be replaced on a regular basis. The QIAcube HT Software reminds you to replace the HEPA filters at 6 
monthly intervals; replacement should take place then.  

Replace the HEPA filters as follows:  
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1. Remove the access hatch by pulling it. 

2. Unscrew the 4 thumb screws. 

3. Remove the “H” frame.  

4. Remove both HEPA filters. 

5. Insert the new HEPA filters and reassemble. 

Note: For ordering information for the QIAcube HT HEPA filter, see Appendix C – Ordering Information. 

For waste disposal of the used HEPA filters follow instructions of your local regulations. 

 Replacing filters on the vacuum station 

Vacuum filters should be replaced on a regular basis. The QIAcube HT Software reminds you to replace these filters at 6 monthly 
intervals; replacement should take place then. 

Replace vacuum filters as follows: 

1. Remove all hoses from the Polycap™ filter. 

2. Unplug the Polycap and Carbon-Cap™ filters from the vacuum station. 

 
Vacuum station with Polycap and carbon filter. 

3. Plug the new Polycap filter into the correct opening on the vacuum station. Connect the hoses between the Polycap filter 
and waste bottle cap. 

4. Plug the new carbon filter into the correct opening on the vacuum station. Be sure to position the filter with the labeling 
upside down. 

Note: For ordering information for the QIAcube HT vacuum filters, see Appendix C – Ordering Information. 

For waste disposal of the used filters of the vacuum station follow instructions of your local regulations. 
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 Shutting down the QIAcube HT 

The QIAcube HT Software can be shut down by clicking  in the top right hand corner of the QIAcube HT window or by 
selecting “Exit” in the “File” menu.  

During shut down, the user is prompted to clean the instrument. For more details, see Section 7.2, page 151. 

The user is prompted to turn on the UV lamp after cleaning. For more details, see Section 5.18, page 130. 

During shut down, the robotic arm returns the pipetting head the resting position at the back, right of the instrument. 

When it is safe to do so, the user is prompted to switch the instrument off.  

Power to the vacuum station is automatically disconnected when the power to the main instrument is turned off. Therefore, we 
recommend leaving the vacuum station switched on to avoid errors upon initialization. 

When the instrument is switched off, all robotic axes are disengaged and can be moved freely. 
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8 Troubleshooting Guide 

If you need to contact QIAGEN Technical Services about an error, note down the steps leading to the error, save or choose the 
applicable support package from the problem run, and then send this to QIAGEN Technical Services. If the support package 
cannot be saved because of a communication problem, start the software with the instrument powered down, save the support 
package immediately, and then contact QIAGEN Technical Services. This will help the QIAGEN Field Service Specialist in 
solving the problem. 

A warning is issued when an error, such as insufficient tips, is encountered during the run, and the error is listed in the post-run 
report (Section 6.5, page 149). 

 Run setup errors 

 A warning alarm initially sounds for 30 seconds, and subsequently at 30 second intervals.  
 The warning icon appears in the toolbar. 
 The warning is listed in the status bar (Section 5.3.6, page 54).  

The following actions can be taken by the user: 

 Cancel — protocol run is canceled (Section 6.4, page 148) 
 Ignore — instrument continues operation according to the protocol without modification 
 Retry Operation — instrument disposes attached tips and moves the pipetting head to the resting position at the rear right 

of the instrument. This allows the user access to the entire workspace so that the error may be resolved. A message appears 
prompting the user to click OK to continue the run.  
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 Important error messages 

This section describes software and instrument errors.  

 Software errors 

The following table lists selected software errors. 

 Error Description  

No tips Calculations indicate that insufficient tips are available for the specified processing. 

User canceled job The run was interrupted by a user action. 

User opened instrument lid The instrument lid was opened during processing. 

User paused job The run was paused by a user action. 

User resumed job A paused run was resumed by a user action. 

Software or configuration error Indicates a possible problem with the installation. Try reinstalling the software. 

Tip ejection failed Tip was not ejected from the pipetting head during processing. Try performing the tip ejector calibration. 

Tip pickup failed Tip was not correctly picked up during processing. Try performing the position calibration of the tip plate 
position. 

Volume calibration must be done before run Volume calibration must be done before a run can be started: a newly setup robot, or after pipettor service. 

 

 Instrument errors 

Instrument error numbers begin with 40000. Specific error codes from the instrument are reported as the sum of this base value 
(40000) and the code listed in the following table. The following table lists selected instrument errors. 
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 Error errors 

 Code Error  

1 Command FIFO overrun error. Turn the power off/on and restart. If the problem persists, contact QIAGEN Technical Services. 

2 Bad checksum error for command message. Turn the power off/on and restart. If the problem persists, contact QIAGEN Technical Services 

3 Bad axis number used in command. Turn the power off/on and restart. If the problem persists, contact QIAGEN Technical Services. 

4 Instrument received an unknown command. Turn the power off/on and restart. If the problem persists, contact QIAGEN Technical Services. 

5 Vacuum sensor cannot sense vacuum. Contact QIAGEN Technical Services. 

6 Attempt to operate axis when it is not enabled. Turn the power off/on and restart. If the problem persists, contact QIAGEN Technical Services. 

9 Home switch could not be found within limit. Contact QIAGEN Technical Services. 

10 82C55 I/O pins are unstable. Contact QIAGEN Technical Services. 

11 An error has occurred in SPI communications. Remove the USB to serial connector, if used. Or try changing the USB cable. 

18 Error reading accessory EEPROM. Contact QIAGEN Technical Services. 

129 An invalid axis was specified. Turn the power off/on and restart. If the problem persists, contact QIAGEN Technical Services. 

130 The instrument did not respond with the first reply. Contact QIAGEN Technical Services 

131 The instrument did not respond with a second reply. Contact QIAGEN Technical Services. 

132 COM port fault Check software version 

133 The micro firmware is mismatched. Contact QIAGEN Technical Services. 

134 An invalid COM port was chosen Choose the correct COM port 

135 An attempt was made to move an axis beyond its limit Send the robot to its home position and retry. Contact QIAGEN Technical Services. 

136 Too many replies were specified in transmitted try power off/on and restart. If continues, then contact TS packet. 

137 Incorrect checksum found in a received packet. 

138 The first reply was corrupt. 

139 The second reply was corrupt. 

140 The local receive FIFO overflowed. 

141 An incorrect number of replies were received. 

145 An unknown accessory was detected. Unplug any accessories and identify which accessory has caused the problem; then contact QIAGEN 
Technical Services. 

147 A bad packet length was received. Turn the power off/on and restart. If the problem persists, contact QIAGEN Technical Services. 

148 More data was received while processing. Turn the power off/on and restart. If the problem persists, contact QIAGEN Technical Services. 

  
If any of these errors are encountered, contact QIAGEN Technical Services with a support package that contains the event where 
the error occurred. 
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9 Technical Specifications 

 Environmental conditions 

 Operating conditions 

Power 100–240 V, 250 VA, 50–60 Hz  
Mains supply voltage fluctuations are not to exceed 10% of the nominal supply voltages. 

Fuse F5A 250 V fuse 

Overvoltage 
category 

II 

Air temperature 15–30°C (59–86°F)  

Relative humidity* 40–70%  

Altitude* Up to 2000 m (6500 ft.) 

Place of operation For indoor use only 

Pollution degree 2 

 Transportation conditions 

Air temperature –25°C to 60°C (–13°F to 140°F) in manufacturer’s packaging 

Relative humidity Max. 75% (noncondensing) 

 Storage conditions 

Air temperature 15°C to 30°C (59°F to 86°F) in manufacturer’s packaging 

Relative humidity Max. 75% (noncondensing) 

 
* Conditions under which equipment is electrically safe to operate. 
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 Mechanical data and hardware features 

 Instrument dimensions and weight 

Dimensions 
(excluding laptop) 

Instrument lid, closed 
Width: 540 mm (21 in.) 
Height: 450 mm (18 in.) 
Depth: 630 mm (25 in.) 
Instrument lid, open 
Width: 540 mm (21 in.) 
Height: 860 mm (34 in.) 
Depth: 630 mm (25 in.) 
Clearance for connection of cables (at instrument rear) 
Depth: 90 mm (3 in.) 
QIAcube HT vacuum station 
Width: 495 mm (19 in.) 
Height: 520 mm (20 in.) 
Depth: 400 mm (16 in.) 

Weight QIAcube HT instrument: 44 kg (97 lb) 

QIAcube HT vacuum control station: 17 kg (38 lb.) 

 Worktable capacity 

The worktable provides the following positions: 

 4 SBS-standard plates (footprint 128 x 86 mm), compatible to accept 96-well plates or tip racks 
 1 custom adapter for a reagent trough plate compatible to accept reagent troughs  
 Vacuum chamber with chambers for waste and elution 

 Liquid handling 

Channels 8 pipetting channels 

Pipetting volumes  20–200 µL  

Precision  20–200 µL; less than 4% coefficient of variation  

Capacity Up to 96 samples in increments of 8 samples  
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 Instrument lid 

Material Acrylic (SMMA)/Polyester (UP) 

Work surface 
sterilization 

UV lamp attachment 

The UV light is connected by the QIAGEN Field Service Engineer when the instrument is installed 
(see Section 4.4.1 for details) 

 HEPA filter unit 

Positive pressure Preinstalled HEPA filter unit 

 Hardware and software features 

Laptop and 
software 

The QIAcube HT is operated with a connected laptop. A laptop appropriate for the correct operation 
of the QIAcube HT Software is supplied as part of the QIAcube HT system.  

Interface The following interfacing options are available for connecting the laptop to the instrument: 

 USB (laptop) to USB (instrument); preferred 
 RS-232 (laptop) to RS-232 (instrument) 
 USB (laptop) to converter to RS-232 (instrument) 
 PCMCIA (laptop) to converter to RS-232 (instrument) 

Note: The laptop must be connected to the instrument with only one option at a time. 

Connecting with the 
RS 232 interface 

Connect the laptop to the instrument through the RS-232 interface as follows: 

 Ensure that the QIAcube HT instrument is switched off. 
 Connect the 9-pin serial cable to the RS-232 serial port on the accessory panel at the rear the 

instrument. Connect the other end of the cable to the RS-232 serial port on the laptop. 
 Switch on the instrument.  

Note: Driver installation is not required when using the RS-232 interface. 

Other connection 
options 

In addition to the direct RS-232 (see Section 4.6.1) or USB connection, the following interfacing 
options are available for connecting the laptop to the instrument: 

 USB (laptop) to converter to RS-232 (instrument) 
 PCMCIA (laptop) to converter to RS-232 (instrument) 

Note: The laptop must be connected to the instrument with only one option at a time. 

Uninstalling the 
QIAcube HT 
Software 

The QIAcube HT Software can be uninstalled from the Settings or the Programs menu. 

To uninstall the software from the Settings menu: 

 From the Windows Start menu, select Settings > Control Panel.  
 The “Control Panel” opens. 
 Double-click the Add or Remove Programs icon, and wait for the screen to be populated. 
 Select QIAcube HT from the list of installed programs, and click Remove. 
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 The version number of the software appears with the name in the list. 
 

To uninstall the software from the Programs menu: 

  From the Windows Start menu, select Programs > QIAcube HT > Uninstall. 
  Click Yes to continue.  

 

To uninstall the associated USB driver: 

 From the Windows Start menu, select Settings > Control Panel. 
 The “Control Panel” opens. 
 Double-click the Add or Remove Programs icon, and wait for the screen to be populated. 
 Select QIAcube HT (Driver Removal), and click Remove to remove the USB driver.  

Note: Uninstallation does not delete the installation folder (typically C:\Program Files\QIAcubeHT), 
allowing calibration settings, run settings, and run files to be retained. If necessary, the folder can be 
manually deleted. Note that deleting this folder will delete all calibration data and run files that have 
been saved in the C:\Program Files\QIAcubeHT\Data directory. 
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Appendix A 

Advanced settings 

Advanced run settings are available to adjust specific functions on the QIAcube HT. These functions should be modified only 
under direct instruction from QIAGEN. 

Tip pickup mode 

This defines the strategy used for collecting tips from the Tip Rack Holder. Normal (single stage) or Three Stage can be selected. 

Normal (single stage) Instructs the instrument to collect tips using a single downward movement. 

Note: This setting provides relatively fast tip pick-up, but may cause mechanical damage to the Z axis 
of the pipetting head. It is not recommended. 

Three Stage Instructs the instrument to collect tips in 3 separate downward movements: 

1. The pipetting head is brought into the tip collar. 

2. The pipetting head is gently pressed against the tip collar. 

3. The pipetting head is forced against the tip collar. 

This is the default setting. 

Detect tip absence 

A tick is displayed when this function is activated. This function is automatically detected when the instrument has failed to pick 
up a tip. This is caused when a tip is absent from the pick-up position. A dialog box is displayed with options to ignore (and 
proceed as if the pickup succeeded), retry (attempt to pick up at the same location), cancel (terminate the run), or skip (to the 
next available tip position and retry). 

This function is activated by default. 

Automatically skip to next if detect tip absence 

This function is disabled until “Detect tip absence” is enabled. A tick is visible when this function is activated. This function 
automatically skips to the next available tip position and retries the tip pickup if a tip pickup fails due to tip absence. 

This function is not activated by default. 
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Compensate for liquid loss (reagents) 

This function sets a depth in millimeters by which the tip should be further lowered into the wells below the calculated liquid 
surface position for reagent pipetting operations. 

This function is intended to allow for reagent liquid losses due to evaporation, tip retention, or other processes that lower the 
actual volumes present relative to their expected (calculated) values. In addition, this function can be used to address a variety 
of situations where the tip would otherwise be placed too high in reagent wells for pipetting operations. 

The recommended range is 0 to 3 mm. 

The default value is 3. 

Note: Losses for reagent liquids are typically greater than those for non-reagents. 

Note: Reducing this value below the default (3) can cause tips to be placed too high in the wells, resulting in transfer of insufficient 
reagent volumes. 

Allow volumes >tip capacity (special operations) 

A tick is displayed when this function is activated. By default, all of the liquid handling functions available via the Special button, 
presented in the “Reaction” right-hand pane, work only with volumes up to the largest capacity tip supported on the QIAcube HT 
(i.e., 200 µL). Activating this option allows those functions to work with volumes larger than 200 µL. 

This function is activated by default. 

Reactions are mixed by default 

A tick is displayed when this function is activated. This function sets the default setting of the Mix on ejection? option displayed 
in the Mix Settings section of the “Reaction Configuration” dialog box (displayed using the Add button of the Reaction right-hand 
pane). When activated, the Mix on ejection? option is checked by default; when deactivated, this option is unchecked by default. 

This function is activated by default. 

Allow use of multiple reagent volumes 

A tick is visible when this function is activated. 

If activated, the user sees the advanced reagents table in the “Reaction Configuration” dialog box. This allows the user to 
configure the volume of a reagent for each reaction separately (instead of using the default volumes). 

If deactivated, the user sees the simple reagents table in the “Reaction Configuration” window. 
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If multiple volumes for at least one reagent are used, and the user tries to deactivate the option, a message box appears: 

 
 

Click Yes to reset all used volumes of all used reagents in the current protocol to the reagent’s default. 

Click No to keep the option activated. No volumes will be changed. 

Allow preserved well indices 

A tick is displayed when this function is activated. This function affects the options listed in the “Target Wells” section of the 
“Reaction Configuration” dialog box shown when editing conventional liquid handling operations (displayed using the 
Add button of the “Reaction” right-hand pane). When activated, the Preserve source well indices option is presented; when 
deactivated, this option is not displayed. 

The “Preserve source well indices” function changes the reaction well allocation strategy used by the software for the 
corresponding liquid handling operation. Normally, this function is disabled and the software allocates reaction wells sequentially 
from the first available well in the target plate not used by previous reaction setup operations in the run. When activated, the 
software attempts to use the well index in the reaction plate corresponding to the well index of the sample in the source plate for 
the reaction made using that sample. 

The software applies special rules to allow reactions which “Preserve source well indices” and those which do not to coexist in 
the same run. In short, for each reaction plate the software determines the highest index reaction well required by a “Preserve 
source well indices” liquid handling operation and treats the next well as the first available for all other reaction construction 
operations which do not “Preserve source well indices” in that plate. 

This function is activated by default. 

Set anti-drip inhale tip position 

This function sets the position in the tube at which tips are placed before inhaling drips. At this position a small amount of air is 
inhaled after liquid ejection to prevent dripping of liquid droplets during tip transport. 

This position is expressed as a percentage of the distance from the top of the tube to the surface of the liquid. 

The allowable range is 0 to 100 (%). 

The default value is 50. 
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Set anti-drip exhale tip position 

This function sets the position in the tube at which tips are placed before exhaling drips. At this position a small amount of air is 
exhaled prior to liquid aspiration to place any drips retained in the tip during transport in contact with the liquid to be aspirated. 

This position is expressed as a percentage of the distance from the top of the tube to the surface of the liquid. 

The allowable range is 0 to 100 (%). 

The default value is 90. 

Aspirate reagent with minimum tip insertion (else at base) 

A tick is displayed when this function is activated. This function controls the placement of tips for reagent aspirate operations. 

When activated, tips are placed in the reagent wells at an optimal height below the estimated liquid surface to reduce contact 
between liquid and the exterior of the tip. This reduces the likelihood of droplet formation on the outer walls of the tips during 
transport and helps to manage drips. 

When inactive, tips are placed at the base of the reagent wells for aspirate, increasing the probability of drips during transport. 

This function is not activated by default. 

Use slow (viscous) pre-wet speeds for reagent 

A tick is displayed when this function is activated. This function modifies the reagent aspirate pre-wet operation performed when 
reusing tips for reagent transfers. 

When activated, the reagent aspirate pre-wet is performed at the “viscous reagent” pipetting speed instead of the “reagent” 
pipetting speed. The pre-wet operation coats the interior surfaces of the tips with liquid that is to be retained in the tips for 
subsequent air-dispensing of reagents to target wells using the same tips. When performed at the slower “viscous” speed, 
experience has shown that reagent dispensing performance is improved. 

This function is activated by default. 

Set reagent post air dispense pause (msec) 

After air dispense of reagent to target wells, reagent liquids on the exterior surfaces of the tips may drain and form a droplet at 
the tip base. To assist with reagent drip control, these droplets are inhaled into the tips prior to the next movement of the robot 
arm. 

This function defines the time (in milliseconds) allowed for this droplet formation pause. 
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The recommended range of values is 0 to 3000 msec. 

The default setting is 0. 

Use slow move speeds for reagent (post eject) 

A tick is displayed when this function is activated. This function reduces the speed at which the instrument arm moves whenever 
tips carrying reagent liquid are reused after the initial dispense. The slower, smoother movement reduces the likelihood of drips 
from the tips. Although there is no cross-contamination risk when transporting reagent, this function can reduce workspace 
cleaning requirements. 

This function is not activated by default. 

Aspirate sample with minimum tip insertion (else at base) 

A tick is displayed when this function is activated.  This function controls the placement of tips for sample aspirate operations. 

When activated, tips are placed in the sample wells at an optimal height below the estimated liquid surface to reduce contact 
between liquid and the exterior of the tip. This reduces the likelihood of droplet formation on the outer walls of the tips during 
transport and helps to manage drips. 

When inactive, tips are placed at the base of the sample wells for aspirate, increasing the probability of drips during transport. 

This function is not activated by default. 

Set sample post aspirate tip raise speed (%) 

After sample liquid is aspirated, tips are raised to the liquid surface to allow liquids on the outside walls of the tips to drain. This 
function defines the time allowed (expressed as a percentage of the nominal tip retraction speed) to draw the tips through the 
liquid to the surface. Surface tension effects can assist to pull liquids into the remaining body of liquid when this movement is 
performed at a suitable speed. This aids with sample drip control to reduce cross contamination. 

The recommended range of values is 10 to 100 (%). For viscous liquids a value in the range 30 to 60 is suggested. 

The default value is 100. 
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Set sample post aspirate pause (msec) 

After sample liquid is aspirated, tips are raised to the liquid surface to allow liquids on the outside walls of the tips to drain. This 
function defines the time allowed (expressed in milliseconds) for liquids retained on the outside of the tips to drain to the tip base 
at the liquid surface and into the remaining liquid prior to transfer to the destination wells. This aids with sample drip control to 
reduce cross-contamination. 

The recommended range of values is 0 to 3000 msec. 

The default value is 1000. 

Set sample post mix/eject speed (msec) 

After sample liquid is ejected (or after the final ejection of a sample mix operation), tips are raised to the liquid surface to allow 
liquids on the inside and outside walls of the tips to drain. This function defines the time allowed (expressed in milliseconds) for 
liquids retained on the tips to drain to the tip base at the liquid surface and into the remaining liquid prior to any final air blowout 
and subsequent anti-drip inhale. This aids with sample drip control to reduce cross-contamination. 

The recommended range of values is 0 to 3000 msec. 

The default value is 1000. 

Use special pipetting parameters for lysate transfer 

Select this option to enable configuration of pipetting conditions for lysates (see below). 

Set special pipetting parameters for lysate transfer 

This function can be used to specify lysate transfer from lysis block to filter plate. The transfer usually uses default pipetting speed, 
air intake, and blowout. Select this function to set the pipetting speed for lysates in a range from 60 to 450 µL/s. In addition, the 
air intake after a lysate ejection can be configured at a range from 0 to 50 µL. Adjustments can be defined for the first two steps 
and the last step, each depending on the volumes of the lysate. The blowout can also be set for the last step of lysate transfer. 

Compensate for liquid loss (non-reagent) 

This function sets a depth in millimeters by which the tip should be further lowered into the wells below the calculated liquid 
surface position for non-reagent pipetting operations. 

This function is intended to allow for liquid losses due to evaporation, tip retention, or other processes that lower the actual 
volumes present relative to their expected (calculated) values. In addition, this function can be used to address a variety of 
situations where the tip would otherwise be placed too high in non-reagent wells for pipetting operations. 
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The recommended range is 0 to 3 mm. 

The default value is 0. 

Note: Losses for non-reagent liquids are typically less than those for reagents. 

Note: Increasing this value above the default (0) can place tips too low in the wells, reducing the quality of mixing operations. 

Use slow move speeds for sample 

When activated a tick is visible. This function reduces the speed at which the instrument arm moves whenever tips carrying 
sample liquid are transported. The slower, smoother movement reduces the likelihood of drips from the tips and avoids risks of 
cross contamination. 

This function is activated by default. 

Break seal using 2-step carriage lift 

A tick is displayed when this function is activated. This function affects the way in which the capture plate transfer carriage is 
raised prior to transfer of the capture plate from one side of the vacuum chamber to the other. 

When activated, the carriage lift operation is performed in two steps, lifting the carriage initially by 2 mm to break any seal 
between the lower gasket of the carriage and the upper surface of the vacuum chamber, then finally raising the carriage to the 
transport height. This 2-step operation is more robust than using a single movement to raise the carriage to the transfer height. 

This function is activated by default. 

Sample and reaction functions for non-wizard protocols 

Choosing an accessory 

In some cases, a plate may be used with one or more optional “accessory” devices (such as a cooling block) on the instrument 
worktable. Using an accessory may change the height calibration required for the plate.  

To support the use of accessories, the software allows multiple height calibrations to be recorded for a plate: For example, for 
using the plate with and without the accessory. When using the plate with an accessory on the worktable, the correct accessory 
configuration must be specified in the software workspace to ensure the correct height calibration data are used during pipetting 
operations. 
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Specify an accessory plate configuration as follows: 

1. Open the software workspace (see Section 5.3, page 51). 

2. Right-click the plate that is to be changed. 

3. From the menu that appears, select Change accessory. 

The “Select Accessory” window appears. 

4. Select an accessory. 

The default is “No accessory”. 

5. When the correct accessory has been selected, click OK to apply the selection and close the window.  

When an accessory is chosen, the background color of the position changes in the workspace. 

 
If required, perform calibration for the plate–accessory combination. For more information about calibration, see 
Section 5.12.5, page 88. 

Choosing the tip type 

To accommodate the wide variety of consumables and different types of runs, the type of pipet tips and their locations can be 
changed within the software.  

Specify the default tip rack configuration as follows: 

1. Open the software workspace (see Section 5.3, page 51). 

2. Right-click the plate that is to be changed. 

3. From the menu that appears, select Change plate type. 

The “Plate Configuration” window appears. 
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4. Ensure that only Tips is selected in Filter to panel.  

5. From the Select Plate Type drop-down list, select “Standard 96 Well” to display the available 96-well tip rack options in the 
“Plate” list.  

Only the options that are appropriate for the selected position are displayed. 

6. From the “Plate” list, select 96 QIAGEN OnCor C 200 µL Tips.  

7. Select the following Plate Usage Options: 

 Pipet Order: “Vertical” 
 Segmentation: “1 Segment” 
 Labeling and Well Display Order: “Default [A1-H12], Ordered by Character Label” 

8. When the correct tips have been chosen, click OK to apply the changes and close the window.  

The selected pipet tips appear in the workspace. 

Note: Correct selection of tip type is critical for successful operation of the QIAcube HT.  

Note: Only use pipet tips recommended by QIAGEN. 

Working with sample banks  

A sample bank is a collection of wells in a given plate or plate segment that is grouped and treated as a single unit for liquid-
handling operations. 

Individual sample wells must be assigned to a sample bank before they are available for use in a reaction setup. Reaction wells 
can also be assigned to a sample bank — this enables a reaction to be used as a component of a second reaction. 

Note: Runs set up using the “Vacuum extraction” wizard (Section 6.3.1, page 140) include sample banks set up automatically 
by the wizard. In such runs, sample bank operations are disabled to avoid corruption of the run configuration. 
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Sample banks are managed using the “Update Sample Bank” window, accessed from the plate operations menu or from the 
sample right-hand pane. For more detailed information about managing sample banks using the sample right-hand pane, see 
Section 5.11.1, page 72. 

Right-click a sample or reaction plate to view sample bank options in the upper panel of the plate operations menu. Select any 
of these options, apart from Toggle sample bank list and Set preload volume, to directly display the “Update Sample Bank” 
window.  

Add selected wells to sample 
bank 

Opens the “Update Sample Bank” window and enables selected wells to be added to a 
new or existing sample bank.  

Add first ‘n’ wells on plate to 
sample bank 

Opens the “Update Sample Bank” window and enables consecutive wells on a plate to be 
added to a new or existing sample bank. 

Add list of wells on plate to 
sample bank 

Opens the “Update Sample Bank” window and enables a list of wells to be defined and 
added to a new or existing sample bank. 

Remove selected wells from 
sample bank 

Opens the “Update Sample Bank” window and enables selected wells to be removed from 
an existing sample bank. 

Toggle sample bank list Opens the “Sample Banks” panel of the “Sample” right-hand pane. This option is only 
available when a reaction plate is selected. For more information about managing 
sample banks using the “Sample Banks” panel, see Section 5.11.1, page 72.  

Set preload volume Enables the user to enter the volume of liquids which have been preloaded into reaction 
tubes. This option is only available when a reaction plate is selected. Click OK to continue. 

 
“Update sample bank” window. 
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New Bank Create a new sample bank. Insert a sample bank name. Sample bank names must be unique 
within the run. 

Existing Bank Modify an existing sample bank. Current sample banks that are defined for the selected 
plate/segment are listed. 

Banks defined elsewhere List all sample banks that are defined in the run file. 

Select all Select all of the wells within the plate. 

Clear all Deselect all of the wells within the plate. 

Range of wells Define a consecutive range of wells. Specify the “First well” and specify the “Number of wells”. 

List of wells List the range of wells (e.g., A1–B1) selected. This list is automatically updated when the well 
selection is changed. In addition, a list can be directly entered into this field to select wells. A list 
can consist of more than one description (e.g., A1–B2, C2–C6). 

Bank wells View the existing wells in the sample bank. Wells are highlighted red. 

Specify concentration range Define a concentration range for the filter. Specify the “Min Concentration”, “Max 
Concentration”, and whether to use selected wells “INSIDE” or “OUTSIDE” the defined 
concentration range. 

Apply filter to selected wells Add or remove samples from a sample bank, based on a defined concentration range. The filter 
is immediately applied to the current selection. 

Add Selection and Close Add selected wells to the sample bank. The “Update Sample Bank” window closes. 

Delete Selection and Close Delete selected wells from the sample bank. The “Update Sample Bank” window closes. 

Cancel Close the “Update Sample Bank” window. 

More Open the “Sample selection” and “Filter selection” panels, in addition to the “Sample Bank 
Name” panel. 

Less Close the “Sample selection” and “Filter selection” panels. 
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Create a new sample bank 

1. To select all of the wells within a plate, click a sample or reaction plate. To select a group of wells within a plate, click the 
plate and then drag. Selected positions are highlighted in red.  

2. Right-click the plate to view in the plate operations menu. Select Add selected wells to sample bank. The Update Sample 
Bank window opens. 

3. Select New Bank and enter a name for the new sample bank. 

4. If desired, click and drag the plate schematic in the lower portion of the window to modify the original well selection. 
Alternatively, options in the “Sample Selection” panel and “Filter Selection” panel can be used to select wells. 

5. Click Add Selection and Close. The selected wells are indicated in color on the software worktable. 

6. To add another group of wells to this sample bank, proceed as for “Modifying an existing sample bank” (below). 

Modifying an existing sample bank 

1. To select all of the wells within a plate, click a sample or reagent plate. To select a group of wells within a plate, click the 
plate and then drag. Selected positions are highlighted in red.  

2. Right-click the plate to view the plate operations menu. Select Remove selected wells from sample bank.  

The “Update Sample Bank” window opens. 

3. Select Existing Bank, and select a sample bank from the list.  

4. If desired, click and drag the plate schematic in the lower portion of the window to modify the original well selection. 
Alternatively, options in the “Sample Selection” panel and “Filter Selection” panel can be used to select wells. 

5. To add selected wells to the existing sample bank, click Add Selection and Close. To remove selected wells from the existing 
sample bank, click Remove Selection and Close. 

Configuring reactions  

Reaction configuration allows the user to access options for combining liquids or performing other instrument functions as part of 
the run protocol. These facilities extend the use of QIAcube HT beyond its primary purpose as a wizard-driven nucleic acid 
purification system. 

Two buttons on the reaction right-hand pane are used to update the reaction list: 

 Add — configures a general liquid-handling operation 
 Special — configures an instrument operation or a sample bank duplication operation 

Important: Do not add non-wizard steps to a wizard-programmed protocol. This is critical for a successful operation. 
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General liquid-handling operation 

Configure a general liquid-handling operation as follows: 

1. Open the software workspace (see Section 5.3, page 51). 

2. Right-click the reaction plate to configure. 

Reaction plate information is displayed in the right-hand pane.  

3. Click Add... in right-hand pane.  

The “Reaction Configuration” window appears. 

 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 182 

When the option Allow multiple reagent volumes is activated in the Run Settings menu (see page 170) the “Reaction 
Configuration” dialog box is displayed with the advanced reagents view: 

 
 
1. Select the samples from the Samples drop-down list. 

2. Select reagents to be transferred from the “Which will be combined with ALL of these” lists. 

3. Select the reaction plate into which the reagents will be dispensed from the Target reaction plate drop-down list.  

To display all available reaction plates in a new window, click the  button.  

4. Enter the total volume of the final mixture in the Made up to this volume: field. 

5. According to the sample bank selected, enter the number of wells in the Target wells: field. The value must be a multiple of 
8. Alternatively, enter the number of reaction replicates in the Replicates: field. 

The maximum number of replicates is defined as 384. The replicates are positioned in such a way that the replicates of one 
sample well are pipetted into the plate consecutively. For example, if 3 replicates are selected and the sample bank 
contains wells A1–A8, then the replicates of well A1–A8 would be pipetted into wells A1–A8, B1–B8, and C1–C8 in a 
vertically ordered reaction plate. 

6. Select Mix on ejection? if desired and enter the number of mix cycles to be performed after the reagent is dispensed. 

The volume mixed is the larger of either the well contents or the last volume of liquid added. This option is particularly 
useful when pipetting a very small sample volume (<3 µL). Mixing ensures the entire sample is “rinsed” out of the tip. 

7. To apply the changes and close the window, click OK.  
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Special operation 

Configure a special operation as follows: 

1. Open the software workspace (see Section 5.3, page 51). 

2. Right-click the reaction plate to configure. 

Reaction plate information is displayed in the right-hand pane.  

3. Click Special... in the right-hand pane. 

4. Select the desired operation (see the following sections for descriptions). 

5. Set any required parameters in the operation configuration window that appears, and click OK to save the newly set up 
operation or Cancel to discard the operation.  

Special operation: Add “pause (30 sec.)” 
This function adds a 30 second pause to the reaction list. No additional configuration is needed. 

Special operation: Add “pause (arbitrary)” 
This function adds a pause of defined length to the reaction list. 

 
 
Special operation: Add “reset eject position” 
This function instructs the instrument to start pipetting into a reaction plate from its first well, typically well A1. No additional 
configuration is needed. 

Special operation: Add “pause until confirmation” 
This function displays an optional user-defined message and pauses the instrument until a specified user action is performed and OK 
is clicked.  
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Special operation: Add “move carriage” 
This function instructs the instrument to move the transfer carriage from one side of the vacuum chamber to the other. The direction 
is defined by the Move from left to right and Move from right to left options. 

 
 
A pre-move pause (in seconds) specifies a pause that allows the dissipation of the vacuum applied to hold the carriage in place. 

Special operation: Add “vacuum on/off” 
This function controls the vacuum pump.  

  
When the vacuum is to be applied, the Enable vacuum? option is selected and the vacuum pressure is entered.  

The Wait for confirmation before proceeding? option pauses the instrument until the user clicks OK. Alternatively, the fixed duration 
of vacuum application can be specified. 

The Ignore pressure feedback? option allows the next operation to proceed without first confirming that the vacuum has reached 
the target vacuum pressure.  

Note: Only an experienced user should use the latter two functions. 
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Special operation: Add “move pinch valve” 
This option allows the user to control the position of the pinch valve for application of vacuum to the specified chambers. 

 
 
Special operation: Add “fan on/off” 
This function instructs the instrument to turn the HEPA filter on or off during a run.  

 
 
Special operation: Add “sample bank duplication step…” 
This function instructs the instrument to perform simple plate replication operations with controls for tip use. If a sample bank of 
8 samples is replicated 5 times using standard “general liquid handling” reaction steps (i.e., prepared using Add…), 40 tips are 
required. When the Add sample bank duplication step… option is used, only 8 tips are required for this operation. 
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1. Select a tip setting option. 

Multi-eject Instructs the instrument to use a single tip for each sample, aspirate the entire volume required 
for all replicates, and dispense the volume to complete all replicates. 

Re-use tips Instructs the instrument to use a single tip for each sample and to aspirate and dispense one 
replicate at a time. 

Use new tips Instructs the instrument to use a new tip to transfer each replicate. 

To configure multi-eject options, click the Multi-Eject Settings. 

 
Use air on multi-eject Air is blown through the tip after final ejection to reduce accumulation of liquid on the tip 

interior. This is the default setting when tip reuse is selected but is optional when single-tip use 
has been selected. 

Apply Default Initial 
Ejection Volumes 

Use default initial ejection volumes (i.e., 1 µL for 50 µL tips, and 4 µL for 200 µL tips). This 
volume is returned to source well before the dispensing sequence. 

Specify Initial Ejection 
Volume 

Specify initial ejection volume (the volume that is aspirated and ejected into the source well 
before transfer into target well). 

Additional Extra 
Volume 

Specify a volume to aspirate in addition to the volume to transfer. This volume is retained in the 
tip and discarded when the tip is disposed through the tip chute. 

2. Specify the sample bank to be replicated from the Sample bank: drop-down list. 

3. Define the location and size of each replicate by choosing a target reaction plate, a target starting well in that plate, and a 
volume to transfer. 

Clicking opens the “Plate/Well Selector” window for selecting the target reaction plate. 

Select the desired target plate. This closes the window and updates the selection choice in “Bank Duplication” form. 

Choose a starting well and define the transfer volume for a channel. 

First well Defines the first well of the reaction plate into which the sample bank will be replicated. 

Volume Defines the sample volume that will be used for replication. 

Click Add to include this target configuration to the replicate list. 

Select a replicate from the list and click Remove to delete this replicate from the duplication series. 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 187 

Total volume Defines the total volume, which includes an extra volume if Multi-eject is selected. The extra 
volume is calculated according to settings. 

The software automatically calculates the volumes required and displays them in the notes field. 

4. Click OK to return to the main software window.  

The “Reaction List” is updated with the sample bank replication step.  

 
Special operation: Add “discard tips”  
For runs configured without the “Vacuum extraction” wizard, this function allows used tips remaining on the worktable to be 
discarded explicitly. This function is typically used at the end of a run. 

Description of the Generic XML Format 

The XML file exported in Generic XML mode follows the schema defined in …\Integration\xsd\GenericXMLFormat.xsd. 

The main structure is: 

<Root> 
 <ReactionData> 
  <Socket> 
   <Name>C1</Name> 
   <PlateID/> 
   <PlateType>Std96</PlateType> 
   <Size>96</Size> 
   <Wells> 
    <Well> 
     <Label>A1</Label> 
     <WellID/> 
     <WellNo>1</WellNo> 
     <StandardWellName>A:1</StandardWellName> 
     <Color>5775359</Color> 
     <TubeType>BioSprint_250</TubeType> 
     <Concentration>37</Concentration> 
     <FinalWellVol>80</FinalWellVol> 
     <EventOccurred>0</EventOccurred> 
     <Contents> 
      <Diluent> 
       <SocketName>M1</SocketName> 
       <WellLabel>A</WellLabel> 
       <Vol>40</Vol> 
      </Diluent> 

          <Mix> 
           <SocketName>M1</SocketName> 
           <WellLabel>B</WellLabel> 
           <Vol>10</Vol> 
           <Name>Mix B</Name> 
          </Mix> 

      <Reagent> 
           <SocketName>R1</SocketName> 
           <WellLabel>I</WellLabel> 
           <Vol>2.5</Vol> 
           <Name>10X Buffer</Name> 
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      </Reagent> 
      <Sample> 

           <SocketName>C1</SocketName> 
           <PlateID/> 
           <WellLabel>A1</WellLabel> 
            <Vol>20</Vol> 
            <Name/> 
            <SampleID/> 
            <Concentration>0</Concentration> 

      </Sample> 
      <Reaction> 
       <SocketName>R1</SocketName> 
       <WellLabel>I</WellLabel> 
       <Vol>40</Vol> 
       <Concentration>74</Concentration> 
       <ReactionID/> 
       <SourceContent/> 
      </Reaction> 
     </Contents> 
    </Well> 

… 

For each reaction well a <well> tag is exported, that contains information of all contents of the well. The <reaction> tag contains 
recursive information, if a reaction was added to the exported well (e.g. when using “Create sample banks from target wells”). 

As the XML export can be used to export more than one plate, the <Socket> tag might be repeated for every exported plate 
data. 

It is possible to create XSL transformation files to transform this generic XML format to the format you might need for your lab 
environment. This XSl file should be stored in the folder …\integration\xsl. It can then be selected by the user during the XML 
export dialog. 

To make the user’s selection for empty wells and sample labels evaluable, two parameters are passed to the XSL transformation: 

 SampleLabelType Possible values: 
    SL_FullID = 0 
    SL_SampleID = 1 
    SL_ReactionID = 2 
    SL_SampleName = 3 
 

 EmptyLabelType Possible values: 
    EL_Empty = 0 
    EL_WellID = 1 
    EL_WellOrder = 2 
    EL_WellNumber = 3 

They can be evaluated during the transformation. 
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Appendix B 

Declaration of Conformity 

Name and address of the company 

 QIAGEN GmbH 
 QIAGEN Strasse 1 
 40724 Hilden 
 Germany 
 
An up-to-date Declaration of Conformity can be requested from QIAGEN Technical Support. 

Waste Electrical and Electronic Equipment (WEEE) 

This section provides information about disposal of waste electrical and electronic equipment by users. 

The crossed-out wheeled bin symbol (see below) indicates that this product must not be disposed of with other waste; it must be 
taken to an approved treatment facility or to a designated collection point for recycling, according to local laws and regulations. 

The separate collection and recycling of waste electronic equipment at the time of disposal helps to conserve natural resources 
and ensures that the product is recycled in a manner that protects human health and the environment. 

 

 

 

 

Recycling can be provided by QIAGEN upon request at additional cost. In the European Union, in accordance with the specific 
WEEE recycling requirements and where a replacement product is being supplied by QIAGEN, free recycling of its WEEE-
marked electronic equipment is provided. 

To recycle electronic equipment, contact your local QIAGEN sales office for the required return form. Once the form is submitted, 
you will be contacted by QIAGEN either to request follow-up information for scheduling collection of the electronic waste or to 
provide you with an individual quote. 
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FCC declaration 

The ’’United States Federal Communications Commission’’ (USFCC) (in 47 CRF 15. 105) declared that the users of this product 
must be informed of the following facts and circumstances. 

‘’This device complies with part 15 of the FCC: 

Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.’’ 

“This Class A digital apparatus complies with Canadian ICES-0003.’’ 

The following statement applies to the products covered in this manual, unless otherwise specified herein. The statement for other 
products will appear in the accompanying documentation. 

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation 
of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense. 

QIAGEN GmbH Germany is not responsible for any radio television interference caused by unauthorized modifications of this 
equipment or the substitution or attachment of connection cables and equipment other than those specified by QIAGEN GmbH, 
Germany. The correction of interference caused by such unauthorized modification, substitution or attachment will be the 
responsibility of the user. 

Liability clause 

QIAGEN shall be released from all obligations under its warranty in the event repairs or modifications are made by persons 
other than its own personnel, except in cases where the Company has given its written consent to perform such repairs or 
modifications. 

All materials replaced under this warranty will be warranted only for the duration of the original warranty period, and in no case 
beyond the original expiration date of original warranty unless authorized in writing by an officer of the Company. Read-out 
devices, interfacing devices, and associated software will be warranted only for the period offered by the original manufacturer 
of these products. Representations and warranties made by any person, including representatives of QIAGEN, which are 
inconsistent or in conflict with the conditions in this warranty shall not be binding upon the Company unless produced in writing 
and approved by an officer of QIAGEN. 
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Appendix C – Ordering Information 

Product Contents Cat. no. 

QIAcube HT System Robotic workstation with UV lamp, HEPA filter, 
laptop, QIAcube HT operating software, start-up 
pack, installation and training, 1-year warranty on 
parts and labor  

9001793 

Plasticware and accessories  

Accessories Pack, QXT Upgrade kit for QIAxtractor instrument; 
Adapter set to use dedicated QIAcube HT kits on the 
QIAxtractor 
Contains: Transfer Carriage (9022654), Riser Block 
EMTR (9022655), and Channeling Adapter 
(9022656) 

9022649 

Gasket for Transfer Carriage Replacement flat gasket (one piece) 9022975 

Reagent Trough (with Lid), 170 mL Box of 20 plus lid; liquid reservoirs; used with 
Reagent Trough R1 Position Plate and Reagent 
Trough SBS Plate 

990556 

Reagent Trough (with Lid), 70 mL Box of 10 plus lid; liquid reservoirs; used with 
Reagent Trough R1 Position Plate and Reagent 
Trough SBS Plate  

990554 

Adapter, Reagent Trough SBS Plate For holding combinations of 70 mL and 170 mL 
Reagent Troughs in the standard SBS plate positions 

9018935 

Adapter, Reagent Trough R1 Position 
Plate 

For holding combinations of 70 mL and 170 mL 
Reagent Troughs in the R1 position on the instrument 
worktable 

9019513 

Filter-Tips, OnCor C, 200 µL (960) Disposable filter-tips; for use with the QIAcube HT 
and QIAxtractor 

990610 

Tape Pads (5) Adhesive tape sheets for sealing multiwell plates and 
blocks: 25 sheets per pad, 5 pads per pack  

19570 

HEPA filter  Replacement cartridge (one filter) 9019486 

Vacuum Filter, Polycap Filter Replacement cartridge (one filter) 9019488 

Vacuum Filter, Carbon Filter Replacement cartridge (one filter) 9019483 

Tip Disposal Box  Box of 10; waste collection box to fit  
tip ejector chute 

990550 

 

For up-to-date licensing and product-specific disclaimers, see the respective QIAGEN kit handbook or user manual. QIAGEN kit 
handbooks and user manuals are available at www.qiagen.com or can be requested from QIAGEN Technical Services or your 
local distributor. 
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Appendix D – Informations de sécurité 

Avant d'utiliser le QIAcube HT, il est impératif de lire attentivement ce manuel et de porter une attention particulière aux 
informations de sécurité. Afin de garantir un fonctionnement de l'appareil en toute sécurité et de maintenir l'appareil en bon état 
de marche, il est impératif de suivre les instructions et les informations de sécurité fournies dans le présent manuel d'utilisation. 

Les types d'informations de sécurité suivants sont fournis tout au long du manuel. 

AVERTISSEMENT 

 

Le terme AVERTISSEMENT signale des situations risquant d’entraîner des accidents corporels dont 
l'utilisateur, ou d’autres personnes, pourraient être victime. 

Les détails concernant ces circonstances sont donnés dans un encadré identique à celui-ci. 

 
ATTENTION 

 

Le terme ATTENTION signale des situations risquant d’entraîner des détériorations de l'appareil ou de 
tout autre matériel. 

Les détails concernant ces circonstances sont donnés dans un encadré identique à celui-ci. 

 
Les conseils donnés dans ce manuel ont pour but de venir compléter les exigences de sécurité habituelles en vigueur dans le 
pays de l’utilisateur et non de s’y substituer. 

Utilisation appropriée 

AVERTISSEMENT
/ATTENTION 

 

Risque d’accident corporel et de détérioration du matériel 
L’utilisation inappropriée du QIAcube HT peut entraîner des accidents corporels ou une détérioration 
de l’appareil. 

L'utilisation du QIAcube HT est exclusivement réservée au personnel qualifié ayant été convenablement 
formé. 

L’entretien du QIAcube HT doit uniquement être effectué par des spécialistes du Service Après Vente 
QIAGEN. 

 
AVERTISSEMENT

/ATTENTION 

 

Risque de surchauffe 
Afin de garantir une bonne ventilation, laisser un dégagement d’au moins 10 cm sur les côtés et à 
l’arrière du QIAcube HT. Les fentes et les ouvertures qui assurent la ventilation de l'appareil ne doivent 
pas être obstruées. 

 
AVERTISSEMENT

/ATTENTION 

 

Risque d’accident corporel et de détérioration du matériel 
Le QIAcube HT est trop lourd pour être soulevé par une seule personne. Afin d'éviter tout accident 
corporel et toute détérioration du matériel, ne pas soulever l'appareil seul. 
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AVERTISSEMENT
/ATTENTION 

 

Risque d’accident corporel et de détérioration du matériel 
Ne pas essayer de déplacer le QIAcube HT pendant qu'il est en fonctionnement. 

 
AVERTISSEMENT 

 

Atmosphère explosive 
Le QIAcube HT n’est pas conçu pour être utilisé dans une atmosphère explosive. 

 
AVERTISSEMENT 

 

Risque d’explosion 
Le QIAcube HT a été conçu pour l’utilisation des réactifs et substances fournis par les kits QIAGEN. 
L’utilisation de réactifs et de substances autres que celles indiquées peut entrainer un risque d’incendie 
ou d’explosion. 

 
ATTENTION 

 

Détérioration de l’appareil 
La lumière directe du soleil peut décolorer les pièces de l'appareil et abîmer les éléments en plastique. 

Tenir le QIAcube HT à l'abri de la lumière directe du soleil. 

 
ATTENTION 

 

Détérioration de l’appareil 
Éviter de renverser de l’eau ou des produits chimiques sur le QIAcube HT. La détérioration de l’appareil 
due au déversement de liquides annule la garantie. 

 
AVERTISSEMENT 

 

Risque d’accident corporel 
Pendant l'étalonnage des positions, le bras robotisé se déplace alors que le capot de l'appareil est 
relevé. Ne jamais cliquer sur une des touches tant que des parties du corps se trouvent dans l'enceinte 
de l'appareil. 

 
En cas d’urgence, éteindre le QIAcube HT à l’aide de l’interrupteur d’alimentation situé à l’arrière de l’appareil et débrancher 
le cordon d'alimentation de la prise de courant. 
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Sécurité électrique 

Avant l'entretien, débrancher le cordon d'alimentation de la prise de courant. 

AVERTISSEMENT 

 

Danger électrique 
Toute interruption du conducteur de protection (conducteur de terre/de masse) à l’intérieur ou à 
l’extérieur de l’appareil ou toute déconnexion de la borne du conducteur de protection est susceptible 
de rendre l’appareil dangereux. 

Toute interruption intentionnelle est interdite. 

Tensions mortelles à l’intérieur de l’appareil 

Lorsque l’appareil est relié à l’alimentation, les bornes peuvent être sous tension et l’ouverture des capots 
de l’instrument ou le retrait de pièces risque d’exposer des éléments sous tension. 

 
AVERTISSEMENT 

 

Danger d'irradiation UV 
Un dispositif électronique de verrouillage empêche la lampe UV de fonctionner tant que le capot de 
l'appareil est ouvert. Ce dispositif ne doit en aucun cas être désactivé. 

 
Afin que le QIAcube HT fonctionne de manière satisfaisante et en toute sécurité, suivre les conseils suivants : 

 Le cordon d'alimentation de l'appareil doit être branché sur une prise d'alimentation munie d’un conducteur de protection 
(terre/masse). 

 Ne pas effectuer de réglage, ni remplacer les pièces internes à l'instrument. 
 Ne pas faire fonctionner l’appareil si des panneaux ou des pièces en ont été retirés. 
 En cas de déversement de liquides à l'intérieur de l'appareil, débrancher celui-ci de la prise d'alimentation et contacter les 

Services techniques de QIAGEN. 
 Si l'appareil présente un danger électrique, empêcher le reste du personnel de s'en servir et contacter les Services 

techniques de QIAGEN. L'appareil peut présenter un danger électrique dans les cas suivants : 

 Le cordon d'alimentation présente des signes de détérioration. 
 L'appareil a été stocké pendant une longue période dans des conditions non conformes à celles énoncées dans 

l'Annexe A. 
 L'appareil a subi des chocs sévères durant le transport. 
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Sécurité biologique 

Les spécimens et les réactifs contenant des matières provenant d’êtres humains doivent être considérés comme potentiellement 
infectieux. Utilisez des procédures de laboratoire sûres comme décrit dans des publications telles que Biosafety in Microbiological 
and Biomedical Laboratories, HHS (www.cdc.gov/biosafety/publications). 

Échantillons 

Les échantillons peuvent contenir des agents infectieux. Vous devez connaître le risque que de tels agents représentent pour la 
santé et devez utiliser, stocker et éliminer ces échantillons conformément aux règles de sécurité nécessaires. 

AVERTISSEMENT 

 

Échantillons contenant des agents infectieux 
Certains échantillons utilisés avec cet appareil peuvent contenir des agents infectieux. Manipulez ces 
échantillons avec la plus grande précaution et conformément aux règles de sécurité nécessaires. 

Portez toujours des lunettes de protection, deux paires de gants et une blouse de laboratoire. La 
personne responsable (par exemple, le directeur du laboratoire) doit prendre les précautions 
nécessaires afin de garantir que l’environnement de travail est sûr, que les opérateurs de l’appareil sont 
convenablement formés et ne sont pas exposés à des niveaux dangereux d’agents infectieux comme 
cela est défini dans les fiches techniques santé-sécurité (FDS) ou dans les documents de l’OSHA*, de 
l’ACGIH† ou du COSHH‡ applicables. 

L’évacuation des vapeurs et l’élimination des déchets doivent s’effectuer conformément à toutes les règles 
et lois nationales, régionales et locales relatives à la santé et à la sécurité. 

* OSHA : Occupational Safety and Health Administration (États-Unis d’Amérique) (Administration pour la santé et la sécurité du travail). 
† ACGIH : American Conference of Government Industrial Hygienists (États-Unis d’Amérique) (Conférence américaine des hygiénistes industriels 

gouvernementaux). 
‡ COSHH : Control of Substances Hazardous to Health (Royaume-Uni) (Contrôle des substances dangereuses pour la santé).  

Produits chimiques 

AVERTISSEMENT 

 

Produits chimiques dangereux 
Certains produits chimiques utilisés avec cet appareil peuvent être dangereux ou le devenir après 
l’exécution du cycle du protocole. 

Toujours porter des lunettes de protection, des gants et une blouse de laboratoire. 

La personne responsable (par exemple, le directeur du laboratoire) doit prendre les précautions 
nécessaires afin de garantir que le lieu de travail environnant est sûr et que les opérateurs de l’appareil 
ne sont pas exposés à des niveaux dangereux de substances (chimiques ou biologiques) toxiques 
comme cela est défini dans les fiches de données de sécurité (FDS) ou dans les documents de l’OSHA*, 
de l'ACGIH† ou du COSHH‡ applicables. 

L’évacuation des vapeurs et la mise au rebut des déchets doivent s’effectuer conformément à toutes les 
réglementations et lois nationales, régionales et locales relatives à la santé et à la sécurité. 

* OSHA : Occupational Safety and Health Administration (États-Unis d’Amérique) (Administration pour la santé et la sécurité du travail). 
† ACGIH : American Conference of Government Industrial Hygienists (États-Unis d’Amérique) (Conférence américaine des hygiénistes industriels 

gouvernementaux). 
‡ COSHH : Control of Substances Hazardous to Health (Royaume-Uni) (Contrôle des substances dangereuses pour la santé).  
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Vapeurs toxiques 

Si vous travaillez avec des solvants volatils ou des substances toxiques, vous devez disposer d’un système de ventilation de 
laboratoire efficace afin d’évacuer les vapeurs qui peuvent être générées. 

Elimination des déchets 

Le matériel en plastique usagé peut contenir des produits chimiques dangereux. Ces déchets doivent être convenablement 
collectés et éliminés conformément aux réglementations locales de sécurité. 

Pour plus d'informations sur la mise au rebut du QIAcube HT, voir l'Annexe A. 

Dangers mécaniques 

AVERTISSEMENT 

 

Pièces mobiles 
Éviter le contact avec les pièces en mouvement lorsque le QIAcube HT est en fonctionnement. Ne jamais 
placer les mains sous le bras robotisé lorsque celui-ci s'abaisse. Ne pas tenter de déplacer des plaques 
ou des tubes lorsque le bras robotisé est en marche. 

 
ATTENTION 

 

Détérioration de l’appareil 
N'appliquer aucune force manuelle sur le bras en Y (c'est-à-dire la tête de pipetage). 

En cas de déplacement manuel accidentel du bras en Y, il est fortement recommandé de redémarrer le 
système. 

 
Afin que le QIAcube HT fonctionne de manière satisfaisante et en toute sécurité, suivre les conseils suivants : 

 Utiliser uniquement les cônes et les supports de cônes recommandés. 
 Dans la mesure du possible, maintenir le capot de l'appareil fermé. 
 Ne pas désactiver le dispositif de verrouillage du capot. 
 Lors de l'étalonnage des plaques capot ouvert, toujours se tenir à l'écart de l'appareil au moment des réglages. Le 

dispositif de verrouillage est désactivé en mode d'étalonnage. Par conséquent, ne pas cliquer avec la souris ni appuyer sur 
une des touches du clavier lors de l'observation de l'étalonnage des plaques. Attendre l'arrêt complet du bras robotisé pour 
déplacer une plaque ou un tube. 

 Ne rien poser sur le bras robotisé. 
 Avant de retirer des plaques ou des tubes de la table de travail, sélectionner « Pause » dans la barre d'outils du logiciel 

QIAcube HT pour mettre l'appareil en mode de pause. Attendre l'arrêt complet du bras robotisé. Cela peut prendre jusqu'à 
10 s. 



 
 

QIAcube HT Version 4.17 User Manual    06/2023 197 

Sécurité relative à la maintenance 

Procéder à la maintenance comme décrit à la Section 7. QIAGEN facture les réparations rendues nécessaires suite à une 
maintenance inadaptée. 

AVERTISSEMENT 

 

Risque d’accident corporel et de détérioration du matériel 
Effectuer uniquement la maintenance spécifiquement décrite dans ce manuel. 

 
AVERTISSEMENT 

 

Risque de décharge électrique 
Ne pas ouvrir les panneaux du QIAcube HT. 

Risque d’accident corporel et de détérioration du matériel 
Effectuer uniquement la maintenance spécifiquement décrite dans ce manuel. 

 
ATTENTION 

 

Détérioration de l’appareil 
Ne pas utiliser de solvants ni de réactifs contenant des acides, des bases ou des composés abrasifs 
pour nettoyer le QIAcube HT. 

 
ATTENTION 

 

Détérioration du capot du QIAcube HT 
Ne pas utiliser de solvants ni de réactifs contenant des acides, des bases ou des composés abrasifs 
pour nettoyer le capot de l'appareil. L'alcool peut endommager le capot. Employer uniquement de l'eau 
distillée. 

 
ATTENTION 

 

Détérioration des panneaux latéraux du QIAcube HT 
Ne jamais nettoyer les panneaux latéraux de l’appareil à l'alcool ou avec une solution à base d'alcool. 

 
ATTENTION 

 

Détérioration du chariot de transfert de la plaque de capture 
En aucun cas le chariot de transfert de la plaque de capture ne doit être autoclavé. 

Symboles sur le QIAcube HT 

Symbole Emplacement Description 

 

Table de travail et près de la plaque signalétique Symbole de mise en garde 

 

Table de travail et près de la sortie pour l’éjection des cônes Symbole de danger biologique 
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Symbole Emplacement Description 

 

Table de travail Symbole de risque d'écrasement 

 

Plaque signalétique à l’arrière de l’appareil Marquage CE pour la conformité 
Européenne 

 

Plaque signalétique à l’arrière de l’appareil  Marquage UKCA pour la conformité UK 

 

Plaque signalétique à l’arrière de l’appareil Label CSA pour le Canada et les Etats-Unis 

 
Plaque signalétique à l’arrière de l’appareil Fabricant légal 

 

Plaque signalétique à l’arrière de l’appareil Symbole DEEE 

 

Plaque signalétique à l’arrière de l’appareil Label FCC de la Federal Communications 
Commission des États-Unis 

 

Plaque signalétique à l’arrière de l’appareil Label C-Tick pour l'Australie (identifiant du 
fournisseur N17965) 

 

Plaque signalétique à l’arrière de l’appareil Label RoHS pour la Chine (restriction de 
l’utilisation de certaines substances 
dangereuses dans l’équipement électrique 
et électronique) 

 

Plaque signalétique à l’arrière de l’appareil    Lire le manuel d’utilisation. 

 

Appendix E – Sicherheitshinweise 

Lesen Sie dieses Handbuch sorgfältig durch, bevor Sie den QIAcube HT benutzen. Beachten Sie dabei insbesondere die 
Sicherheitshinweise. Die Gebrauchsanweisungen und Sicherheitshinweise im Handbuch müssen befolgt werden, um einen 
sicheren Betrieb des Geräts zu gewährleisten und das Gerät in einem sicheren Zustand zu erhalten. 
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In diesem Handbuch werden die folgenden Kategorien von Sicherheitshinweisen verwendet: 

WARNUNG 

 

Der Begriff „WARNUNG“ (“WARNING”) weist Sie auf Situationen hin, in denen eine 
Verletzungsgefahr für Sie selbst oder andere Personen besteht. 

Nähere Einzelheiten über diese Situationen werden in einem Textfeld wie diesem beschrieben. 

 
ACHTUNG 

 

Der Begriff „ACHTUNG“ (“CAUTION”) weist Sie auf Situationen hin, in denen das Gerät oder andere 
Geräte beschädigt werden könnten. 

Nähere Einzelheiten über diese Situationen werden in einem Textfeld wie diesem beschrieben. 

 
Die in diesem Handbuch enthaltenen Hinweise stellen eine Ergänzung und keinen Ersatz der üblichen Sicherheitsanforderungen 
dar, die im jeweiligen Land gelten. 

Sachgemäße Handhabung 

WARNUNG/ 
ACHTUNG 

 

Verletzungsgefahr und Beschädigung des Geräts 
Die unsachgemäße Bedienung des QIAcube HT kann zu einer Verletzung des Benutzers oder zur 
Beschädigung des Geräts führen. 

Der QIAcube HT darf nur durch qualifiziertes Personal, das entsprechend geschult wurde, bedient 
werden. 

Die Instandhaltung des QIAcube HT darf nur durch einen Außendienst-Mitarbeiter des QIAGEN Service 
durch¬geführt werden. 

 
WARNUNG/ 
ACHTUNG 

 

Überhitzungsgefahr 
Vergewissern Sie sich, dass zwischen Wand und QIAcube HT (Rückseite und Seitenteile) ein 
Mindestabstand von 10 cm eingehalten wird. Das gewährleistet eine ausreichende Belüftung des 
Gerätes. Die Lüftungsschlitze und Öffnungen, die für die Be- und Entlüftung des QIAcube HT bestimmt 
sind, dürfen nicht zugedeckt werden. 

 
WARNUNG/ 
ACHTUNG 

 

Verletzungsgefahr und Beschädigung des Geräts 
Der QIAcube HT ist zu schwer, um von einer einzelnen Person gehoben zu werden. Zur Vermeidung 
einer Verletzung oder Beschädigung des Gerätes heben sie das Gerät nicht alleine an. 

 
WARNUNG/ 
ACHTUNG 

 

Verletzungsgefahr und Beschädigung des Geräts 
Der QIAcube HT darf auf keinen Fall während des Betriebs fortbewegt werden. 

 
WARNUNG Explosionsgefahr 

Der QIAcube HT ist ausschließlich mit Reagenzien und Substanzen aus den QIAGEN Kits zu benutzen. 
Die Benutzung von anderen Reagenzien oder Substanzen kann Feuer oder eine Explosion auslösen. 
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ACHTUNG 

 

Geräteschäden 
Direktes Sonnenlicht kann zum Ausbleichen von Geräte¬teilen führen und Schäden an Kunststoffteilen 
verursachen. 

Der QIAcube HT darf nicht direkter Sonneneinstrahlung ausgeliefert werden. 

 
ACHTUNG 

 

Beschädigung des Geräts 
Vermeiden Sie es, Wasser oder Chemikalien auf der Oberfläche des QIAcube HT zu verschütten. Durch 
verschüttete Chemikalien oder verschüttetes Wasser verursachte Geräteschäden sind nicht durch die 
Garantie abgedeckt. 

 
WARNUNG 

 

Verletzungsgefahr 
Bei der Kalibrierung der Positionen bewegt sich der Roboterarm bei geöffneter Gerätehaube. Klicken 
Sie nicht auf die Maus und drücken Sie nicht auf eine Taste der Tastatur, während sich Ihre Hände oder 
andere Körperteile im Arbeitsbereich des Roboterarms befinden. 

 
Schalten Sie im Notfall den QIAcube HT aus (der Netzschalter befindet sich auf der Geräterückseite), und ziehen Sie den 
Netzstecker aus der Steckdose. 

Schutz vor Stromschlag 

Ziehen Sie das Netzanschlusskabel aus der Steckdose, bevor Sie Wartungsarbeiten am Gerät vornehmen. 

WARNUNG 

 

Gefahr durch Stromschlag 
Jede Unterbrechung des Schutzleiters (Erdungs- bzw. Masseleiter) im Gerät oder außerhalb des Geräts 
und jede Abtrennung des Schutzleiters am Anschluss der Netzleitung erhöht die Gefahr eines 
Stromschlags. 

Eine absichtliche Unterbrechung der Schutzleiter-verbindung ist verboten. 

Gefährliche Spannung im Gerät 
Wenn das Gerät an die Stromversorgung angeschlossen ist, sind die Anschlussstellen 
spannungsführend. Durch das Öffnen der Abdeckungen oder das Entfernen von Gehäuseteilen können 
spannungsführende Komponenten freigelegt werden. 

 
WARNUNG 

 

Gefahr durch UV-Strahlung 
Ein elektronisch gesteuerter Sensor zeigt an, dass die Gerätehaube geschlossen sein muss, bevor die 
UV-Lampe eingeschaltet werden kann. Der Hauben Sensor darf unter keinen Umständen ausser Kraft 
gesetzt werden. 

 
Um einen zufriedenstellenden und sicheren Betrieb des QIAcube HT zu gewährleisten, befolgenden Sie bitte die nachstehenden 
Richtlinien: 
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 Das Netzkabel muss an eine Wechselstrom-Steckdose mit Schutzleiter (Erdungs-/ 
Masseleiter) angeschlossen werden. 

 Nehmen Sie im Geräteinneren keine Einstellungen an Teilen vor und wechseln Sie keine Teile aus. 
 Nehmen Sie das Gerät nicht in Betrieb, wenn Abdeckungen oder Teile entfernt worden sind. 
 Falls Flüssigkeit auf dem Gerät verschüttet wird und in das Gerät läuft, dann schalten Sie es sofort aus, trennen Sie es von 

der Netzspannung (Stecker ziehen!) und setzen Sie sich mit dem Technischen Service von QIAGEN in Verbindung. 
 Falls die elektrische Sicherheit bei der Bedienung des Geräts nicht mehr gewährleistet werden kann, muss das Gerät gegen 

unbefugte oder unabsichtliche Benutzung gesichert werden. Kontaktieren Sie anschließend den Technischen Service von 
QIAGEN. Die elektrische Sicherheit des Geräts ist nicht mehr gegeben, wenn: 

 Das Netzkabel beschädigt ist. 
 Das Gerät längere Zeit unter ungünstigen Bedingungen, d. h. unter anderen Bedingungen als in Anhang A angegeben, 

gelagert wurde. 
 Das Gerät unsachgemäß transportiert worden ist. 

Biologische Sicherheit 

Bei Substanzen und Reagenzien, die humanes Untersuchungsmaterial enthalten, sollte immer von einer möglichen 
Infektionsgefahr ausgegangen werden. Wenden Sie nur sichere Laborverfahren an, wie sie z. B. in Veröffentlichungen wie 
Biosafety in Microbiological and Biomedical Laboratories (HHS, www.cdc.gov/biosafety/publications) beschrieben werden. 

Proben 

Proben können infektiöse Erreger enthalten. Sie sollten sich der Gesundheitsgefahr bewusst sein, die von diesen Erregern ausgeht, 
und derartige Proben gemäß den erforderlichen Sicherheitsbestimmungen handhaben, lagern und entsorgen. 

WARNUNG 

 

Proben, die infektiöse Erreger enthalten 
Einige Proben, die mithilfe dieses Geräts verarbeitet werden, können infektiöse Erreger enthalten. Gehen 
Sie beim Umgang mit diesen Proben mit der größtmöglichen Vorsicht und gemäß den erforderlichen 
Sicherheitsbestimmungen vor. 

Tragen Sie immer eine Schutzbrille, zwei Paar Laborhand-schuhe und einen Laborkittel. 

Die verantwortliche Person (z. B. der Laborleiter) muss alle erforderlichen Vorsichtsmaßnahmen treffen, 
um sicher-zustellen, dass die unmittelbare Umgebung des Arbeits-platzes sicher ist und die Bediener des 
Geräts ausreichend geschult sind. Außerdem dürfen die Grenzwerte in Bezug auf infektiöse Erreger, 
die in den entsprechenden Sicherheitsdatenblättern (SDS) oder den Vorschriften der OSHA,* ACGIH† 
oder COSHH‡ festgelegt sind, nicht überschritten werden. 

Beim Betrieb des Abzugs und bei der Entsorgung von Abfallstoffen müssen alle Bestimmungen und 
Gesetze zu Gesundheitsschutz und Sicherheit am Arbeitsplatz auf übernationaler, nationaler und 
regionaler Ebene eingehalten werden. 

* OSHA: Occupational Safety and Health Administration (Vereinigte Staaten von Amerika) 
† ACGIH: American Conference of Government Industrial Hygienists (Vereinigte Staaten von Amerika) 
‡ COSHH: Control of Substances Hazardous to Health (Vereinigtes Königreich)  
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Chemikalien 

WARNUNG 

 

Gefährliche Chemikalien 
Einige Chemikalien, die mit diesem Gerät verwendet werden, können gefährlich sein oder nach 
Beendigung eines Protokolllaufs gefährlich werden. 

Tragen Sie immer eine Schutzbrille, Laborhandschuhe und einen Laborkittel. 

Die verantwortliche Person (z. B. der Laborleiter) muss alle erforderlichen Vorsichtsmaßnahmen treffen, 
um sicher-zustellen, dass die unmittelbare Umgebung des Arbeits-platzes sicher ist. Auch dürfen die 
Grenzwerte in Bezug auf infektiöse Erreger, die in den entsprechenden Sicherheits-datenblättern (SDS) 
oder den Vorschriften der OSHA*, ACGIH† oder COSHH‡ festgelegt sind, nicht überschritten werden. 

Beim Betrieb des Abzugs und bei der Entsorgung von Abfallstoffen müssen alle Bestimmungen und 
Gesetze zu Gesundheitsschutz und Sicherheit am Arbeitsplatz auf übernationaler, nationaler und 
regionaler Ebene eingehalten werden. 

* OSHA: Occupational Safety and Health Administration (Vereinigte Staaten von Amerika) 
† ACGIH: American Conference of Government Industrial Hygienists (Vereinigte Staaten von Amerika) 
‡ COSHH: Control of Substances Hazardous to Health (Vereinigtes Königreich)  

Giftige Dämpfe 

Alle Arbeiten mit flüchtigen Lösungsmitteln oder toxischen Substanzen müssen unter einem funktionierenden Laborabzugssystem 
durchgeführt werden, damit die möglicherweise entstehenden Dämpfe abziehen können. 

Entsorgen von Abfällen 

Benutzte Kunststoff-Laborartikel können gefährliche Chemikalien enthalten. Derartige Abfälle müssen gemäß den geltenden 
regionalen Sicherheitsbestimmungen gesammelt und entsorgt werden. 

Beachten Sie bei der Entsorgung des QIAcube HT die gesetzlichen Bestimmungen zur Entsorgung von Elektro- und Elektronik-
Altgeräten (siehe Anhang A). 

Gefahren durch mechanische Teile 

WARNUNG 

 

Sich bewegende Geräteteile 
Vermeiden Sie jeglichen Kontakt mit sich bewegenden Geräteteilen, während der QIAcube HT in 
Betrieb ist. Auf gar keinen Fall dürfen sich Ihre Hände unter dem Roboterarm befinden, wenn dieser 
herunterfährt. Versuchen Sie nicht, Reaktionsgefäße oder Platten zu entnehmen oder zu bewegen, 
während der Roboterarm arbeitet. 

 
ACHTUNG 

 

Beschädigung des Geräts 
Bewegen Sie den Y-Arm (den Pipettierkopf) nicht von Hand. 

Wir empfehlen dringend, einen Neustart des Systems durchzuführen, falls der Y Arm versehentlich von 
Hand bewegt wurde. 
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Um einen zufriedenstellenden und sicheren Betrieb des QIAcube HT zu gewährleisten, befolgenden Sie bitte die nachstehenden 
Richtlinien: 

 Verwenden Sie nur die empfohlenen Pipettenspitzen und -Racks. 
 Halten Sie die Gerätehaube möglichst immer geschlossen.  
 Setzen Sie unter keinen Umständen den Hauben Sensor außer Kraft.  
 Wenn bei geöffneter Gerätehaube die Plattenpositionen kalibriert werden, achten Sie darauf, dass Sie nicht in den 

Arbeitsbereich des Roboterarms kommen, wenn Sie Justierungen vornehmen. Im Kalibrier-Modus ist der Sensor für die 
Haubenöffnung deaktivert. Achten Sie deshalb darauf, nicht mit der Maus zu klicken oder eine der Bedienungstasten auf 
der Tastatur zu drücken, wenn Sie die Kalibrierungen der Plattenpositionen überprüfen. Warten Sie, bis die 
Bewegungsabläufe des Roboterarms beendet sind, bevor Sie Reaktionsgefäße oder Platten entnehmen oder bewegen. 

 Stellen Sie keine Gegenstände auf den Roboterarm. 
 Wählen Sie die Option “Pause” in der Werkzeugleiste der QIAcube HT Software, um das Gerät anzuhalten, bevor Sie 

Reaktionsgefäße oder Platten von der Arbeitsplattform entfernen. Warten Sie, bis der Roboterarm die gerade ablaufende 
Bewegung beendet hat – dies kann bis zu 10 Sekunden dauern. 

Sicherheitshinweise – Wartungsarbeiten 

Führen Sie alle Wartungsarbeiten gemäß den Anweisungen in Abschnitt 7 durch. QIAGEN stellt alle Reparaturen in Rechnung, die 
nachweislich auf eine inkorrekte Wartung zurückzuführen sind. 

WARNUNG 

 

Verletzungsgefahr und Beschädigung des Geräts 
Führen Sie nur Wartungsarbeiten durch, die ausdrücklich in diesem Handbuch beschrieben werden. 

 
WARNUNG 

 

Gefahr durch Stromschlag 
Die Gehäuseteile des QIAcube HT dürfen nicht entfernt werden. 

Verletzungsgefahr und Beschädigung des Geräts 
Führen Sie nur Wartungsarbeiten durch, die ausdrücklich in diesem Handbuch beschrieben werden. 

 
ACHTUNG 

 

Beschädigung des Geräts 
Verwenden Sie weder Lösungsmittel noch Reagenzien, die Säuren, Laugen oder Abrasivstoffe enthalten, 
um den QIAcube HT zu reinigen. 

 
ACHTUNG 

 

Beschädigung der QIAcube HT Gerätehaube 
Verwenden Sie weder Alkohol noch Lösungsmittel oder Reagenzien, die Säuren, Laugen oder 
Abrasivstoffe enthalten, um die Gerätehaube zu reinigen. Alkohol schädigt die Gerätehaube. 
Verwenden Sie zum Reinigen der Gerätehaube ausschließlich destilliertes Wasser. 
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ACHTUNG 

 

Beschädigung der QIAcube HT Seitenverkleidung 
Reinigung sie niemals die Gerätehaube und Seitenwände mit Alkohol oder alkoholhaltigen Lösungen. 

 
ACHTUNG 

 

Beschädigung des Plattentransfer-Gestells 
Das Plattentransfer-Gestell darf auf keinen Fall autoklaviert werden. 

 

Symbole auf dem QIAcube HT 

Symbol Ort Beschreibung 

 

Arbeitsplattform und Geräterückseite Symbol für Warnhinweise („Warnung“ 
oder „Achtung“) 

 

Arbeitsplattform und am Ausgang der Pipettenspitzen-Rutsche Warnung for Biogefährdung 

 

Arbeitsplattform und Roboter Arm Warnung vor Handverletzung 

 

Typenschild auf der Geräterückseite CE-Kennzeichnung der EU-Konformität 

 

Typenschild auf der Geräterückseite  UKCA-Kennzeichnung der UK-Konformität 

 

Typenschild auf der Geräterückseite Symbol der CSA-Zertifizierung in Kanada 
und den USA 

 
Typenschild auf der Geräterückseite Hersteller i.S.d. Gesetzes 

 

Typenschild auf der Geräterückseite WEEE-Kennzeichnung (Zertifizierung 
gemäß europäischer Richtlinien bzw. 
Elektro- und Elektronik-Altgeräte-
Verordnung) 
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Symbol Ort Beschreibung 

 

Typenschild auf der Geräterückseite FCC-Kennzeichen der Federal 
Communications Commission der 
Vereinigten Staaten 

 

Typenschild auf der Geräterückseite RCM-Zeichen (ehemals C-Tick) für 
Australien (Anbieterkennzeichnung 
N17965) 

 

Typenschild auf der Geräterückseite Markierung gemäß RoHS-Richtlinie für 
China (Beschränkung der Verwendung 
bestimmter gefährlicher Stoffe in Elektro- 
und Elektronikgeräten) 

 

Typenschild auf der Geräterückseite Lesen Sie die Gebrauchshinweise im 
Handbuch 

 

Document Revision History 

 Revision Description  

June 2023 Included the UKCA symbol. Removed the environmental class. 
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